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Notices
Chapter 1: Notices
This manual is intended for use with the ADIC Gateway and ADIC Storage
Networking Controller (ADIC SNC). Where the text states “ADIC Gateway,” the
user may read both “ADIC Gateway” and “ADIC Storage Networking Controller.”

ADIC Limited Product Warranty

1. Subject to the limitations set forth below, ADIC warrants to Buyer as follows:

a.) For 12 months from the date of delivery to Buyer, all hardware products
manufactured by ADIC (hereafter Products), excluding drives and media
manufactured by third parties, which are covered by paragraph (c) below,
will be capable of performing substantially in accordance with the applicable
specifications for such Products stated in documentation supplied by ADIC;

b.) All hardware repairs made by ADIC will be free from defects in material
and workmanship for the greater of the original warranty period or 3 months
from the date such repairs are made; and

c.) With respect to drives, tapes, and software manufactured by a third party,
which are supplied by ADIC, Buyer will be the beneficiary of the
manufacturer’s warranties, if any, SUBJECT TO THE LIMITATIONS
STATED THEREIN. Copies of such manufacturer’s warranties will be made
available to Buyer upon request. ADIC DISCLAIMS AND EXCLUDES ALL
WARRANTIES WITH RESPECT TO SUCH ITEMS.

2. The foregoing warranties will be voided if the Products are not properly
installed, serviced, used, or maintained according to ADIC’s printed instruc-
tions or if the Products have been damaged or modified after delivery. Buyer
assumes responsibility for the selection of the Products for the uses for which
they are purchased.

3. If a defect is found and reported to ADIC in writing within the warranty period,
ADIC will, in its sole discretion and as its sole responsibility and liability and as
BUYER’S SOLE AND EXCLUSIVE REMEDY for breach of warranty, either
repair or replace the nonconforming Product or accept the return thereof and
refund to Buyer the price paid to ADIC for such nonconforming Product. ADIC
will respond to Buyer’s request for return material authorization within 72
hours of Buyer’s notice. All warranty repair work or inspections must be per-
formed at an ADIC facility designated by ADIC. Shipment to ADIC’s facility
and all risk of loss or damage during shipment shall be borne by, or for the
account of, Buyer.
1
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4. ADIC will indemnify Buyer for any damages and costs finally awarded against
Buyer on the grounds that the Products, in the form and condition delivered by
ADIC to Buyer hereunder, infringe on any valid United States patents or copy-
rights of any third party, provided that Buyer notifies ADIC in writing of any
such claim within 10 days after learning thereof and that Buyer gives ADIC full
control over the defense and settlement of the claim and fully cooperates with
ADIC with respect thereto. If any such claim is brought or is likely to be
brought, ADIC may at its option replace or modify the Products to make them
non-infringing, or refund to Buyer, upon the return of the Products at issue, the
price paid therefore, less 20% for each year which has passed since the date
of delivery hereunder. Buyer must discontinue all use of any portion of the
Products that has been replaced or modified or for which such a refund has
been tendered. ADIC’s obligation hereunder will not apply to any claim based
on ADIC’s following Buyer’s or its customers’ specifications or requests, the
use of the Products to practice a process or in conjunction with items not sup-
plied by ADIC, and Buyer will similarly indemnify ADIC with respect to any
such claims. THE FOREGOING STATES ADIC’S SOLE RESPONSIBILITY,
AND BUYER’S SOLE REMEDY, FOR ANY INFRINGEMENTS OF ANY
PROPRIETARY RIGHTS.

5. ADIC DOES NOT WARRANT THAT THE PRODUCTS WILL MEET ALL
END-USER REQUIREMENTS OR THAT OPERATION OF THE PRODUCTS
WILL BE UNINTERRUPTED OR TROUBLE FREE. THE WARRANTIES SET
FORTH ABOVE ARE THE ONLY WARRANTIES MADE BY ADIC. ADIC
EXPRESSLY DISCLAIMS AND EXCLUDES ALL OTHER REMEDIES,
EXPRESS OR IMPLIED, ORAL OR WRITTEN, ARISING BY LAW OR OTH-
ERWISE INCLUDING PARTICULAR PURPOSE OR THOSE ARISING
FROM COURSE OF DEALING, COURSE OF PERFORMANCE, OR TRADE
USAGE.

6. BUYER ACKNOWLEDGES THAT ADIC HAS NOT MADE, AND BUYER IS
NOT RELYING UPON, ANY EXPRESS OR IMPLIED WARRANTIES OR
REPRESENTATIONS TO BUYER REGARDING THE VALUE OF THIS
AGREEMENT.

ADIC End User License Agreement

This License defines the terms and conditions of the license between Advanced Digital
Information Corporation (ADIC) and Licensee for use of ADIC's software and related
documentation. Any software or related materials provided to Licensee by ADIC will be
subject to the terms and conditions of this License and by opening the accompanying
package and/or by using the products, Licensee signifies its agreement with this license.

1. Software License.
ADIC Limited Product Warranty



ADIC Limited
a.) License. In consideration of Licensee's payment of the License fees and
subject to the terms of this License, ADIC grants to Licensee a personal,
non-exclusive, non-transferable license to use the Software (Software is
defined as the current version of the software products accompanying this
license agreement in object code form only). A separate license is required
for use of each Software program on each of Licensee’s computers. The
Software will be installed initially on Licensee's Designated Computer.
Licensee may thereafter transfer the Software to another one of its
computers of the same machine architecture, provided that the Software is
installed on one (1) Designated Computer at a time.

b.) Use. Licensee is authorized hereby to use the Software on one computer
only (Designated Computer), or on backup equipment if the Designated
Computer is inoperative until such time as the Designated Computer is
restored to operation. This grant is specifically limited to use by the Licensee
for normal, customary internal data processing, and specifically excludes
Licensee's time-sharing or the rental of the Software or use of the Software
in the development or marketing of a competitive or compatible product. No
right to use, print, copy or display the Software or Documentation, in whole
or in part, is granted hereby except as expressly provided in this License.

c.) Copying. Licensee may make one (1) copy of the Software in a non-
printed, machine-readable form for archival and back-up purposes only. In
order to protect ADIC's trade secret and copyrights in the Software,
Licensee agrees to reproduce and incorporate ADIC’s trade secret or
copyright notice in any copy or partial copy, and will maintain appropriate
records of the location of such copy.

d.) US Government Rights. If the Licensee is the United States
government, Licensee understands and agrees that ADIC Software and
documentation are provided as "Commercial Items" as defined at 48 CFR
2.101 and are being licensed to U.S. Government end users consistent with
48 CFR 12.212.

2. Software Ownership and Protection

a.) Title to Software. The Software and all copies thereof are proprietary to
ADIC and title thereto remains in ADIC. All applicable rights to patents,
copyrights, trademarks, trade secrets or other proprietary rights in the
Software and any modifications made at Licensee's request are and will
remain in ADIC.

b.) Restrictions. Licensee will not itself or permit others to: (i) sell,
sublicense, transfer, publish, disclose, display, provide access via a network
or otherwise make available the Software or any copy thereof to others; (ii)
remove, obscure, or alter any copyright, trade secret, trademark, patent or
other proprietary rights notice affixed to or displayed on the Software or
3
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Documentation; (iii) modify, merge with other programs or translate any
portion of the Software into any other assembly or language; and (v)
reverse-assemble, reverse-compile or attempt to derive a source code
equivalent of the Software.

c.) Protections. Licensee agrees to secure and protect the Software, the
Documentation and copies thereof in a manner consistent with ADIC's rights
therein and to take appropriate action to satisfy its obligations in this
Agreement by instruction or agreement with its employees, agents,
subcontractors or others who are permitted access to the Software. All
programs or copies developed by or for Licensee in violation of this License,
including translations, compilations, partial copies and up-dates, are owned
by ADIC.

d.) Responsibility. Licensee has sole responsibility for use of the products
and any information entered, used, or stored thereon, including
responsibility for protection of data from modification, destruction, or
disclosure, and for the accuracy and integrity of the data. ADIC assumes no
responsibility for Licensee's negligence or failure to protect its data.

3. Warranty and Warranty Servicing.

a.) Warranty. ADIC warrants that for a period of 90 days from installation the
Software will conform to all substantial operational features in ADIC's
current published specifications and will be free of defects which
substantially affect performance of the Software. ADIC does not warrant
that the Software will meet the Licensee’s requirements or that the operation
of the Software will be uninterrupted or error free. The Licensee must notify
ADIC in writing, within 90 days after installation of the Software of
Licensee’s claim of any defect. If ADIC determines that the Software is
defective, ADIC’s sole obligation is for ADIC, at its option, to correct, any
defect in the Software or to accept the return of the Software. Where
Software is returned for claims made during the warranty period, Licensee
will receive a refund for the Software. This warranty is made void if the
Licensee or any third party makes any modifications to the Software. ADIC
is not responsible for corrections necessitated by difficulties or defects
traceable to Licensee's errors or system changes.

b.) Compatibility. ADIC does not warrant that the Software is compatible
with the current releases of all operating systems, nor that the Software will
be made compatible with new releases of operating systems within a
specified amount of time, or at all. At Licensee's request, ADIC will notify
Licensee of the version level of the operating system with which the
Software is intended to be compatible.

c.) Warranty Disclaimer. EXCEPT FOR THE EXPRESS LIMITED
WARRANTY STATED ABOVE, ADIC MAKES NO WARRANTIES,
ADIC Limited Product Warranty
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EXPRESS OR IMPLIED, FOR THE SOFTWARE, INCLUDING THE
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE.

4. Term and Termination. This License commences on the Effective Date and
will continue in perpetuity unless Licensee fails to comply with any conditions
of this License. If Licensee breaches, ADIC may, after allowing Licensee a
reasonable time to cure its default, terminate this License upon written notice
to the Licensee. Within 30 days after termination of this License, Licensee will
certify, in writing, to ADIC, that Licensee has discontinued the use of all Soft-
ware and returned to ADIC the original and all copies of the Software and
Documentation in any form maintained by Licensee.

5. DISCLAIMER AND LIMITATION OF LIABILITY. THE LICENSEE HAS THE
SOLE RESPONSIBILITY FOR THE ADEQUATE PROTECTION AND BACK-
UP OF ITS DATA USED IN CONNECTION WITH THE SOFTWARE. IN NO
EVENT WILL ADIC BE LIABLE FOR SPECIAL, INDIRECT, INCIDENTAL OR
CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER
RESULTING FROM THE LOSS OF USE, DATA OR PROFITS, RERUN
TIME, INACCURATE INPUT OR WORK DELAYS, OR ANY PERSONAL OR
PROPERTY DAMAGE ARISING OUT OF OR IN CONNECTION WITH THIS
LICENSE OR THE USE, PERFORMANCE OR NON-PERFORMANCE OF
THE SOFTWARE, WHETHER IN ACTION, IN CONTRACT, OR TORT
INCLUDING NEGLIGENCE, EVEN IF ADIC KNEW, SHOULD HAVE KNOWN
OR HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
ADIC's LIABILITY FOR DAMAGES HEREUNDER WILL IN NO EVENT
EXCEED THE AMOUNT OF FEES PAID BY LICENSEE UNDER THIS
LICENSE.

6. General.

a.) No Assignment or Modification. This License is not assignable. None of
the Software or Documentation may be sublicensed, assigned, or
transferred to any other party without ADIC’s prior written consent. Any
effort contradictory with this is null and void. This License can only be
modified by a written agreement executed by the parties.

b.) Governing Law and Venue. The laws of the state of Washington will
govern this license. All litigation between the parties, including all
applications for injunctive relief, must be conducted before a court of
competent jurisdiction in King County, Washington, USA and both parties
consent to personal jurisdiction of such court. If any of the provisions of this
License are held to be invalid under any applicable statute or law, they are,
to that extent, deemed omitted.

c.) Entirety. Licensee acknowledges that it has read this Software License,
understands it, and agrees to be bound by its terms and conditions. Further,
5
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Licensee agrees that this is the complete and exclusive statement of the
agreement between the parties and supersedes all proposals or prior
agreements, oral or written and all other communications between the
parties relating to the subject matter of this License. Any variance from the
terms and conditions of this License or any supplement in any Licensee
purchase order or other written notification or agreement will be of no effect.

Safety Notices

The ATTENTION notice indicates the possibility of damage to a program, device,
system, or data.

The DANGER notice warns you of conditions or procedures that could result in
death or severe personal injury.

DANGER

AN ELECTRICAL OUTLET THAT IS NOT CORRECTLY WIRED COULD PLACE HAZARDOUS
VOLTAGE ON METAL PARTS OF THE SYSTEM OR THE DEVICES THAT ATTACH TO THE

SYSTEM. IT IS THE RESPONSIBILITY OF THE CUSTOMER TO ENSURE THAT THE OUTLET
IS CORRECTLY WIRED AND GROUNDED TO PREVENT AN ELECTRICAL SHOCK.

Safety Inspection

Perform the following safety checks to identify unsafe conditions. Be cautious of
potential safety hazards not covered in the safety checks. If unsafe conditions are
present, determine how serious the hazards are and whether you should continue
before correcting the problem.

Remove AC Power

Perform the following steps to remove AC power.

1. Perform a controlled system shutdown of attached host systems.

2. Set the Power switch on the ADIC Gateway to the off position.

3. Disconnect the power cord from the power source.

External Machine Check

Perform the following external machine check:

1. Verify that all external covers are present and not damaged.

2. Ensure all latches and hinges are in correct operating condition.
Safety Notices
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3. If the ADIC Gateway is not installed in a rack cabinet, check for loose or
broken feet.

4. Check the power cord for damage.

5. Check the external signal cable for damage.

6. Check the cover for sharp edges, damage, or alterations that expose the inter-
nal parts of the device.

7. Correct any problems that you find.

Internal Machine Check

Perform the following internal machine checks.

1. Check the condition of the inside of the machine for any metal or other
contaminants, or any indication of water, other fluid, fire, or smoke damage.

2. Check for any obvious mechanical problems, such as loose components.

3. Check any exposed cables and connectors for wear, cracks, or pinching.

Safety Label Check

Perform the following label check.

1. Verify that the safety label shown in Figure 1-1 is installed on the ADIC Gate-
way

2. If the safety label is missing, order and install it.
7
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Figure 1-1: Safety Label

3. Check the voltage label on the bottom of the device to ensure it matches the
voltage at the power source.

4. Check the voltage level at the power source.

5. Check for proper grounding. See Figure 1-2.

Figure 1-2: Ground Test

Note: Always use an analog meter, never a digital meter, to perform
the ground check of the outlet. A digital meter can give the wrong
readings if ground current is present.
Safety Notices
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6. With the power cord connected to the ADIC Gateway, verify that there is 1.0
ohm or less resistance between the ground lug on the power cord plug and
the metal frame.

7. If the ADIC Gateway passes the test in the previous steps, connect the power
cord to the power source.

Fusing Requirements

Figure 1-3 shows the fusing label.

Figure 1-3: Fusing Label

The ADIC Gateway uses double-pole / neutral fusing.

Replace these fuses with the same rating.

The fuses are 4A – Time Lag / 250 V
9
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AC Grounding

Figure 1-4 shows AC grounding on the ADIC Gateway.

Figure 1-4: AC Grounding

Environmental Notices and Statements

Product Recycling

This unit contains recyclable materials. These materials should be recycled where
processing sites are available and according to local regulations.

Lithium Battery

RISK OF FIRE, EXPLOSION, OR BURNS. DO NOT SHORT CIRCUIT, CRUSH, HEAT ABOVE
100 C, INCINERATE, OR DISASSEMBLE THE BATTERY

Laser Safety

This unit may contain a single-mode or multi-mode transceiver, both of which are
Class 1 laser products. The transceiver complies with IEC 825-1 and FDA 21 CFR
1040.10 and 1040.11. The transceiver must be operated under the recommended
operating conditions.
Environmental Notices and Statements
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General Restrictions

The classification is valid only if the module is operated within the specified
temperature and voltage limits. The system using the module must provide power
supply protection that guarantees that the system power source will cease to
provide power if the maximum recommended operation limit or more is detected
on the +3.3 V/+5 V at the power source. The operating temperature of the module
must be in the temperature range given in the recommended operating limits.
These limits guarantee the laser safety.

Usage Restrictions

The optical ports of the modules must be terminated with an optical connector or
with a dust plug.

Electronic Emission Statements

This section gives the electronic emission notices or statements for the United
States and other countries.

Federal Communications Commission (FCC) Statement

This equipment has been tested and found to comply with the limits for a Class A
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful interference when the equipment is
operated in a commercial environment. This equipment generates, uses, and can
radiate radio frequency energy and, if not installed and used in accordance with
the instruction manual, may cause harmful interference to radio communications.
Operation of this equipment in a residential area is likely to cause harmful
interference, in which case the user will be required to correct the interference at
his own expense.

Properly shielded and grounded cables and connectors must be used in order to
meet FCC emission limits. DISC is not responsible for any radio or television
interference caused by using other than recommended cables and connectors or
by unauthorized changes or modifications to this equipment. Unauthorized
changes or modifications could void the user’s authority to operate the equipment.

This device complies with Part 15 of the FCC Rules. Operation is subject to the
following two conditions: (1) this device may not cause harmful interference, and
(2) this device must accept any interference received, including interference that
may cause undesired operation.

Industry Canada Compliance Statement

This Class A digital apparatus complies with Canadian ICES-003.
11
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Avis de conformité à la réglementation d’Industrie Canada: Cet appareil
numérique de la classe A est conform à la norme NMB-003 du Canada.

European Community Compliance Statement

This product is in conformity with the protection requirements of EC Council
Directive 89/336/EEC on the approximation of the laws of the Member States
relating to electromagnetic compatibility. ADIC cannot accept responsibility for
any failure to satisfy the protection requirements resulting from a non-
recommended modification of the product, including the fitting of non-ADIC option
cards.

This product has been tested and found to comply with the limits for Class A
Information Technology Equipment according to European Standard EN 55022.
The limits for Class A equipment were derived for commercial and industrial
environments to provide reasonable protection against interference with licensed
communication equipment.

Attention: This is a Class A product. In a domestic environment, this product may
cause radio interference in which case the user may be required to take adequate
measures.

Where shielded or special cables (for example, cables fitted with ferrites) are used
in the test to make the product comply with the limits:

Properly shielded and grounded cables and connectors must be used in order to
reduce the potential for causing interference to radio and TV communications and
to other electrical or electronic equipment. Such cables and connectors are
available from ADIC authorized dealers. ADIC cannot accept responsibility for any
interference caused by using other than recommended cables and connectors.

Japanese Voluntary Control Council for Interference (VCCI) Class
1 Statement
Electronic Emission Statements



Introduction
Chapter 2: Introduction
This chapter describes the ADIC Gateway. It provides the following information:

• Overview
• Configuration Support
• Hardware Product Description and Features
• Supported Platforms
• Supported Devices
• Operating Specifications
• Agency Approvals
• Features

Overview

The ADIC Gateway is the interface between storage and Open System Host
interfaces and provides Fibre Channel to SCSI connectivity.

Configuration Support

The ADIC Gateway is a self-configuring product with Fibre Channel and SCSI
interface options. The ADIC Gateway can have up to four on-board UltraSCSI
channels and up to six SAN interfaces, which are configurable using plug-in cards.

Address Mapping

The ADIC Gateway maps addresses across and between these different
interfaces and preserves the persistency of the address maps across power ups
of systems, devices, and the ADIC Gateway. The ADIC Gateway supports the
attachment of up to 255 unique devices across multiple interfaces.

Interface Protocol Awareness

The ADIC Gateway processes SCSI-3 and SCSI-2 protocols for disk, tape, and
tape medium changer devices. It can report the host and devices that are attached
to its interfaces. The ADIC Gateway has the capability to manage the access
security between end points on the Fibre Channel interfaces and the SCSI
channels.
13
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ADIC Management Console

The ADIC Management Console offers full capability for remote management,
configuration, and event notification. Each ADIC Gateway has internal Event
Logging, Event Analysis, and periodic Health Checks for predictive failure
analysis. All of these management, configuration, and notification capabilities are
accessible via standard SNMP protocol for use with major network management
applications. The ADIC Management Console offers Java application software for
the ADIC Gateway remote management and configuration.

Access Security Capabilities

The ADIC Gateway is aware of the hosts and devices that are attached to its
interfaces and provides access security between hosts and devices. Access
security between different hosts and devices is a requirement for multi-initiator
SAN solutions. Using the ADIC Management Console, you can partition the SAN
for different levels of access and performance.

Virtual Private SAN™ Option

VPS technology enables Storage Area Networks with multiple users to share the
same connectivity channels or pipes to access the same or different storage
elements or resources. Therefore, multiple virtual private connections can be
created on the same storage networking infrastructure.

VPS is a Virtual Private connection or channel between a storage element and the
user of that element in a Storage Area Network. Virtual Private SAN is created by
a method of Access Security that manages the access between an Initiator (user,
host, system, ..) to Target/LUN (Device, Disk or Tape, ...) and also protects and
preserves such permission.

• VPS is completely host independent and requires no software
components on the host.

• VPS has no interface dependencies and supports Fibre Channel,
SCSI or any other SAN interface.

• VPS supports SAN connectivity/fan-out products such as hubs
and switches.

• VPS is independent of the storage elements and requires no
change in legacy or new storage devices.

An optional automatic host registration service that sends periodic host status
information to VPS is provided.

VPS is an optional software capability for the ADIC Gateway that requires a
license key to be enabled.
Configuration Support
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Data Mover

The ADIC Gateway can move data directly between storage devices that are
attached to it. This direct movement of data can be from disk to disk, disk to tape,
tape to disk or tape to tape. Data Mover frees-up valuable system resources on
the server and substantially increases the speed of backup and restore
operations.

Data Mover is the engine for Server-Free backup and restore and HSM
applications that support the Extended Copy Specification (ANSI T10/99-143r1).

The Data Mover capability is always available to users of the ADIC Gateway

Virtual Private Map™ Option

VPM technology enables legacy and new systems equipped with SCSI Host Bus
Adapters to access SAN devices.

• VPM allows Fibre Channel and SCSI Target devices to be
mapped to private SCSI host channels.

• VPM is completely host independent and requires no software
components on the host.

VPM is an optional software capability for the ADIC Gateway that requires a
license key to be enabled before use.

Channel Zoning

Channel Zoning is a means of managing the access security between SAN
connections and SCSI channels on a channel by channel basis.

Channel Zoning can be used to secure access between a server and its storage,
segregating them, for example, from other servers and their respective storage.

The default settings allow all SAN connections to access all SCSI Channels.

The Channel Zoning capability is always available to users of the ADIC Gateway.

Hardware Product Description and Features

This section describes the capabilities of the product and outlines some of the key
features of its interfaces.

• An Intel i960RD 66 MHz I/O processor with integrated instruction
set and data caches

• Interleaved fast-page-mode (FPM) processor memory using
15
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standard 60 nanosecond FPM SIMMs for command, control, and
code execution

• Non-volatile FLASH memory for operational firmware, power on
self-test code, diagnostic functions, system utilities, persistent
configuration tables, and event log. The default configuration is 2
MB.

• VxWorks real-time operating system (RTOS)

Fibre Channel Interfaces

Interfaces for host and device attachment can be configured for up to three plug-in
PCI Mezzanine Cards (PMCs). These interfaces can be configured to use single-
port copper, single-port Short Wave Optical, single-port Long Wave Optical, or
dual-port Short Wave Optical Fibre Channel PMCs.

The PMCs can be replaced in the field by the customer or by a service
representative.

Fibre Channel interfaces support the following Public and Private Loop modes:

• Target
• Initiator
• Target and Initiator

Fibre Channel Interfaces also support the following connection options:

• Loop
• Point-to-Point
• Loop Preferred

Fibre Channel interfaces are in compliance with the following standards and
specifications:

• Private Loop (FC-PLDA, Rev. 2.1, Sept 22, 1997) Class 3
• Public Loop (FC-FLA, Rev. 2.7, Aug 12, 1997) Class 3
• Fibre Channel-AL-2 Rev. 6.4, Aug 28, 1998
• Fibre Channel-PH Rev. 4.3, June 1, 1994
• SCSI- Fibre Channel P, Rev. 12, May 30, 1995

Table 2-1: Fibre Channel Connections
Connection Type Connector Cable Type Speed Distance

Copper HSSDC 1.062.5 Mb/sec 30 m

Optical Short Wave Duplex SC 62.5 µ multimode 1.062.5 Mb/sec 300 m
Optical Short Wave Duplex SC 50 µ multimode 1.062.5 Mb/sec 500 m
Optical Long Wave Duplex SC 9 µ multimode 1.062.5 Mb/sec 10 km
Hardware Product Description and Features
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Ultra2 SCSI I/O Interfaces

• Any or all of the three PCI Mezzanine Card (PMC) interfaces can
be configured to use a dual-ported Ultra2/3 SCSI PMC board
instead of a Fibre PMC.

• Ultra2/3 SCSI PMCs are available as Single-Ended/Low Voltage
Differential (SE/LVD) or High Voltage Differential (HVD).

• SCSI PMCs use standard VHDCI stacked right-angle SCSI
connectors, and autonegotiate speeds of up to 80 MHz for Ultra
SCSI-2 and 160 MHz for Ultra SCSI-3.

• The cable lengths can be as long as 25 meters with HVD
interfaces and 12 meters for LVD/SE interfaces.

The SCSI interfaces are compliant with the following SCSI specifications:

• ANSI T10/1071D Rev. 6, SCSI-3 Fast-20
• ANSI T10/375D Rev. 10t, SCSI-2
• ANSI T10/1142D Rev 20b, SCSI-3 Parallel Interface-2

Ultra SCSI I/O Modules

The key features and capabilities of the ADIC Gateway’s on-board Ultra SCSI I/O
modules are listed below.

• Up to four Ultra Wide SCSI channels--Single-Ended (SE), high
voltage differential (HVD), and/or Low Voltage Differential (LVD)--
with internal termination are possible.

• SCSI channels have automatic speed and width negotiation
capability for wide or narrow bus widths and Standard, Fast, or
Ultra speeds. These parameters can be viewed from the ADIC
Management Console.

• You can disable the termination on SCSI channels through the
installation of a jumper or from the ADIC Management Console.

• The SCSI ID of each channel is set by default to 7 and can be
changed from the ADIC Management Console.

• Each SCSI channel supports up to 15 SCSI target IDs and up to
32 LUNs per ID (subject to an overall total of 256 devices). The
ADIC Gateway uses one LUN for command and control so that
the remaining 255 LUNs are available for SCSI devices. For
each Fibre Channel interface, the ADIC Gateway occupies one
Fibre Channel ID and all SCSI target devices are available as
LUNs on the same Fibre Channel ID.

• The unit comes with SCSI-3 68-pin jackscrew external connectors
for maximum mechanical reliability.

• Cable lengths can be as long as 25 meters with SCSI HVD
interfaces.
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Ethernet

The 10/100 Base-T Ethernet port has an RJ-45 connector for out-of-band
management. It can be connected to a network hub using an unshielded twisted-
pair Ethernet cable. The Ethernet port complies with the IEEE 802.3 specification.

Service Port

The service port is an RS-232 connection with a 9-pin D-shell connector (DTE). It
is compatible with serial ports on personal computers.

The service port is used for local service and diagnostics when you use a terminal
session to the shell interface.

The service port is configured at 19,200 Baud, 8 data bits, no parity and XON/
XOFF. It connects to the host serial port with a 9-pin to 9-pin null modem cable.

Enclosure

The enclosure is designed for strength, durability, and electromagnetic and radio
frequency interference (EMI/RFI) immunity.

The external dimensions are:

• 2U (3.5”) high
• 11” deep
• 16.73” (standard 19” rack) wide

It is available with standard 19-inch Rack Mount or Desk Top configuration kits.

The enclosure has two ball bearing cooling fans that draw air in through the side
of the enclosure. The exhaust is on the opposite side.

Two temperature switches monitor the internal temperature of the enclosure. One
switch indicates a temperature warning at 60°C and the other indicates a
temperature alarm at 70°C.

The enclosure has an Enclosure Monitor Register facility. It monitors the status
and health of all components of the enclosure and reports it to the ADIC
Management Console. Status is also displayed on the front panel LED indicators.

Power Supply Unit

The power supply is an auto-sensing universal power supply nominally supporting
power between 100 -127 VAC and 200-240 VAC, at a frequency of 50/60 Hz, with
a maximum input power rating of 90W.
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It has the highest reliability and mean time between failure (MTBF) numbers and
is manufactured by a leading power supply company with excellent field reliability
results in the industry.

It has a standard integrated power entry, on/off switch, and fuse holder. It uses
two 250 V 4A time lag fuses.

The power supply status is monitored as part of the Enclosure Monitor Register
and is reported by the front panel LED, and to the ADIC Management Console.

LED Indicators

On the front panel there are LEDs that provide a visual indication of the status and
activity of the ADIC Gateway and its interfaces. When the ADIC Gateway is first
turned on, some of the LEDs will be on and others will flash while it is booting.
Starting from the left of the front panel, the following list describes how to interpret
the LED signals after the ADIC Gateway has finished booting.

Figure 2-1: LEDs on Front Panel

• SAN Connections
A group of six green LEDs that indicate Status and Activity on the SAN

interfaces for each of the three PMC slots.

If a single-port Fibre Channel card is installed, the Status LED will be
ON when the port is up and is connected to a live Fibre Channel
device. The Activity LED will flash when there is activity on the SAN
interface.

If a dual-port Fibre Channel card is installed, the Status LED will be
ON when both ports are up and are connected to live Fibre Channel
devices. The Status LED will flash once per second when the numer-
ically lower port is down and the numerically higher port is up. The
Status LED will flash every two seconds when the numerically higher
port is down and the numerically higher port is up. The Activity LED
will flash when there is activity on one or both SAN interfaces.

• SCSI Channels
A group of four green LEDs. One LED for each of the four SCSI chan-
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nels. A flashing Activity LED indicates activity on a SCSI Channel.

• Ethernet
A group of three LEDs (two green, one amber) indicate the Link,

Transmit, and Collision statuses of the Ethernet Port network con-
nection.

• Temperature
A group of two amber LEDs indicate Temperature Warning and Tem-

perature Alarm. Normally the LEDs are OFF indicating temperature
is within acceptable limits.

• Power
A green LED indicates the status of the main power supply. Normally

the Power LED is ON indicating that the power supply is ON and out-
put voltage is within acceptable limits.

• RDY
A green RDY LED indicates a status of ready. Normally the RDY LED

flashes once per second indicating good health. The RDY LED
begins flashing after the ADIC Gateway has finished booting. If the
LED is ON for more than a few seconds it means there is a problem.
If the LED is OFF (and the ADIC Gateway is turned on) it means
there is a problem. If the LED is flashing rapidly (and you have not
selected “Identify Gateway” via the ADIC Management Console), it
means there is a problem.

Supported Platforms

The ADIC Gateway is a platform-independent product. You can connect a host to
the ADIC Gateway after you have installed the appropriate host bus adapter and
drivers. You can also connect host systems with different operating systems to
the ADIC Gateway through Fibre Channel.

For a current list of supported platforms, configurations, and host bus adapters,
visit “Service and Support” at www.adic.com, or call the ADIC Technical
Assistance Center at 1-800-827-3822.

Supported Devices

The architecture and implementation of the ADIC Gateway software has full
SCSI-2 and SCSI-3 target and initiator support. The ADIC Gateway has support
for disk, tape, and medium changer devices. The product supports all these
devices with the same ADIC Gateway firmware. Multiple target device type drivers
coexist to support different device types.
Supported Platforms
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For a current list of supported devices, see the Web site and technical support
contact information, visit “Service and Support” at www.adic.com, or call the ADIC
Technical Assistance Center at 1-800-827-3822.

Operating Specifications

This section contains the physical, electrical, and environmental specifications for
the product.

Installation Options

• Desk top with four rubber feet
• Rack mount with two rack mount brackets

Physical Dimensions

• Height: 3.5” (2U)
• Width: 16.73”(Standard 19” rack)
• Depth: 11”

Operating Environment

POWER ON, OPERATING EXTREMES

• Temperature: 10°C to 40°C (50°F to 104°F)
• Relative Humidity: 8% to 80%
• Wet Bulb: 27°C (80°F)

POWER ON, RECOMMENDED OPERATING POINTS

TEMPERATURE

• 22°C (72°F) Relative Humidity: 45%
POWER ON, RECOMMENDED OPERATING RANGES

• Temperature: 22°C to 25°C (68°F to 77°F)
• Relative Humidity: 40% to 50%

POWER OFF

• Temperature: 5°C to 45°C (41°F to 113°F)
• Relative Humidity: 8% to 80%
• Wet Bulb: 27°C (80°F)
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STORAGE

• Temperature: 0°C to 60°C (32° F to 140° F)
• Relative Humidity: 8% to 80%
• Wet Bulb: 29°C (84.2°F)

Power Consumption

The power consumption of this product depends on the number and type of
installed interface options. The following numbers are line power consumption
values for a fully configured product. The maximum line power consumption is 90
watts in active mode. Typical line power consumption is 60 watts in active mode.

AC Power Requirement

100 -127 VAC and 200-240 VAC, at a frequency of 50/60 Hz

Agency Approvals

The SAN Router is tested and conforms to the following agency approval
requirements:

• Class 1 laser product (with Fibre Channel optical option only)
• Complies with FDA 21 CFR 1040.10 and 1040.11
• CSA Mark with an NRTL/C indicator
• The NRTL/C indicator adjacent to the CSA Mark signifies that the

product has been evaluated to the applicable ANSI/UL and CSA
standards, for use in the U.S and Canada.

• FCC Rules, Part 15, Class A
• EMC directive 89/336/EEC (CE Mark)
• EN55022, Class A
• EN61000-4-2 ENV50140
• Australian EMC Framework (C-Tick mark)
• AS/NZS 3548:1994, Class A
• VCCI, Class 1

Introduction to the ADIC Management Con-
sole

The Director uses a combination of industry-standard Simple Network
Management Protocol (SNMP) requests and a method or technology known as
SCSI over TCP, which encapsulates SCSI commands and/or data in TCP
packets.
Introduction to the ADIC Management Console
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Client/Server Model

Figure 2-2: ADIC Management Console Application Model

Agent

Each ADIC Gateway is a stand-alone, SNMP-manageable host. The ADIC
Management Console uses SNMP as the primary method of communication with
the agents. This allows you to set and retrieve information that controls the
operation of the agent. It also provides alerts (traps) when an event has occurred
that requires intervention. The SCSI/TCP component allows you to update
firmware on the ADIC Gateways and target devices and manipulate device
operating parameters. The agent component is embedded in the operating
software of the ADIC Gateway.

Server

The Server component is a Java application that runs on a host computer system
(see “Installation Requirements”). The server is responsible for maintaining
communication with the managed agents, and acts as an intermediary between
the agent running on the ADIC Gateway and multiple Clients. It provides security
features by maintaining account names and passwords on behalf of the Client
application. By keeping track of different Client views, a user can recall a saved
view from any Client.

The Server coordinates the requests from multiple clients to manage multiple
ADIC Gateways. Communication between the Server and the agents is carried
out either by SNMP or SCSI/TCP, as required. Specifically, the Java Management
Application Programming Interface (JMAPI) is used where possible to provide an
industry standard and transportable interface. All communications between the
Clients and the Server is implemented using the Java Remote Method Invocation
(RMI), a form of remote procedure call (RPC).
23
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The Server is written to be both transportable and efficient. Multiple Clients can
share data the Server already knows about rather than having to request the data
again. In addition, the Server receives all traps from the agents and forwards them
to the Clients that have registered to receive them.

Client

The Client is a Java application. One or more Clients connect to a Server in order
to manage the ADIC Gateways. The Client operates from any compatible
computer, as long as a TCP/IP connection is established to the Server
component. This allows for dial-in configurations using Point-to-Point Protocol
(PPP), intranet, or Internet access (where allowed by local network policy and
firewall configurations). If the client is started on the same host as the server, a
connection will automatically be established.

The Client is the application that provides the user interface and allows viewing
and manipulating of all ADIC Gateways and device parameters. Each Client can
be configured by the individual user to show only the ADIC Gateways of interest.
This means that one Client can monitor one set of ADIC Gateways and other
managers can be responsible for totally different ADIC Gateways, without
interfering with each other.

The Client uses Java RMI calls to communicate with the server, and SCSI over
TCP to communicate directly to the ADIC Gateways for some operations.

Features

SNMP

SNMP community strings serve to group network devices into logical collections
for management purposes. The community strings on the Server must match
those on the ADIC Gateway you wish to manage.

There are three different strings defined for the ADIC Management Console:

Read for querying the ADIC Gateway.
Write for controlling the ADIC Gateway.
Trap for receiving event messages from the ADIC Gateway

The ADIC Gateway can maintain 32 Read and Write community strings and 1
Trap community string.
Features



Features
SNMP Community Support

A set of commands is provided for manipulating the SNMP Community strings.
These strings act as passwords for authenticating requests made from managing
applications such as the ADIC Management Console.

There are three different communities defined: Read (allows “Gets” only), Write
(allows “Sets”, i.e., changes to be made) and Trap (defines the Community string
that a trap recipient will allow). In order for a managing application to view or
control an SNMP agent (such as the ADIC Gateway), it must provide the correct
community string for each request. The ADIC Gateway allows up to 32 community
strings for each of the Read and Write communities. There is only a single Trap
community string.

Security

Logging on to a server is required to manage the ADIC Gateway via the ADIC
Management Console application. Two levels of privilege control what type of
access is allowed:

Administrator

Allows full access, including changing parameters

User

Allows viewing of data and parameters only

Service Port access is managed with User accounts created via telnet or the serial
interface on the ADIC Gateway

SAN Access Control

Access control features include Channel Zoning, optional Virtual Private SAN
(VPS™) and optional Virtual Private Map (VPM™).

Channel Zoning allows selected SCSI channels to be available to selected SAN
connections.

The VPS option requires a software license key to enable the Initiator-Target/LUN
access control feature. VPS manages access permission between any host
attached to a SAN connection and any storage element attached to the ADIC
Gateway. This includes storage devices attached to any SCSI Channel and
storage devices attached to any other SAN Connection on the ADIC Gateway.

The VPM option requires a software license key to enable target devices on any
channel to be mapped to any SCSI host channel.
25
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Host Registration Service

The Host Registration Service is software that installs on the host from the CD-
ROM or it can be downloaded from the website. It simplifies VPS configuration for
the system administrator. It removes the burden of physically tracing each
connection to correlate the Fibre Channel HBA World Wide Name (WWN) with a
specific host.

The registration service installs on most host platforms and it provides the ADIC
Gateway with periodic host status information including the host name, host type
and type of HBA installed. Host information is sent over the host Fibre Channel
connection to the ADIC Gateway.

Once installed, the service runs automatically and does not require further system
administrator interaction. From the ADIC Management Console, you can see the
Fibre Channel that the host is connected to and you can tell whether the host is on
or offline.

Saved Views

Each user can store their own preferred views on the server. Loading a previous
view automatically connects the user to one or more ADIC Gateway in a single
step rather than specifying connections to ADIC Gateways individually. Because
they are stored on the server, the same views are available to the user from any
client.

Network Discovery

Network discovery allows you to locate any ADIC Gateway based on network
addresses and network masks. This allows management of an ADIC Gateway
without knowing the specific Internet Protocol (IP) address beforehand.
Alternatively, the IP address (or name, if it can be resolved through DNS) of an
ADIC Gateway can be entered directly for instant access.

Configuration Options

You can set up an ADIC Gateway with a number of non-default parameters,
channel settings, and event management variables.

Software Updates

You can update the ADIC Gateway firmware from the client. You can also send
device micro-code to individual target devices as a means to update their
firmware.
Features
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Event Logging

You can retrieve and view the ADIC Gateway event logs in a table. Filtering based
upon the significance of events simplifies fault isolation.

Health Checks

Instantaneous and periodic health checks allow monitoring of each SAN Gateway
and devices attached to it. The level and interval of the health check is selectable
to obtain greater confidence or minimize the impact on system performance.

Views

Two different viewing modes are available.

Tree view shows all available ADIC Gateways and can be expanded to show
greater levels of detail.

Front panel view shows the status of the LED indicators for a selected ADIC
Gateway.

Heartbeat

Each component of the ADIC Management Console monitors the components
with which it communicates to ensure continuity of service. If the ADIC Gateway is
no longer available, the server component notifies monitoring clients
27
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Installation
Chapter 3: Installation
This section covers installation of the ADIC Gateway, SCSI devices, and the host
adapter. Before you or your service representative installs the ADIC Gateway you
must perform the steps in the Pre-installation checklist.

Note: Ensure SCSI device interfaces match the interfaces of the attached SCSI
devices (SE/LVD or HVD).

Instructions on how to install the product is divided into three sections:

Pre-installation Checklist:

Before you or the service representative installs the ADIC Gateway
check the items on the pre-installation checklist.

Installation Checklist:

The installation checklist has instructions on how to install the ADIC
Gateway. You may have the option of having a service representative
perform this portion of the installation for you.

Post-installation Checklist:

After you or the service representative installs the ADIC Gateway, fol-
low the post-installation checklist to complete the installation.

Pre-installation Checklist

It is important that the items in this checklist are verified before you begin the
installation of the ADIC Gateway. This ensures a successful installation of the
product.

Table 3-1: Pre-Installation Steps

Step User Action or Decision Comments and References

1 • Desktop Install
• Rack Mount Install

Decide whether the ADIC Gateway is to
be installed on a desktop or rack
mounted. See “Desktop Configuration”
on page 38 or “Rack Mount
Configuration” on page 38
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2 Verify host platform OS,
required Service Pack
installed
For example: Windows NT
4.0, Service Pack 6a (or
later)

For a current list of supported platforms
required host platform code updates and
information on how to obtain them, ADIC
Gateway

3 Verify required Fibre
Channel Host Bus Adapter,
HBA BIOS and device
driver procured, installed

For a list of supported HBAs and the
required BIOS and device driver, visit
“Service and Support” at www.adic.com,
or call the ADIC Technical Assistance
Center at 1-800-827-3822

See also “Host Adapter Setup” on
page 44

4 If you will be connecting
more than one host to the
ADIC Gateway and you
want to use the Virtual
Private SAN or Virtual
Private Map access
options, be sure you have
the necessary licenses

See “Setting up Access Control” on
page 58

5 If you are using Virtual
Private SAN or Virtual
Private Map, install the
Host Registration Service
on the hosts that will be
connected to the ADIC
Gateway

For Windows NT/Windows 2000, see
“Installing the SAN Explorer and Host
Registration Service” on page 44

For Solaris, AIX and other platforms, see
“Installing the Host Registration Service”
on page 44

6 Ensure that all host Fibre
Channel cables
• Have been ordered with
the product or have been
preinstalled and checked
• Are marked with:

-Host system
identifier

- ADIC Gateway
system identifier

Refer to the HBA Specification provided
with your HBA and “Hardware Product
Description and Features” on page 15

Table 3-1: Pre-Installation Steps

Step User Action or Decision Comments and References
Pre-installation Checklist
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7 Ensure that SCSI disk or
tape system installation
has been completed.
• For tape attach, tape
device driver installed or
updated
• Mark both ends of each
SCSI cable with

-Target ID and
channel number

-ADIC Gateway ID
and channel number

Usually done by you or a service
representative during target device
installation

8 Decide on network
parameters.
Ethernet port configuration
decisions:
• Static IP
address____________
• Netmask (if
required)_________
• User-defined ADIC
Gateway name
(optional)_______________
If the ADIC Gateway is not
on the same TCP/IP
subnet as the server*,
assign the default network
gateway address and/or
route table entries.
_____________________

Attention: Save this
configuration information
for future reference.

Obtain the network parameters from your
network administrator.
Attention: Use of incorrect network
parameters can cause problems on the
Ethernet network.
The default network name is ADIC
Gateway. If you choose a different name,
it becomes the prompt displayed on the
service terminal. Choosing a different
name may be useful if you have more
than one ADIC Gateway

9 Run the Ethernet cable
from the ADIC
Management Console
server to the network hub

None

Table 3-1: Pre-Installation Steps

Step User Action or Decision Comments and References
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Installation Checklist

The installation checklist has instructions on how to install the ADIC Gateway with
SCSI attached storage and FC attached hosts. You may have the option of having
a service representative perform this portion of the installation for you.

10 Run the Ethernet cable
from the network hub to the
ADIC Gateway

None

* Server in this context means the computer used for the ADIC Management
Console server application

Table 3-2: Installation Steps

Step User Action or Decision Comments and References

1 Acquire information for
ADIC Gateway installation

Refer to Step 8 in Table 3-1: “Pre-
Installation Steps”

2 Unpack the ADIC
Gateway.
Check the components
against the ship group list

3 If desktop, install four
rubber feet (ADIC
Gateway supplied parts)

If rack mount, install rack
mounting (ADIC Gateway
supplied parts)

If desktop, go to “Desktop Configuration”
on page 38.

If rack mount, go to “Rack Mount
Configuration” on page 38.

4 Connect the Power Cord
to the SAN Gateway

Go to “Connecting Power” on page 43.

Table 3-1: Pre-Installation Steps

Step User Action or Decision Comments and References
Installation Checklist
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5 Connect the service
terminal to the Service
Port and start up a
terminal emulation session

See “Connecting to the Service Port” on
page 217.

Step User Action or Decision Comments and References

6 Turn on the ADIC
Gateway and observe the
startup messages on the
service terminal

Look for “done executing startup script”
message (See “Startup Message
Reference” on page 315)
Within one minute, the Ready LED
should start flashing once per second.
If the “done executing startup script”
message is not seen or the Ready LED
is not flashing as expected, go to “Start
MAP” on page 157

7 Issue the
initializeBox
command from the service
terminal. After issuing this
command, the ADIC
Gateway will reboot
automatically.

See “Service Port Command Reference”
on page 223.
Attention: This command will erase all
configuration information. It should be
used only during initial ADIC Gateway
installation

8 If you purchased licenses
for the Data Mover
Module, VPS, or VPM, you
should activate them now
by typing
sncFeatureEnable
vpmFeatureEnable
vpsFeatureEnable

see Appendix B: Service Port Command
Reference

9 Look for the “done
executing startup script”
message on the service
terminal, then turn off the
ADIC Gateway

None

Table 3-2: Installation Steps
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10 The SCSI disk or tape
subsystems must be
installed and verified
before the ADIC Gateway
installation can continue

None

11 Connect the SCSI cables
from the target devices to
the ADIC Gateway.
Turn on the SCSI target
devices

Go to “Attaching SCSI Devices” on
page 39

Step User Action or Decision Comments and References

12 Turn on the ADIC
Gateway

Within one minute, the Ready LED
should start flashing once per second
and the “done executing startup script”
message should be displayed on the
service terminal

13 Issue the targets
command from the service
terminal.

See “Appendix B: Service Port
Command Reference”.
If all attached SCSI targets are not
shown, go to “SCSI MAP” on page 171

13 • Configure the Ethernet
Port (Host Name, Address,
Routes, Enable Ethernet,
reboot).
• Connect the Ethernet
cable from the network hub
to the ADIC Gateway
• Observe Ethernet Link
LED

Configure the Ethernet Port using
information from Step 8, Table 3-1: “Pre-
Installation Steps” on page 29.
Go to “ADIC Gateway Network Setup” on
page 49.
If the Ethernet Link LED is not on, go to
“Ethernet MAP” on page 187

14 Issue hostTypeShow 
command from the service
terminal to view host type
settings for the Fibre
Channel ports.
If the hosts that will be
connected are not the type
shown, issue setHost
command from the service
terminal to set the host
type for each Fibre
Channel port

See ““setHost [port],“OS”” on page 270”.
If the Virtual Private SAN access control
option will be installed, VPS will
configure the host type for each host and
override the Fibre Channel port host type
settings

Table 3-2: Installation Steps
Installation Checklist
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15 Power down the FC
host(s).
Connect the FC cables
from the FC HBA(s) to the
ADIC Gateway.
Power up the FC host(s)

If SAN Connection Status LED for the
attached host(s) is not on, check FC
cables. You may have to change the
polarity of the FC cables. If problem
persists, go to “Fibre Channel MAP” on
page 178

Step User Action or Decision Comments and References

16 Issue fcShow command
from the service terminal
to show the status of each
FC interface that is
installed and connected.
Issue fcShowDevs
command from the service
terminal to show SCSI
target devices that are
connected as seen by the
Fibre Channel interface

See “Service Port Command Reference”
on page 223.
In the output of the fcShow command,
look for the Firmware State column. If the
word Ready does not appear, go to
“Fibre Channel MAP” on page 178.
Check to see that all SCSI target devices
are seen by each FC interface. If not, go
to “SCSI MAP” on page 171

17 Verify all target devices
are available to the host
system(s)

Use appropriate host system utilities for
disk and tape. If all devices are NOT
available, reboot host system(s) and
check again. If problem persists, go to
“Start MAP” on page 157

18 Perform steps in Table 3-
3, on page 36 “Post-
Installation Checklist”

In SAN Configuration, two specific areas
require understanding and attention:
• Access Control
• Save Configuration
For more information on these, see
“Understanding SAN Configurations” on
page 53

Table 3-2: Installation Steps
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Post-installation Checklist

Perform the actions listed in Table 3 after you or your service representative have
completed the installation steps.

Table 3-3: Post-Installation Steps

Step Customer Actions Comments and References

1 Install the ADIC
Management Console
software.
For an updated list of
supported systems, visit
“Service and Support” at
www.adic.com, or call the
ADIC Technical Assistance
Center at 1-800-827-3822.

See “Install the ADIC Management
Console Software” on page 46
The designated system will be used as
the central point for monitoring and
controlling ADIC Gateways

2 Ensure that the designated
system has access to the
same Ethernet subnet as
the ADIC Gateway

Consult your network administrator

3 Start-up the ADIC
Management Console
server

See “Startup and Configuration” on
page 47

4 Start-up the ADIC
Management Console
client:
• Connect to the server (if
it does not find the server
running on the same sys-
tem)
• Log on
• Add new administrator
account and password. This
removes the default account
• Log off and log on using
the new administrator
account

Connect using the name or IP address of
the designated server system.
See “Startup and Configuration” on
page 47

5 From the client, connect to
the desired ADIC
Gateways

See “Connect SAN Gateway” on page 80

6 Save your user/
administrator view

See “Save Current View as” on page 66
Post-installation Checklist



ADIC Gatewa
ADIC Gateway Setup

Placing the ADIC Gateway

Whether installed in a rack or on a desk, the ADIC Gateway must be situated with
a minimum of one inch of clearance on either side to allow adequate airflow

7 If later firmware is
available, perform the
following for each ADIC
Gateway:
• Update firmware
• Restart

See “Controls Menu Group” on page 94

To obtain information about firmware
updates, visit “Service and Support” at
www.adic.com, or call the ADIC Technical
Assistance Center at 1-800-827-3822

8 If you chose an Access
Control option in Step 8 of
Table 3-1: “Pre-Installation
Steps” on page 29, Use
the ADIC Management
Console to enable Access
Control

See “Access Options” on page 97

9 At this time, you MUST
save the ADIC Gateway
configuration

See “Save SAN Gateway Configuration”
on page 90

10 Become familiar with using
the ADIC Management
Console

See “Using the ADIC Management
Console” on page 63

11 You must use the ADIC
Management Console to
monitor and maintain your
Storage Area Network.
If a trap/event is reported
by the ADIC Management
Console, check the
reported event code, then
see and perform the
recommended action

See “Remote Event Notification” on
page 307

Note: We highly recommend that you save your ADIC Gateway configuration
periodically. You MUST save your configuration if you add or remove devices,
or if you make changes to access control or other operating parameter settings

Table 3-3: Post-Installation Steps
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through the box. The ventilation holes in each side of the unit must never be
blocked.

There are no spacing requirements above or below the unit.

Desktop Configuration

The ADIC Gateway is shipped with four rubber feet that should be used when the
ADIC Gateway is placed on a desktop or other flat surface. Perform the following
to install the rubber feet.

1. Turn the ADIC Gateway upside down.

2. Remove the backing from the adhesive side. Apply to each of the corners on
the bottom of the ADIC Gateway approximately ¼-inch from each edge. See
Figure 3-1.

Figure 3-1: Installing the Rubber Feet for Desktop Use

Rack Mount Configuration

The ADIC Gateway rack mount kit (included) contains brackets, screws, and
washers that enable it to be mounted in a standard rack. See Figure 3-2. If your
rack does not have threaded rails, you will need to provide clipnuts to complete
the installation. The rack screws that are provided are threaded 10-32. If this does
not match the threaded rails, you will need to provide other screws to complete
the installation. To install into a rack, perform the following:

1. Using one of the brackets, locate the holes you will be using on each side rail
of the rack. Insert the clipnuts (A) if the rails are not threaded.
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2. Attach a bracket (D) to each side of the ADIC Gateway using the small screws
(A) provided with the brackets.

3. Place a washer on each screw (C). Hold the ADIC Gateway in the rack and
secure with four screws.

Figure 3-2: Installation Into a Rack

When mounted in an enclosed rack, provision must be made to exchange 24 CFM
of air between the interior of the rack and the room environment for each ADIC
Gateway installed.

Attaching SCSI Devices

SCSI devices are attached to any of the SCSI connectors on the rear of the ADIC
Gateway. The device types and speeds, as well as cabling, target IDs, and
termination are discussed below. High quality cables with the correct latches or
screws must be used at all times to ensure reliable connections. Cables are not
provided with the ADIC Gateway.

Note: Ensure that you read this section before you attach any devices
to the ADIC Gateway. A summary table appears at the end of this
discussion.
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Maximum Number of LUNS

The ADIC Gateway supports up to 255 LUNS.

Attention: Do not attach more than 255 LUNS to the ADIC Gateway. Exceeding
the 255 LUN limit will result in unreliable behavior.

Transfer Rates: Ultra, Fast, and Asynchronous

The SCSI protocol defines two methods of data transfer: synchronous and
asynchronous. Asynchronous transfers may run as fast as 5 MHz, while
synchronous transfers may run as fast as 160 MHz (Ultra3).

The rate of transfer is negotiated between a SCSI initiator, such as the ADIC
Gateway, and each target. For each target device identified during a bus scan, the
ADIC Gateway will request a transfer rate at the fastest transfer rate supported by
the ADIC Gateway. The target will then reply with the maximum transfer rate it will
support.

Note: In general, devices that are capable of running at Ultra2/3 speeds should
not be mixed on a bus with slower devices, since the bus speed will be set to
match the slowest device on the bus.

Wide and Narrow SCSI Buses

A SCSI bus may be either narrow (8 bit) or wide (16 bit). The ADIC Gateway SCSI
buses are all wide, but may be connected to narrow devices with the correct cable
adapters.

Although it is possible to mix narrow and wide devices on a single SCSI bus, this
configuration is not recommended. If any of the devices supports Ultra2/3 speeds,
then a mix of narrow and wide devices is prohibited.

In order for the ADIC Gateway to locate and communicate with the devices, each
device on the SCSI bus must be assigned a unique target ID. On a wide (16 bit)
SCSI bus, the SCSI standard allows for a total of 16 target IDs. On a narrow (8 bit)
SCSI bus, the SCSI standard allows for a total of 8 target IDs. There are no
requirements about the ordering or position of the target IDs on the SCSI bus. The
only requirement is that there be no duplicate target IDs. By default, the ADIC
Gateway uses ID 7. Thus, peripheral devices may be assigned IDs 0 through 6
and 8 through 15, typically selected by a switch or jumpers. These settings may
be changed.

Attention: Make sure you do not assign more than one device on a
bus to the same target ID. This will prevent that bus from working
properly.
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The SCSI protocol also defines a priority-based arbitration method, based on the
target ID of the device attaching to the bus. The SCSI ID priority order is, from
highest to lowest, 7, 6, 5, 4, 3, 2, 1, 0, 15, 14, 13, 12, 11, 10, 9, 8.

Table of SCSI Terminology and Limitations

The following table (look for updates at http://www.scsita.org/) defines the number
of devices supported, based on the negotiated transfer type. When reviewing the
limitations of a bus, the capabilities of the fastest devices must be considered. The
bus length indicates total SCSI bus length, including any internal device cables,
rather than the length between any two devices.

Table 3-4: SCSI Trade Association Terminology

Endorsed
Terminology

for SCSI Parallel
Interface

Technology

Max.Bus
Speed,
MBytes/

Sec

Bus Width,
Bits

Max. Bus Lengths,
in Meters (1)

Max.
Devices

SE HVD LVD

SCSI 1 (2) 5 8 6 (3) 25 8

Fast SCSI (2) 10 8 3 (3) 25 8

Fast Wide SCSI
(2)

20 16 3 (3) 25 16

Ultra SCSI (2) 20 8 1.5 (3) 25 8

Ultra SCSI (2) 20 8 3 - - 4

Wide Ultra SCSI 40 16 - (3) 25 16

Wide Ultra SCSI 40 16 1.5 - - 8

Wide Ultra SCSI 40 16 3 - - 4

Ultra2 SCSI (2,4) 40 8 (4) 12 25 8

Wide Ultra2 SCSI
(4)

80 16 (4) 12 25 16

Ultra3 SCSI or Ultra
160 (6)

160 16 (4) (5) 12 16

Ultra320 320 16 (4) (5) 12 16
41
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Notes:

1. The listed maximum bus lengths may be exceeded in Point-to-Point and engi-
neered applications.

2. Use of the word "Narrow", preceding SCSI, Ultra SCSI, or Ultra2 SCSI is
optional.

3. Low Voltage Differential (LVD) was not defined in the original SCSI standards
for this speed. If all devices on the bus support LVD, then 12-meters operation
is possible at this speed. However, if any device on the bus is singled-ended
only, then the entire bus switches to single-ended mode and the distances in
the single-ended column apply.

4. Single-ended is not defined for speeds beyond Ultra.

5. HVD (High Voltage Differential) is not defined for speeds beyond Ultra2.

6. After Ultra2 all new speeds are wide only.

SCSI Bus Termination

Each end of a SCSI bus must be terminated correctly. The ADIC Gateway
provides termination on each of its buses. The terminators can be disabled using
a jumper on the ADIC Gateway motherboard. They can also be enabled or
disabled from the ADIC Management Console. Each interface has a separate
control for the terminators.

Attention: Improper SCSI bus termination may result in excessive errors on the
SCSI bus, and may lead to data corruption or the inability to communicate with
target devices.

The ADIC Gateway provides termination power on all SCSI buses for external
terminators.

Many SCSI target devices have internal terminators. It is imperative that the
terminators be disabled for all devices EXCEPT those at the physical ends of the
SCSI bus.

Problems on the SCSI Bus

When A SCSI bus fails to operate correctly, it is most often caused by incorrect
connections to the SCSI bus. Common problems include:

• Missing terminator at the end of a SCSI bus: Check that an
external terminator is attached or that the end device has termi-
nation enabled.

• Excessive termination: Check that all devices other than the end
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devices have termination disabled.
• Multiple devices at the same ID: If two or more devices are

configured at the same SCSI ID, only one of those devices will
be seen by the ADIC Gateway, and data transfers to that device
will be unreliable. Check that only one device is set to each ID.

• Target device set to initiator’s ID: If a target device is set to the
same ID as the ADIC Gateway (ID 7), the bus will be unstable
and targets will not be identified. Check that no target devices
are set to ID 7, or if one must be set to 7, change the ADIC Gate-
way Initiator ID.

• Bent pins in a SCSI connector: The pins in the SCSI connectors
are somewhat fragile. Inspect each connector to find pins that
were bent when the connector was attached. Replace any cables
with bent pins.

• Improper device type: A DE device on an SE bus or an SE
device on a DE bus will cause the bus to be unusable.

• Improper terminator type: A DE terminator on an SE bus or an
SE terminator on a DE bus will cause the bus to be unusable.

• Inadequate cables: Older cables may not be suitable for running
at Ultra speeds. Be sure all cables are rated for Ultra.

• Mixed cable types: If a SCSI bus has both round cables and flat
ribbon cables, it may suffer problems when running at Ultra
speeds. Use the same cable type consistently for all segments of
the SCSI bus.

• Unshielded cables: An unshielded SCSI cable used external to a
cabinet may cause reliability problems, due to interference from
other electrical devices. Use only shielded cables.

Connecting Power

The ADIC Gateway must be connected to AC Power with a voltage of 100 to 127
or 200 to 240 volts, at a frequency of 50 to 60 Hz. A power switch is located next
to the power connector on the rear panel of the ADIC Gateway.

The ADIC Gateway uses two 250 V, 4 amp Time Lag fuses. They are located in
the fuse holder next to the power switch on the rear panel. If the ADIC Gateway
Main Power LED does not light when the ADIC Gateway power cord is connected
to the power source and is turned on, then check these fuses. Replace only with
F4AL-type fuses.

Note: A proper power cable is provided with each ADIC Gateway.
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Other Installation Issues

Host Adapter Setup

Hosts are connected to the ADIC Gateway through specific Host Bus Adapters
(HBAs). The installation procedure varies slightly, depending on which adapter
you will be using. The procedure involves these steps:

1. Install the adapter in the host system, following the manufacturer’s
recommendations.

2. Power on the host system and update the adapter firmware, if necessary.

3. Boot the operating system and install the device driver for the HBA.

4. Reboot and verify that the device driver has started and that expected target
devices are seen by the operating system.

5. Install optional utility software, if desired.

Perform steps 4 and 5 after the ADIC Gateway is installed and connected to the
host system.

Installing the SAN Explorer and Host Registration Ser-
vice

The SAN Explorer software allows viewing all connected Fibre Channel, SSA and
SCSI devices. In addition, you can update the code on all devices and view the
LUN mapping through switches to which your ADIC Gateway may be attached.
The software also has an option that lets you choose to install the Host
Registration Service.

See the readme file in the [host type]/HOSTSW folder on the CD-ROM for
installation instructions. For software updates, visit “Service and Support” at
www.adic.com, or call the ADIC Technical Assistance Center at 1-800-827-3822.

INSTALLING THE HOST REGISTRATION SERVICE

The Host Registration Service for Virtual Private SAN provides the ADIC Gateway
with periodic host status information including the host name, host type and HBA.
Host information is sent over the host connection to the ADIC Gateway. Once
installed, the service runs automatically and does not require further system
administrator interaction. From the ADIC Management Console, you can see the
Fibre Channel or SCSI port that the host is connected to and you can tell whether
the host is on or offline.
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The default period is set to send host status every 15 minutes. If you want, you
can change the period to any value between 1 and 255 minutes. See the readme
file on the CD-ROM in the HOSTSW folder for the specific host platform you are
using. The readme file contains the installation procedure and information about
changing how often host status information is sent.

For Windows NT and Windows 2000: See the readme file in the NT/HOSTSW
folder on the CD-ROM. The Host Registration Service installs as part of the SAN
Explorer executable. For software updates, visit “Service and Support” at
www.adic.com, or call the ADIC Technical Assistance Center at 1-800-827-3822.

For Solaris: A single program is provided for Solaris 2.6 that runs from the
command line or by inclusion in a startup script. Installation is through a Solaris
"package". See the readme file in the SOLARIS/HOSTSW folder on the CD-ROM.
For software updates, visit “Service and Support” at www.adic.com, or call the
ADIC Technical Assistance Center at 1-800-827-3822.

For AIX: See the readme file in the AIX/HOSTSW folder on the CD-ROM. For
availability and information regarding software updates, visit “Service and
Support” at www.adic.com, or call the ADIC Technical Assistance Center at 1-800-
827-3822.

For other platforms, such as HP-UX: See the appropriate readme file on the
CD-ROM. For availability and information regarding software updates, visit
“Service and Support” at www.adic.com, or call the ADIC Technical Assistance
Center at 1-800-827-3822.

Power-Up and Boot Sequence Guidelines

Before you reboot the ADIC Gateway, you must stop all I/O between the host and
SCSI devices.

The ADIC Gateway scans the SCSI buses when it boots. If you add or remove
SCSI devices after the ADIC Gateway has booted, it will not detect the changes.
You can invoke a SCSI rescan or reboot from the ADIC Management Console
client or from the service terminal.

Before you turn on or restart the hosts that are connected to the ADIC Gateway,
you must wait until it has finished booting. You will know that the ADIC Gateway
has finished booting when the RDY light on the user panel blinks at intervals of
one second.

Some operating systems provide you with software methods that allow you to add
or remove SCSI devices dynamically after the host has booted. To ensure reliable
operation, reboot the host.
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If you update ADIC Gateway firmware you must reboot in order to use the new
firmware. To ensure compatibility between the firmware features or functions and
the host, reboot the host.

If you update SCSI device firmware, the SAN Explorer application does not
display the new firmware version until the ADIC Gateway has issued a SCSI
Inquiry. The SCSI Inquiry occurs when it rescans the SCSI buses. The same is
true for the ADIC Management Console client application and the service
terminal.

Install the ADIC Management Console Software

The ADIC Management Console allows you to manage multiple ADIC Gateways
from any location on your network. The system consists of two Java applications.
You should install the Server on just a single system on your network to manage
multiple ADIC Gateways from multiple ADIC Management Console Clients.

This section describes the installation and initial configuration of the Server and
Client components. The installation for the ADIC Management Console consists
of three components, as described in “Client/Server Model” on page 23. The
agent component is provided as part of the operating software already installed on
the ADIC Gateway hardware.

The installation program installs the appropriate software components on your
Server and Client system. It also installs the required Java Runtime Environment.

SERVER

The system used for the Server does not need to be used as a Client and can be
placed in a locked closet. It does need network access to the ADIC Gateways it
will be managing, so appropriate routes will have to be set on that system and on
the ADIC Gateways.

CLIENT

The Client system can be located anywhere, as long as it can connect to the
Server system using TCP/IP.

Installation Requirements

Minimum configuration guidelines are presented for each system platform in the
readme file located in the SANMGMT folder on the CD-ROM. For an updated list
of supported platforms and installation instructions, visit “Service and Support” at
www.adic.com, or call the ADIC Technical Assistance Center at 1-800-827-3822.

An example of the installation requirements for Windows NT/Windows 2000 is
listed below.
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Installing the Software on Windows NT/Windows 2000

Server System Requirements

• Windows NT 4.0 Server or Workstation, Service Pack 6a or Win-
dows 2000

• Minimum memory: 64MB
• Free hard disk space: 40MB
• Ethernet with TCP/IP protocol installed

Client System Requirements

• Windows NT 4.0 Server or Workstation, Service Pack 6a or Win-
dows 2000

• Minimum memory: 96MB
• Free hard disk space: 30MB
• Ethernet with TCP/IP protocol installed

1. Log on to the target machine with administrator privileges.

2. Insert the CD and execute the ADIC_SD_ executable from the x:\NT\SAN-
MGMT directory, where x is the letter of your CD-ROM drive.

3. The default install option is set to install both the Management Console Server
and Management Console Client. Choose to install both the Server and the
Client on at least one system. When you install the ADIC Management
Console on any other attached system, you can opt to install the Client only.

Startup and Configuration

The first time you install the server component, there is one pre-defined user
account, which has administrator privileges. That account is called Admin and the
password is password.

Note: User names and passwords are case sensitive.

FOR SECURITY:

1. Start the Server application

a.Click on the Windows NT/Windows 2000 Start button

b.Select Programs > ADIC > Server

2. Start the Client application

a.Click the Windows NT/Windows 2000 Start button

b.Select Programs > ADIC > Client
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3. Connect to the Server (automatic if Server and Client are running on same
system)

4. Log on to the Server. See Figure 3-3.

Figure 3-3: Logon to Server

5. Add a new user account with administrator privileges. See Figure 3-4.

Figure 3-4: Add An Administrative User Account

To log on, use the pre-defined Admin account, see “Startup and Configuration” on
page 47.
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To add a new administrator account (pull down the Admin menu and click on Add
User). See Figure 3-5.

Figure 3-5: Adding A User Account

Remember that user names and passwords are case sensitive. After you add a
new administrator account, the pre-defined Admin account is deactivated.

Attention: Save your administrator account information in a secure location. If
you lose this information and do not have another administrator account available,
you must contact your service representative.

Use this new administrator account to set up other user accounts (with
or without Administrator privileges) that you might need.

ADIC Gateway Network Setup

The ADIC Gateway must be connected to a 10-base-T Ethernet network for use
with the ADIC Management Console software. An RJ-45 connector is located on
the rear panel of the ADIC Gateway for connection to the Ethernet. You will need
to first configure the IP address by connecting a terminal or terminal emulator to
the Service Port of the ADIC Gateway.

To configure the network, connect to the ADIC Gateway Service Port. See
“Connecting to the Service Port” on page 217.

For all of the following examples, substitute the values you determined in Step 8 of
Table 3-1: “Pre-Installation Steps” .
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Set the host name:

The host name is set using the hostNameSet command. In the example shown,
the host name of the ADIC Gateway was “Gateway” and is now being set to
“foster.” The shell prompt will change to reflect the new name.

Gateway> hostNameSet "foster"
Target hostname set to foster
value = 0 = 0x0
foster >

Set the host network address:

The network address is set using the ethAddrSet command. The IP address is
specified as four decimal numbers, separated by periods.

foster > ethAddrSet "192.168.1.54"
Host Address set to 192.168.1.54 for Ethernet interface
value = 0 = 0x0

If you need to set a netmask, specify it after the network address:

foster > ethAddrSet “10.0.0.2”, “255.0.0.0”

Set the network routes and/or default gateway:

If a network gateway is needed for the ADIC Gateway to communicate with other
systems, you must specify one.

foster > gateAddrSet "192.168.1.1"
value = 0 = 0x0

When more complicated routing is required to reach the ADIC Management
Console server, use the route command to specify the destination address, as a
full address (single host) or as an abbreviated subnet address, and specify the
address of the gateway that is reachable on the local subnet.

foster > route "add", "206.0.0", "192.168.1.1"
value = 0 = 0x0
foster >

Add User Account for Telnet (optional):

If you want to access the ADIC Gateway’s command line interface through its
Ethernet port using a Telnet session, you need to add a user account. In the
example below, specify the desired user name and user password. The user that
you specify must be 3 or more characters and the password you specify must be
ADIC Gateway Network Setup
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8 or more characters. For further information, see the user commands in “Service
Port Command Reference” on page 223.

foster > userAdd “username”,”password”
value = 0 = 0x0
foster >

Reboot the ADIC Gateway:

The ADIC Gateway must be rebooted to activate the Ethernet port, using the
reboot command.

foster > reboot
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Chapter 4: Understanding SAN
Configurations
One of the functions of the ADIC Gateway is to connect hosts with one kind of
interface, either as Fibre Channel or SCSl, to devices with different interfaces,
either Fibre Channel or SCSI. In a typical configuration, each ADIC Gateway
Storage Area Network interface is connected to either a single host or multiple
hosts using Fibre Channel hubs or switches.

It is important to understand how devices attached to the ADIC Gateway as
targets appear to the host systems. It is different than the way that targets attach
directly to a host system without any intervening ADIC Gateways, or bridges. See
also “Device Mapping” on page 110.

Device Configuration and Mapping

In SCSI terminology, a tape drive or a disk drive is attached to a “bus” and has a
unique address on that bus. There are three parts of the address in a conventional
parallel SCSI:

• Bus
• Target ID
• LUN

A simple case of several disk drives connected to the same bus is shown below.

Figure 4-1: Basic SCSI Connection to System
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This configuration has a device map (from the device point of view) that looks like
this:

If a product such as an ADIC Gateway or a RAID controller is placed between the
system and the target devices, the addressing will have another layer. This is
because the targets (disk drives) are not directly attached to the host. Instead, the
targets are connected to a SCSI bus that is part of the RAID controller or ADIC
Gateway, and they are not directly attached to the system. See Figure 4-2.

Figure 4-2: System With ADIC Gateway Attached Through Fibre Channel

This analysis would also be true even if the host interface and the device
channels are the same type, for example, Fibre Channel host to Fibre Channel
disk drives, when an ADIC Gateway or RAID controller is used, or SCSI host to
SCSI tape drives. For more information on attaching SCSI hosts, see “Installing
and Using Virtual Private Map” on page 147.

With the introduction of an ADIC Gateway, a level of indirection has been added
and the system now has only a single target ID directly attached to it (the ADIC
Gateway). The ADIC Gateway forwards commands to and from its targets (the
disk drives). However, there is a need to map the devices (disks) so the host
system can use them. This level of indirection is handled through another layer of

Table 4-1: Target Device Map

Target ID Device

0 Disk (Target 0)

1 Disk (Target 1)

7 Host System
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mapping, or LUNs. The device map might now look like this from the host point of
view:

For simplification, hard IDs were chosen for the Fibre Channel devices in the
mapping scheme. A hard ID is a number from 0 to 125 used in place of the World
Wide Name assigned to each Fibre Channel device. A soft ID is an ID assigned by
the ADIC Gateway during device discovery. Although a soft ID should never
change, when Fibre Channel devices are added or removed from a loop, the Fibre
Channel host may scramble their device IDs. When using Fibre Channel hubs or
switches, hard IDs are preferred because the host won’t lose track of the devices.
In the mapping scheme LUN 0 points to the ADIC Gateway. This allows you to
send commands to control the ADIC Gateway and is referred to as the Command
and Control LUN.

Host System Considerations

The host operating system imposes limitation on the number of LUNs and target
IDs. It requires SCSI devices to be mapped exactly the same way every time the
host is booted. The ADIC Gateway has the ability to deal with these issues.

Mapping Devices to Targets and LUNs

The most common SCSI implementation in use (SCSI-2) allows eight LUNs per
target ID, so if you want to connect more than seven devices (remember, LUN 0 is
reserved for the ADIC Gateway), this address limitation needs to be circumvented.
Fibre Channel and other serial interfaces implement a newer SCSI specification
(SCSI-3), which allows for many more LUNs per target.

The number of LUNs is still limited by the host operating system. In that case,
another abstraction is required from the host adapter (either in firmware on the
adapter or from the device driver on the host system). This varies with the
implementation, but a common method is to create additional “pseudo” target IDs
when you use up the eight-LUN allotment. In the previous example (adding more
drives), the host system “sees” that target 0 has LUNs 0 through 7, then target 1,
LUNs 0 through 7 for the next eight devices, continuing until all devices are

Table 4-2: Host Device Map

Target ID LUN Device

0 0 ADIC Gateway

0 1 Disk 0

0 2 Disk 1

125 Host System
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accounted for. With a SCSI-type mapping, there are 16 target IDs available per
bus, but one must be reserved for the host adapter. This allows for 15 targets with
8 LUNs each, or 120 total devices.

Different operating systems have different limits on the number of LUNs
supported. For example, Windows NT 4.0 had an eight-LUN limit until the release
of Service Pack 4. The limit is now 255 LUNs per target ID. The increase implies
that you need not use “pseudo” targets. When operating system vendors
implement the new SCSI-3 specifications in their software, it will be possible to
exceed the SCSI-2 device addressing limits.

Persistent Device Maps

Some operating systems (e.g., Windows NT) may not care about the SCSI
address of a device when the system has booted.

Note: An exception might exist for devices, such as media changers that are not
handled by operating system device drivers. Instead, they are directly controlled
by an application, such as a backup program.

Users access the devices only by logical drive letters or network names. If no
devices are added or removed while the system is running, there is no problem if
a device changes addresses when a system is rebooted again. Other operating
systems (e.g., UNIX) do care about the SCSI addresses and require constant
device addresses when mounting the file systems.

Newer serial technologies present problems for either case because they allow for
the dynamic addition and removal of devices. In the case of an interface that must
map a unique (but not changeable by switches) ID to a SCSI-like Target and LUN,
it is important that existing devices do not “move” around if new devices are
added. In this latter case, each device must have a constant address when the
system is rebooted. Within the ADIC Gateway, tables are maintained to ensure
“device persistence.” As new devices are added, each one is assigned a unique
LUN. If you remove a device, its LUN is reserved because there is the possibility
that the device was removed for maintenance purposes, or is temporarily
powered off. This address map can contain up to 255 entries and is stored in non-
volatile memory within the ADIC Gateway. Commands are provided to help you
maintain the device map. ADIC Management Console’s Controls > Device Map
allows management of this persistent device map. You may also manage the
device map via the Service Port. See “Appendix A: Connecting to the Service
Port.”

Alternate SCSI IDs

A host sends Inquiry or Test Unit Ready commands to a tape drive or changer
device during system startup when it scans the SCSI buses. If another host is
Host System Considerations



Adding and R
sharing the device and the device is busy doing I/O, it could take several minutes
for the device to respond.

In a standard queuing model, the command sent by the second host starting-up
would be blocked behind the I/O command and could timeout, preventing the host
from finding the device. The ADIC Gateway can issue a command to the drive,
while another command is already in process by issuing the command from a
second or Alternate ID on the SCSI Channel. This technique allows the Inquiry or
Test Unit Ready to be processed immediately.

When a reservation is held for a device by an Initiator and the ADIC Gateway
receives a command from another Initiator for the same device, the ADIC
Gateway issues the command to the device by sending it from the Alternate ID.
The majority of the commands received by the ADIC Gateway will be returned to
the Initiator with RESERVATION CONFLICT status. The ADIC Gateway uses the
Alternate ID to issue the following commands to the target device.

INQUIRY,
TEST UNIT READY,
PREVENT/ALLOW MEDIUM REMOVAL,
RELEASE,
REQUEST SENSE

DEFAULT ALTERNATE SCSI ID

When the ADIC Gateway scans a SCSI Channel, it determines which IDs are
currently being used by target devices and sets the Alternate ID to the highest ID
not in use. The default Primary SCSI ID is 7. If no target is present at ID 6, the
ADIC Gateway chooses ID 6 for the Alternate ID. Both the Primary ID and
Alternate ID may be explicitly set if necessary.

CHANGING THE ALTERNATE SCSI ID

The Alternate ID can be set to any SCSI ID between 0 and 15. A system
administrator could choose to explicitly set the ID to prevent the ADIC Gateway
from selecting a particular ID not currently in use. This allows a device with a
particular ID to be added in the future. Performance criteria based on SCSI Bus
Priority may also be a good reason for explicitly setting both the Primary and
Alternate SCSI IDs rather than accepting the defaults. See “SCSI Channel” on
page 105.

Adding and Replacing SCSI Target Devices

If new SCSI devices are added to the ADIC Gateway, the SCSI buses must be re-
scanned for the ADIC Gateway to detect them. You can use the scsiRescan
57
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command from the terminal or system connected to the service port or the ADIC
Management Console to request a SCSI rescan.

Attention: Do not attach more than 255 LUNs to the ADIC Gateway. Exceeding
the 255 LUN limit will result in unreliable behavior.

Replacing an Existing SCSI Device

If you have to replace a SCSI target device, remove the old device, set the new
device to the same SCSI ID as the old device and attach it to the same SCSI
channel on the ADIC Gateway. Perform a SCSI rescan to update the configuration
data. The new device will be available to host systems with the same LUN as the
old device.

Setting up Access Control

The ADIC Gateway allows you to connect more than one host to it. In its default
configuration, all hosts can access all target devices. Host operating systems do
not always handle multiple systems using the same target devices
simultaneously. When more than one host tries to use the same disk drives or
LUN, the file systems on those devices become corrupted. Or, if multiple hosts
access the same tape device, backup and restore operations might be
interrupted.

You can choose from three Access Control options that can be enabled in the
ADIC Management Console application.

If you choose Channel Zoning, you can set the desired access between Fibre
Channel connections in initiator mode and any port in target mode.

If you choose Virtual Private SAN, you can set the desired access permissions
between individual hosts and individual LUNs.

If you choose Virtual Private Map, you can set the desired access permissions
between SCSI hosts and individual LUNs.

For further information about Channel Zoning, Virtual Private SAN, and Virtual
Private Map, see “Access Options” on page 97.

Note: Cluster configurations and some newer backup programs do manage
concurrent access to devices.

Attention: If Access Control is not utilized for tape devices, the tape application
must support RESERVE/RELEASE or provide some method (via hardware,
software or manually) to control access to data on tape.
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Fibre Channel Port Modes and Connection
Options

The Fibre Channel ports support Private and Public Fibre Channel Fabric Loop
attachments. Both Loop and Point-to-Point connection options are available. The
default Port Mode setting is Public Target and the default connection setting is
Loop. From the ADIC Management Console, you can view the settings and
change port parameters.

Port Mode Options

TARGET

In this mode, the port operates as a Target allowing a Fibre Channel Initiator (Host
or FC switch) to attach to it.

INITIATOR

In this mode, the port operates as an Initiator allowing Fibre Channel Targets
(disks, tape devices, or FC switch) to attach to it.

TARGET AND INITIATOR

In this mode, the ADIC Gateway has access to target devices on the Fibre
Channel, and Initiators on the Fibre Channel have access to Targets attached to
the ADIC Gateway. The port operates simultaneously as a Target and Initiator.

PRIVATE

With this option, the ADIC Gateway scans the local loop for devices but does not
check for Fabric devices. You can select this option if you are connecting target
devices directly to the port.

PUBLIC

With this option, the ADIC Gateway scans the loop for Fabric devices. If it finds a
Fabric device, it logs-in and queries the Name Server for target devices that are
available on the Fabric. If it finds Targets attached to the Fabric, it adds all of them
to the device map. You can select this option if you are connecting a Fibre
Channel switch to the port and you want the ADIC Gateway to have access to all
of the available target devices attached to the switch. Otherwise, if target devices
are connected directly to the port, it automatically switches to Private mode.
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Connection Type Options

LOOP

With this connection option, the port operates with attached loop-capable devices.
If a point-to-point device is attached, the ADIC Gateway will not be able to
communicate with it.

POINT-TO-POINT

With this connection option, the port supports point-to-point fabric connection
(F_Port Login). It also operates in “old port mode” for compatibility with N_Port
devices that do not support Loop. If loop-capable devices are attached, the ADIC
Gateway will not be able to communicate with them.

LOOP PREFERRED

With this connection option, the port operates in Loop mode unless it detects a
connection to an N_Port device in which case it automatically switches to Point-
to-Point.

POINT-TO-POINT PREFERRED

With this connection option, the port operates in Point-to-Point mode unless it
detects a connection to a loop device in which case it automatically switches to
Loop.

Preserving the ADIC Gateway
Configurations

It is important to preserve the mapping of device addresses. The ADIC Gateway
automatically saves the device map in non-volatile memory to ensure the
persistence between boots and power cycles. For information on device maps,
see “Persistent Device Maps” on page 56. Note that the Ethernet addresses and
names are not included in the “saved” configuration file.

To provide a backup of the device maps and other configured parameters, you
must use the ADIC Management Console to save each ADIC Gateway’s
configuration when you:

• Install the ADIC Gateway
• Add new devices
• Remove devices permanently
• Change Target IDs or LUNs
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Use the ADIC Management Console to save or load the configuration. See “Save
SAN Gateway Configuration” on page 90. You must save the configuration so that
it can be reloaded in case you or the service representative must replace the
ADIC Gateway base.

Note: Save a backup copy of your ADIC Gateway configurations frequently.

Updating the ADIC Gateway Software

The ADIC Gateway is a programmable device and contains an operating system
and operational firmware. If you are instructed to update your firmware, see
“Update Firmware” on page 117.
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Chapter 5: Using the ADIC
Management Console
Menus allow you to select views of one or more ADIC Gateways and the devices
connected to them, and to perform various actions. From the main screen, six
major menu groups are available:

• File
• View
• Admin
• Tools
• Controls
• Help

Some menu options will appear grayed, signifying they are currently disabled.
Options can be disabled for one of two reasons:

• Insufficient user privileges or
• The option does not apply to the currently selected item.

There are two privilege modes:

• User
User privilege allows you to view data, but does not allow you to make

changes to ADIC Gateway settings, configurations, or user accounts.

• Administrator
Administrator privilege allows you to have full access to all options.

Unless otherwise noted below, administrator privilege is required to modify any
parameter.

See “Startup and Configuration” on page 47 for information on starting the Server
and Client components.
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Starting the ADIC Management Console

Before a Client can manage any ADIC Gateways ("Agents"), it must establish a
connection to the Server. If the Server and Client are running on the same
system, a connection is automatically made when the Client starts. If the Server is
on a different system the dialog in Figure 5-1 is displayed.

Figure 5-1: Connect to Server

You can enter an IP address or a name if it can be resolved by the Client system.
After you connect to the Server, log on. See Figure 5-2.

Figure 5-2: Logon to Server

Unless you have already added your own Administrator level account via the
service port, use the default account specified on page 47. At this point, you can:

• Retrieve a saved view. See “File Menu Group” on page 66.
• Perform a “Discovery” of all ADIC Gateways on a subnet. See

“Tools Menu Group” on page 79”.
• Connect to a specific ADIC Gateway. See “Tools Menu Group” on

page 79.
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Figure 5-3: Initial Tree View

The ADIC Management Console's main screen is made up of two panels, the Tree
View panel on the left and the Data panel on the right. The Tree View in Figure 5-
3 is an unexpanded Tree View for a single ADIC Gateway. For an expanded view,
see Figure 5-9. Because the ADIC Gateway with IP address 192.168.30.10 is
selected, it is shown in Tree View with blue highlighting. Its Name is
"Gateway3010" and its Genre is "SANGateway."

On the right hand side of the screen, at the top of the Data panel, is a
representation of the ADIC Gateway's Channel configuration as it appears on the
back of the ADIC Gateway

Product data for the selected ADIC Gateway is displayed textually below the
Channel configuration graphic.

Near the bottom of the screen, the Up Time for the selected ADIC Gateway is
displayed. Up Time indicates how many hours, minutes and seconds have
elapsed since the ADIC Gateway was last booted.

The area at the very bottom of the screen is used to display status messages. See
“View Menu Group” on page 68 for further information.
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File Menu Group

The “File Menu Group” offers commands for loading, manipulating, and saving
view files. See Figure 5-4.

Figure 5-4: File Menu

A view file is a list of ADIC Gateways viewed at any one given time. Each user can
save preferred views on the server. Loading a previous view automatically
connects the user to one or more ADIC Gateways in a single step rather than
specifying connections to them individually. Because they are stored on the
server, the same views are available to the user from any client.

You can have many views. At the beginning of a session, you can choose to load
a view from the Open a Previous View menu, which displays all the views that you
saved previously (for your logon account only) so that you can recall an earlier
viewing environment.

Save Current View

The current collection being viewed defines the view. For this option to be
available (not grayed-out), the current view name must be known either from a
previous loading or a Save Current View as operation. For example, if you initially
load a view that includes the ADIC Gateways that are being used to store data for
Marketing, Hardware, and Web Service, and then during the course of the session
decide to disconnect from the ADIC Gateway handling Hardware's storage,
performing a Save Current View only saves a view of the ADIC Gateways handling
storage connections for Marketing and Web Service. The original view is
overwritten by the new view. If you did not perform a Save Current View, the original
view of the three ADIC Gateways managing Marketing, Hardware, and Web
Service storage is still valid for the next time that view is loaded.

Save Current View as

The Save Current View As option saves the currently viewed collection of ADIC
Gateways on the server. You are prompted to enter a name or short phrase so
you can choose to reload the same view in the future. See Figure 5-5.
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Figure 5-5: Save Current View As

Open a Previous View

Figure 5-6 is an example list of views previously saved by a user. From this list
you can select a view by clicking on the name, and then selecting an action
option.

If you press the Load button, you are returned to the main screen and in a few
seconds the ADIC Management Console establishes connections to all of the
ADIC Gateways in the view and then displays them on the screen.

If you press the Delete button, the selected view is removed from the list. You can
delete as many views as you want.

If you press the Close button, the window closes and you are returned to the main
screen.

Figure 5-6: Saved Views
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Exit

Figure 5-7: Exit

Exit stops the ADIC Management Console Client application and closes its
window. See Figure 5-7.

Attention: If you exit without selecting a save option after making changes to a
view, the changes you made are lost.

View Menu Group

The “View Menu Group” offers two display options. You can view an entire
collection of ADIC Gateways in a hierarchical tree, or you can view the front panel
of a single ADIC Gateway. Tree View is the default view and is selected when the
SAN Gateway Front Panel option is unchecked. See Figure 5-8. In Tree View, you
see icons representing one or more ADIC Gateways in a hierarchical tree
structure.

Figure 5-8: View Menu

When you click the node symbol at the left of the ADIC Gateway icon, the tree
expands to show connected elements represented by other icons. The ADIC
Gateway node expands to show channels, and channels expand to show
attached devices. In Tree View, when you click the node symbol of an expanded
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element, its tree collapses. Figure 5-9 shows the Tree View of an ADIC Gateway
with two tree elements expanded

Figure 5-9: Expanded Tree View
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The icons used in the Tree View carry specific meaning, both in their design and
in their color. See See Figure 5-10.

Figure 5-10: Icons for Channel Modes and Channel Types

In Figure 5-9, Fibre Channels 2, 4, and 5 are blue, SCSI Channels 1-4 and Ultra2
SCSI Channels 3 and 6 are green, and Fibre Channel 1 is purple. Blue indicates
that the channel is in Target mode. Target is the default mode for Fibre Channels.
When channels are set to Target, you are able to see attached hosts, and switches
like the Brocade switch, which broadcasts a World Wide Name.

Green indicates that the channel is in Initiator mode. Initiator is the default mode
for SCSI Channels. When channels are set to Initiator you will be able to see
attached devices, and ADIC Gateways.

In addition to Target mode and Initiator mode, Fibre Channels can function in Target
and Initiator mode. When that is the case, the Fibre Channel icon is purple. Fibre
Channel 1 in Figure 5-9 is set to Target and Initiator mode. You will be able to see
hosts and devices, as well as cascaded ADIC Gateways when a channel is set to
Target and Initiator. If there is no node symbol preceding a Channel, as for example
Fibre Channels 4 and 5 or the Ultra2 SCSI Channel 6 in Figure 5-9Figure 5-9,
there are no attached elements to display. If there is no node symbol preceding a
SCSI Channel set to Target mode, a SCSI host could still be attached. The ADIC
Management Console does not display SCSI hosts unless VPSReg is running on
the host. Nor will it display an icon for a switch that does not broadcast a WWN.

In Figure 5-9, the ADIC Gateway is selected. Product information about the ADIC
Gateway appears in the Data panel, which is in the lower right half of the ADIC
Management Console main screen. The information in the Data panel presents a
View Menu Group



View Menu G
variety of information, including the unit's WWN, IP Address, Firmware Revision,
Serial Number, and Ethernet Speed.

Figure 5-11: Information About a Channel

When a Channel is selected, the lower part of the Data panel display includes the
WWN, port mode, connection type, and maximum speed. See Figure 5-11.The
firmware revision level of the HBA attached to the selected Channel is presented
as distinct from the firmware revision level of the ADIC Gateway.
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Information About a Selected Channel

When a device is selected, information about its capacity, status, width, and speed
is all included in the lower portion of the Data panel. See Figure 5-13. For a list of
the different icons used in Tree View, see Figure 5-12.

Figure 5-12: Icons used in Tree View

Figure 5-13: Information About a Selected Device
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When a host is selected, information about its WWN, Network Name, Operating
System and HBA attachment is all included in the lower portion of the Data panel.

No matter what component in Tree View is selected--host, channel, device, or the
ADIC Gateway itself--the top "paragraph" of the Data panel states the IP address,
Name, WWN, and Firmware revision level of the current ADIC Gateway.

Some information that is presented in the Tree View panel is also presented in the
Data panel. For example, both Tree View and the Data panel display the Channel
Number, Target ID, Device LUN and Assigned LUN of a device. Tree View graphically
specifies the device type. The Data panel displays textual information about the
Vendor ID, Product ID, Serial Number, as well as other information about the size and
capacity of the device. At the top of the Data panel there is a graphic showing the
back of the ADIC Gateway. In Figure 5-13 for example, the slot where the selected
device attaches is shown in green. The slot is connected by a black line to an icon
appropriate to the device being represented. For hosts on a Fibre Channel
connection, the slot is connected by an orange line to an icon representing the
host. See Figure 5-14. Note that when the Channel itself is selected neither the
host nor the device icon appears in the ADIC Gateway front view graphic.

Figure 5-14: Information About a Host
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SAN Gateway Front Panel

Choosing the SAN Gateway Front Panel option shows you a front-panel view of the
selected ADIC Gateway. You can see the status of the lights on the front panel of
the ADIC Gateway. The lights are refreshed automatically, about five times per
second.The ADIC Gateways product data is displayed below the front panel.
Figure 5-15 is an example of the Front Panel View.

Figure 5-15: Front Panel View
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Refresh SAN Gateway

When you select the Refresh SAN Gateway option, the ADIC Management Console
Client requests the Server to contact the selected ADIC Gateway and update all
data. This refreshes the data for the ADIC Gateway and all attached devices. The
Refresh SAN Gateway option can also be accessed by right-clicking on the ADIC
Gateway in the Tree View display. Refresh SAN Gateway is the first of the available
right-click options. See Figure 5-16.

Figure 5-16: Refresh View

Admin Menu Group

The “Administrative Menu Group” is used for connecting to the server, logging on,
and controlling user accounts.

Figure 5-17: Admin Menu
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Connect to Server

To connect to the server, you are prompted to enter the name or IP address of the
ADIC Management Console Server system. See Figure 5-18.

Figure 5-18: Connect To Server

The status/message line at the bottom of the screen shows whether your
connection was successful or unsuccessful. After you have made a successful
connection, you can log on.

Logon

To log on, enter a user name and password. See Figure 5-19. If your logon is
successful, your privilege level is shown on the status/message line at the bottom
of the screen. If your logon is unsuccessful, the reason is shown on the status/
message line.

Figure 5-19: Logon to Server

Change Password

After you log on successfully, you can select the Change Password option. See
Figure 5-20. To change your password, enter the current password, the new
password, and the new password again to confirm it. Press OK and verify whether
the change was accepted by looking on the status/message line to see the status
of your transaction.
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If you do not want to change your password, press Cancel for your old password to
remain unchanged.

Figure 5-20: Change Password

Add New User

You can add a new user if you successfully logged on with administrator
privileges. See Figure 5-21. You must enter a valid administrator name and
password and then enter the new user name and password. If you want to give
the new user administrator privileges, checkmark the New Administrator box.
Press OK to add the new user.

Figure 5-21: Add A User

If you decide not to add a new user, press Cancel to return to the main screen.
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Remove User

You can remove a user if you successfully logged on with administrator privileges.
You must enter a valid administrator name and password and then select the
name of the user you want to remove. See Figure 5-22. Press Remove to remove
the user. You may repeat this process to remove another user. Finally, press OK to
return to the main screen.

Figure 5-22: Remove a User

If you decide not to remove the user, press Cancel to return to the main screen.

If You Lose the Password

If you lose the administrator password and there is no other user account that has
administrator privileges, you must contact your service representative.
Admin Menu Group



Tools Menu G
Tools Menu Group

The Tools Menu Group provides options for finding and connecting to ADIC
Gateways and controlling ADIC Gateway status reports.

Figure 5-23: Tools Menu

Discover Net

With Discover Net, you can discover all ADIC Gateways on the network. When
you select this option, you are prompted to enter the Network Address and the
Network Mask. See Figure 5-24. These parameters tell the ADIC Management
Console which subnet addresses to check.

Figure 5-24: Discover Net

In the Network Address box enter “0” in the place of the subnet you wish to explore,
e.g. the entry “192.168.22.0” searches for IP addresses between “192.168.22.0”
and “192.168.22.255”.

In the Network Mask box enter a subnet mask that matches the class of network
you are searching, e.g. for a Network Address entry of “192.168.30.0” leave the
default entry “255.255.255.0” as the Network Mask. For a Network Address entry of
“192.168.0.0” change the Network Mask to “255.255.0.0”.
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You must enter a Timeout value in milliseconds to limit how long to wait for a
response from each IP address that is checked. You may set the Timeout value
considerably lower than the default (1000 milliseconds) in order to speed
discovery. Before starting the discovery process, you are given an estimate of
how long the discovery will take and you have an opportunity to abort the process
or continue. The default Timeout value is intentionally set to a high number in order
to make certain that all devices on a slow network are discovered.

When the discovery is finished, each ADIC Gateway that was found is displayed
in the tree. The collection displayed defines the current view. If a view was already
loaded, the new ADIC Gateways that were discovered become part of that view
only if you perform a Save Current View. To create a new view with a different
name, perform a Save Current View as. See Figure 5-5 on page 67.

Connect SAN Gateway

If you want to connect to a specific ADIC Gateway you are prompted to enter the
name or IP address of the ADIC Gateway. See Figure 5-25. To use a name, the
name must be resolvable to an IP address by the server system. Contact your
network administrator for assistance. If found, the ADIC Gateway is added to the
tree display. If a view was already loaded, the new ADIC Gateway becomes part
of that view only if you perform a Save Current View. To create a new view with a
different name, perform a Save Current View as. See Figure 5-5 on page 67.

Figure 5-25: Connect to Server

The Connect SAN Gateway option of the Tools menu is not the only way to connect
to a particular ADIC Gateway. You can also bring up the Connect dialog box by
right-clicking the ADIC Gateway in the Tree View display. Scroll down to the
Connect SAN Gateway option, which is the second choice in the right-click menu:
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Figure 5-26: Right Click Menu for Connecting To Gateway

Disconnect SAN Gateway

The Disconnect SAN Gateway menu choice ends your connection to the selected
ADIC Gateway and removes it from the display. ADIC Management Console asks
you to confirm that you want to break the connection. See Figure 5-27. If you have
changed your mind, press No. Otherwise, click on Yes. If you perform a Save
Current View, after answering Yes, the ADIC Gateway you disconnected from is
removed from the view you are saving.

Figure 5-27: Disconnect Dialog Box

The Disconnect SAN Gateway option of the “Tools” menu is not the only way to
disconnect from a particular ADIC Gateway. You can also bring up the Disconnect
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dialog box by right-clicking the ADIC Gateway in the Tree View display. The
Disconnect SAN Gateway option is the third choice in the right-click menu.

Figure 5-28: Disconnect Via Right-Click

Health Check

The Health submenus allow you to determine the status of the selected ADIC
Gateway. You can also check target devices and controllers. Perform Health Check
requests an immediate health check at the current level specified.

Figure 5-29: Health Check Submenu
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Perform Health Check can also be selected from the right-click menu. In Tree View,
select the ADIC Gateway, and then scroll down to the fourth option, Perform Health
Check.

Figure 5-30: Perform Health Check Via Right-Click

This check is performed regardless of the Health Check Interval setting. Setting
Health Check displays the control panel shown in Figure 5-31.

Figure 5-31: Health Check Settings
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Level allows you to choose how thorough the health check will be when it is
performed. Each level is defined as follows:

Interval allows you to enter, in minutes, the amount of time that elapses between
automatic health checks on the selected ADIC Gateway. The interval can range
from 0 to 65,535 minutes. The default interval is 60 minutes.

Check SAN Gateway Heartbeat performs a simple communication check on the
selected ADIC Gateway. A message is displayed on the status line indicating
whether or not a response was received from the ADIC Gateway. Heartbeat
checks are performed automatically at regular intervals.

Table 5-1: Health Check Levels

Level # Level Name Functionality

0 None Health check disabled

1 Basic Function Check power supply and temperature
status

2 Interface Test Everything from level 1, plus check all
interfaces

3 Device Test Everything from level 2, plus perform
device Inquiry on each target device

4 Device Ready Everything from level 3, plus perform Test
Unit Ready on each target device (non-
removable media only)
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Events

Submenus under Events allow you to control the way the event log is displayed
and how traps are generated.

Figure 5-32: Events Submenu

View Event Log displays a list of entries in the event log for the selected ADIC
Gateway. The types of events displayed may be a subset of the events in the log
depending on the Event Viewing level. See Figure 5-33. The types of events in the
event log that match the selected level will be displayed. The most recent events
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are displayed at the top of the list. Selecting Warning will display Warning and
Notice events.

Figure 5-33: Event Viewing Levels

Selecting Information will display Information, Warning and Notice events. Figure 5-
34 contains the contents of a typical Event Log.

Figure 5-34: Typical Event Log

If the log is lengthy, you can navigate through it by using the scroll bar.

Save Event Log allows you to save a copy of the currently displayed entries of the
selected ADIC Gateway event log to a text file. From the browser dialog, you
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enter a name for the file and the location where you want to save it. Figure 5-35
shows the browser dialog.

Figure 5-35: Save Event Log Dialog Box

After saving the log, you have an option that clears the whole Event Log on the
selected ADIC Gateway. See Figure 5-36.

Figure 5-36: Clear Event Log

Set Event Trap Threshold displays the list of the events and their current trap
threshold level settings for the selected ADIC Gateway. The Trap Threshold Level
determines how many times the event can occur before a trap is issued which
sends a message to all users monitoring the ADIC Gateway. If you have
administrator privileges, you can modify a threshold level by selecting an event
(clicking on it), and then pressing the Change button. For the threshold change
dialog, see Figure 5-38 on page 89. You are then prompted to enter a new value
for the Trap Threshold Level. Figure 5-38 shows the Event Trap Threshold
Settings main window.
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Attention: Do not change trap thresholds unless recommended by your service
representative.

Figure 5-37: Set Event Threshold

A threshold level of zero disables traps for that event. A threshold level of one
means that a trap is sent each time the event occurs. Any other value (up to 255)
specifies how many times the event can occur in a ten-minute period; that is, the
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specified number of events must occur within a ten-minute period or no trap will be
issued.

Figure 5-38: Change Event Threshold Dialog Box

Receive Event Traps is the last option on the Events submenu. It controls whether
your ADIC Management Console client receives trap notifications for the ADIC
Gateways you are monitoring in your current view. See Figure 5-32 on page 85.
By default, event traps are enabled (indicated by the check mark). Select this
option to disable receiving traps (the check mark will be removed).

When a trap is received, the symbol is displayed in the status/message area
on the bottom of the main screen. You can look in the Received Event Traps
window to see the trap message. The message identifies the ADIC Gateway by its
IP address. It includes a date and time stamp, an event code and a description of
the event that caused the trap.

Figure 5-39 is an example of the Event Traps window. The Event Traps window is
a separate window that is always present when the ADIC Management Console
application is connected to a server. You can Minimize the window but you cannot
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close it. You can double-click on an event in the window to display more detailed
information.

Figure 5-39: Received Event Trap Window

In Figure 5-39 the Event Trap window contains some typical Health Check events.
You can also see, for example, that the ADIC Gateway at IP address
192.168.30.200 went down (“failed heartbeat occurred”) at 4:46 p.m. on August 2,
200. This ADIC Gateway came back online at 5:15 p.m. on that day (“revived
heartbeat occurred”).

Save SAN Gateway Configuration

Save SAN Gateway Configuration copies the vital configuration information from the
selected ADIC Gateway to a file on the ADIC Management Console server or to a
file and location you specify in the browser dialog.Figure 5-40 shows the pull-
down menu. Figure 5-41 shows the Save SAN Gateway Configuration dialog.

Figure 5-40: Save Gateway Configuration
Tools Menu Group



Tools Menu G
Figure 5-41: Save Configuration Dialog

Enter a Name for the ADIC Gateway configuration you wish to save or select one
from the list of configurations already on the server. You can save the
configuration to a local file (Save Locally) or to a file on the server (Save on Server),
or both. Press Close to dismiss the dialog when you are done.

Attention: It is important that you save the configuration of each ADIC Gateway
initially and any time there is a change in the device address maps. It is a good
idea to save the configuration locally and on the Server to ensure that you have
access to the file.

Load SAN Gateway Configuration

Load SAN Gateway Configuration allows you to restore a saved configuration if you
replaced the ADIC Gateway.

Figure 5-42: Load SAN Gateway Configuration
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Before you choose the file, however, the ADIC Gateway sends you a warning.

Figure 5-43: Warning Before Loading a Configuration

See Figure 5-43. If you decide not to replace the configuration, press No.
Otherwise, press Yes. You have the option to load a configuration from a file that
was saved on the server or one that was saved locally. If you select the Load a
Local File option, the file browser in Figure 5-44 will pop up and allow you to select
the configuration file. If you want to load a configuration file that has been stored
on the server, the file browser in Figure 5-45 appears. Select the file that you wish
to use, and press the Load button.

Figure 5-44: Load a Local File
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Attention: After you load a saved configuration, you must reboot the ADIC
Gateway for the configuration changes to take effect.

Figure 5-45: Load a File From the Server

Attention: If you replace the ADIC Gateway and do not load the saved
configuration, you might not be able to use the storage devices attached to the
ADIC Gateway or data may be lost.
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Controls Menu Group

The Controls Menu Group allows you to control how the selected ADIC Gateway
and attached devices perform. To access a specific channel control, select the
channel in Tree View before pulling down the Controls menu.

Figure 5-46: Controls Menu

Feature Enable

Use this menu if you want to enable the optional, licensed features Virtual Private

SAN (VPS®), Data Mover, or Virtual Private Map (VPM) for the selected ADIC
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Gateway. If these features are already enabled or unavailable they will be grayed
out on the menu.

Figure 5-47: Enabling Optional Features

Feature Enable: Virtual Private SAN

Virtual Private SAN allows you to control access permission between FC hosts
(HBAs) and storage devices (Target LUNs) attached to the ADIC Gateway. If you
need to enable this feature, you must have the License Key that corresponds to
the serial number of your ADIC Gateway.

Attention: When you enable VPS, it takes full control of the SAN connections. By
default, VPS inherits access permissions for hosts that are currently attached and
online. If you add a host to a SAN connection the new host will not have access to
any LUNs until you assign LUNs to it. Please see “Installing and Using Virtual
Private SAN” on page 121 before enabling VPS.
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When you select Controls > Feature Enable > Virtual Private SAN, you are presented
with the dialog box shown in Figure 5-48.

Figure 5-48: Enter License Key to Enable VPS

Note: If this feature is factory enabled, you can activate it by simply entering the
word enable rather than an actual license key.

Feature Enable: Virtual Private Map

Virtual Private Map allows you to control access permissions between SCSI hosts
and storage devices (Target LUNs) attached to the ADIC Gateway. If you need to
enable this feature, you must have the License Key that corresponds to the serial
number of your ADIC Gateway. For more about Virtual Private Map, see
“Installing and Using Virtual Private Map” on page 147.

When you select Controls > Feature Enable > Virtual Private Map, you are presented
with the dialog box shown in Figure 5-49.

Figure 5-49: Feature Enable: Virtual Private Map

Note: If this feature is factory enabled, you can enable and activate it by simply
entering the word enable rather than an actual license key.
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Feature Enable: Data Mover

Data Mover allows you to use Server-Free tape backup applications that support
SNIA Extended SCSI Copy. Enabling this feature allows the ADIC Gateway to
move blocks of data directly between storage devices attached to the ADIC
Gateway.

When you select Controls > Feature Enable > Data Mover, you are presented with the
dialog box shown in Figure 5-50.

Figure 5-50: Feature Enable: Data Mover

Note: If this feature is factory enabled, you can enable and activate it by simply
entering the word enable rather than an actual license key.

Access Options

Use this menu if you want to view or configure Access Control settings for the

selected ADIC Gateway. You can choose Channel Zoning, Virtual Private SAN®, or 
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Virtual Private Map. If a feature has not been enabled it will be grayed out on the
menu. See Figure 5-51.

Figure 5-51: Selecting An Access Control Option

The Access Control option settings are also available from the right-click menu.
See Figures 5-52, 5-54, and 5-56.

In order to prevent more than one host from accessing the same target devices, it
is usually necessary to use some type of Access Control.

Access Options: Channel Zoning

Channel Zoning may be accessed via the Controls > Access Options > Channel
Zoning pop-up menu or by selecting the ADIC Gateway in Tree View and then
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using the right-click menu. It does not need to be Enabled first. Channel Zoning is
the fifth option on the right-click menu. See Figure 5-52.

Figure 5-52: Access Options: Channel Zoning

Channel Zoning allows you to configure zones to restrict access between SAN
connections and SCSI Channels. The default settings allow all SAN connections
to access all SCSI Channels. See Figure 5-53.
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When you select this menu option, a dialog box displays the current Channel
Zoning settings. If you have administrator privileges, you can change the settings.
Figure 5-53 shows the default settings for an ADIC Gateway.

Figure 5-53: Default Channel Zoning Settings

Remove check marks in the boxes to create restricted access zones for the
desired SAN connections and SCSI Channels. All combinations are possible.
Bear in mind that an entire channel is zoned when the box is clicked.

If you are using the VPS Access option, it is possible, but not recommended, to
set up Channel Zoning settings.

Attention: If you make changes to the Channel Zoning settings you must reboot
the ADIC Gateway for the new settings to take effect.

Access Options: Virtual Private SAN

Virtual Private SAN provides you with a finer degree of access control between
host bus adapters in individual systems and Target LUNS on storage devices.
VPS can be used to allow multiple Fibre Channel hosts connected directly or via
switches and hubs to be able to share the same SCSI or Fibre Channels while
restricting their access to selected LUNs.
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Once you have Enabled Virtual Private SAN, you can open the Virtual Private SAN
settings box by selecting the ADIC Gateway in Tree View, and then going to
Controls > Access Options > Virtual Private SAN. You may also choose to use the
right-click menu. Virtual Private SAN is the sixth option on the right-click menu. See
Figure 5-54.

Figure 5-54: Right-Click Menu: VPS

Attention: If you did not use Channel Zoning to restrict access between SAN
connections and SCSI Channels, VPS has full control of all SAN and SCSI
Channels. If you did create restricted access zones, VPS can only assign access
permission within each accessible zone.
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Figure 5-55 shows the Virtual Private SAN Access Settings window. For a full
explanation of Virtual Private SAN, see “Installing and Using Virtual Private SAN”
on page 121.

Figure 5-55: VPS Access Settings

Access Options: Virtual Private Map

VPM is a software feature of the ADIC Gateway that allows any SAN device to
map to any desired ID/LUN on a SCSI attached host. VPM’s drag and drop
interface allows mapping of Fibre Channel and SCSI devices to a private SCSI
host channel. The system administrator uses the ADIC Management Console to
administrate VPM and create a private device map.

Once you have Enabled Virtual Private VPM, you can open the Virtual Private Map
settings box by selecting the ADIC Gateway in Tree View, and then going to
Controls > Access Options > Virtual Private Map. You may also choose to use the
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right-click menu. Virtual Private Map is the seventh option on the right-click menu.
See Figure 5-56.

Figure 5-56: Right-Click Menu: VPM
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The VPM settings dialog box consists of two panels. See Figure 5-57.

Figure 5-57: SCSI Devices Available For Mapping With VPM

Drag devices from the Available LUN column and drop them in the Assigned LUN
column next to the desired ID and LUN to make them available on the selected
SCSI channel. For more information on Virtual Private Map, see “Installing and
Using Virtual Private Map” on page 147.
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SNMP Community Strings

This menu option will display a dialog (Figure 5-58) that allows you to modify the
SNMP community strings for the ADIC Management Console. They are stored on
the Server.

Figure 5-58: SNMP Community Strings

SNMP community strings serve to group network devices into logical collections
for management purposes. The community strings on the Server must match
those on the ADIC Gateway you wish to manage.

There are three different strings defined for the ADIC Management Console:

Read allows the ADIC Management Console to get information from ADIC
Gateways with matching Read community strings.

Write allows the ADIC Management Console to manipulate the settings of ADIC
Gateways with matching Write community strings.

Trap allows the ADIC Management Console to receive Trap messages from ADIC
Gateways with matching Trap community strings.

The default settings for the ADIC Management Console allow the system
administrator to control and collect reports from all associated ADIC Gateways.
See the snmp suite of service port commands for information about changing
community string settings on specific ADIC Gateways.

SCSI Channel

If you have administrator privileges, you may change a SCSI Channel’s
configuration by selecting the channel in Tree View and then using the Controls
pull-down menu item (Controls > SCSI Channel) to open the SCS Channel
Parameters dialog box. You can also open this dialog box by selecting the
appropriate SCSI Channel in Tree View and then using the right-click menu. SCSI
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Channel is the eighth option in the list. See Figure 5-59. Unless you have selected
a SCSI channel in Tree View, the SCSI Channel option will be grayed out.

Figure 5-59: SCSI Channel Parameters Via the Right-Click Menu

Figure 5-60 shows you the parameters for a selected SCSI channel.

Figure 5-60: SCSI Channel Controls

Attention: If you change any of the SCSI Channel Parameter settings, you have
to reset the SCSI Channel or reboot the ADIC Gateway to use the new settings.

Channel Mode identifies the channel as either an Initiator or a Target.
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Host ID is typically assigned as 7.

You can press the Rescan SCSI Bus button to rescan the SCSI bus so the ADIC
Gateway can discover devices that have been added or removed. It also
refreshes the data for the devices on the SCSI channel and updates the display.

Bus Reset on Power Up is typically enabled. Removing the check mark from this box
disables SCSI bus reset on power-up.

The default Alternate Initiator ID is set automatically by the ADIC Gateway. When
the ADIC Gateway scans the SCSI Bus, it determines which IDs are currently
being used by target devices and sets the Alternate ID to the highest ID not in use.
You can change the Alternate ID using the pull-down or typing a new number. To
restore the automatic default selection, choose “-1” from the drop down list.

Termination is typically Enabled. Removing the check mark from this box disables
the internal termination circuits.

Pressing the Reset button reinitializes the SCSI Channel. This will cause the ADIC
Gateway to abort all pending commands, reset the channel, and perform a
rescan.

Attention: Use Reset carefully because it causes pending I/O commands to
return failed status back to the host operating system and may have unexpected
results. Make sure all I/O is stopped before issuing this command.

When you are finished viewing or setting SCSI Channel parameters, you may
press Cancel to abort all changes and return to the main screen or you may press
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OK to keep your changes and return to the main screen. If you press OK, two
warnings about the SCSI reset are issued. See Figures 5-61 and 5-62.

Figure 5-61: First SCSI Reset Warning

Figure 5-62: Second SCSI Reset Warning

Fibre Channel

Fibre Channel shows you parameters for the selected Fibre Channel interface. If
you have administrator privileges, you can change the settings by selecting the
Channel in Tree View and then going to Controls > Fibre Channel. You may also
access the Fibre Channel Parameters dialog box by selecting the Channel in Tree
View and then using the right-click menu. Fibre Channel is the ninth option. See
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Figure 5-63. Unless you have selected the Channel, the Fibre Channel option will
be grayed out on the menu.

Figure 5-63: Fibre Channel Parameters Via the Right-Click Menu

Attention: If you change any of the Fibre Channel Parameter settings, you have
to reset the Fibre Channel or reboot the ADIC Gateway to use the new settings.

Host Type has fourteen possible values: nt, aix, solaris, hp-ux, netware, gateway,
switch, generic, unisys, as400, autosense/nt, linux, fcr-2, and pv-136t-fc. The
default setting is NT. The host type is either the name of the host Operating
System or the type of network appliance attached to the port. This setting controls
the way the ADIC Gateway translates SCSI commands, such as the format of
SCSI sense data, which needs to be presented differently for some hosts. If the
VPS option is enabled, the host type setting in the VPS control panel will be used
rather than this setting.

The default Loop ID setting is Soft and should typically not be changed. (It may be
appropriate to use another Loop ID setting when using Fibre Channel switches). If
you remove the check mark from the box, you can enter a loop ID value from 0 to
125.

Frame Size has three possible values: 512, 1024, and 2048. The Fibre Channel
frame size is specified by each receiving node and need not match any other
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node. The frame size should typically be set to 2048. (It may be appropriate to use
another frame size if required by a particular software application.)

Figure 5-64: Fibre Channel Default Settings

Figure 5-64 shows the default Port Mode setting, which is “Target.” The default
connection option is “Loop.” You have options for changing the port mode and
connection.

When you are finished viewing or setting Fibre Channel parameters, you can
press the Reset button to make your changes take effect immediately. If you press
the OK button, you will be reminded that a Reset or Reboot are required for the
changes to take effect. Press OK to keep your changes and return to the main
screen. Press Cancel to abort your changes and return to the main screen.

Device Mapping

Using the ADIC Management Console, you can edit the ADIC Gateway’s
persistent address map database and customize the LUN assignment for each
target device. Select the ADIC Gateway in Tree View and then select Device
Mapping from the Controls pull-down menu. You may also access the Device
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Mapping dialog box via the right-click menu. See Figure 5-65. Device Mapping is
the fourth choice from the bottom.

Figure 5-65: Device Mapping on the Right-Click Menu

Attention: Making changes to LUN assignments in the persistent address map
database can affect Virtual Private SAN and Virtual Private Map access settings. If
you assign different LUNs to devices that were under VPS or VPM access control,
the same LUN could become associated with different devices and data would be
lost.
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After you have finished editing the device map, you must reboot the ADIC
Gateway for any changes to take effect.

Figure 5-66: Devices Available for Mapping

In Figure 5-66, several SCSI and Fibre devices are displayed all of which are
available for mapping. The selected device is on SCSI Channel 2 of the Gateway
at 192.168.30.201. The Target ID of the selected tape device is 4, its Device LUN
is 0, and its Assigned LUN is 2. The Data panel uses textual labels to specify this
information. Tree View uses the format [Target ID:Device LUN] - Assigned LUN.
The Assigned LUN is the LUN number that the ADIC Gateway has assigned to
this device in its persistent device map.
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For more information on Channel Numbering, see Appendix F: Channel Number
Reference.

Figure 5-67: Device Mapping Window

As shown in Figure 5-67, devices that have already been entered into the
persistent device map appear in black type on the left. The Device Mapping
Window uses the format 'Channel [Target ID:Device LUN] after the text string
“SCSI” or “Fibre”. The assigned LUN for each device shows up only in the left-
most column of the window, labeled 'LUN.' Grayed-out images of these same
devices, without the Assigned LUNs, appear in the right-hand column. LUN 0 is
typically occupied by the ADIC Gateway Command and Control LUN, unless it
has been assigned to another LUN.

In order to assign devices to appropriate LUNs, you may drag and drop devices in
two different ways. You may move devices back and forth from column to column
or you may move them vertically within the left-hand column to different LUNs.

If a device that appears in the Available LUN column is not already assigned, you
may delete it by dragging it down to the recycle bin icon.

In Figure 5-68, LUN 0 is still occupied by the ADIC Gateway Command and
Control LUN. Fibre devices have been assigned lower Assigned LUNs than the
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SCSI devices. When you are satisfied with the assignments that have been made,
press OK. If you decide not to make any changes, press Cancel.

Figure 5-68: Devices That Have Been Remapped

From the ADIC Management Console, select the Gateway, then from the Controls
menu, choose Restart SAN Gateway. Reboot the host, or use some other method to
ensure that the host is aware of the new device map.

Pre-Assigning Device Numbers

To assign a LUN to a device that is currently not present on the system, but for
which a soft LUN assigned during device discovery will not be adequate, press
the Add a new device button.
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The default device type is SCSI, see Figure 5-69. Fill in the desired Channel
Number, Target ID and LUN Number for a SCSI device.

Figure 5-69: Add New SCSI Device

If the device to be added is a Fibre Channel device, use the pull-down to select
Fibre, and then fill in the desired LUN and the WWN of the device, if known. See
Figure 5-70.

Figure 5-70: Add New Fibre Channel Device

The new device or devices will appear in the right-hand column of the Device
Mapping Window. In Figure 5-69, a new entry has been made for a SCSI device
that will be connected to SCSI Channel 2. It will have a target ID of 2 and a Target
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LUN of 1. It appears in the right-hand column of the Device mapping screen. See
Figure 5-71.

Figure 5-71: New SCSI Channel Device

Make sure that each device in the right-hand column is mapped to a LUN in the
left-hand column, or the Device Mapping window will not close. See Figure 5-72.
When you have assigned all devices, press OK.

Figure 5-72: Unmapped Devices Warning

From the ADIC Management Console, select the ADIC Gateway, then from the
Controls menu, choose Restart SAN Gateway. Reboot the host, or use some other
method to ensure that the host is aware of the new device map.
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Update Firmware

With the ADIC Gateway selected in Tree View, you can use the Controls > Update
Firmware option to update ADIC Gateway operational firmware or you can use it to
send micro-code to SCSI target devices as a means to update their firmware. You
can also access the Update Firmware file browser by using the right-click menu.
Update Firmware is the third option from the bottom. See Figure 5-73.

Figure 5-73: Update Firmware Via the Right-Click Menu

You can see the file browser in Figure 5-74. Select the file you want to load, and
then press the Yes button. The firmware file is sent to the currently selected device
(ADIC Gateway or target device). Otherwise, press the No button to abort the
download and return to the main screen. For the latest firmware,visit “Service and
Support” at www.adic.com, or call the ADIC Technical Assistance Center at 1-800-
827-3822. The readme file that accompanies the new firmware will list the file or
files that you need to upload and whether or not they should be uploaded in a
certain order if there is more than one.
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Attention: You must stop all activity from all of the attached hosts before you
update ADIC Gateway firmware. After you update ADIC Gateway firmware, you
must reboot the ADIC Gateway to use the new firmware.

Figure 5-74: Update Firmware

Restart SAN Gateway

After you select an ADIC Gateway in Tree View, you can use the Controls > Restart
SAN Gateway option to reboot it. You can also reboot a selected ADIC Gateway via
the right-click menu. Restart SAN Gateway is the second option from the bottom.
See Figure 5-75.

Figure 5-75: Using the Right-Click Menu to Restart a Gateway
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Attention: Restart will immediately stop all I/O activity. Any connected host must
stop sending commands to devices attached to the ADIC Gateway or it will cause
timeouts or other failures to be reported on the host system.

When you select Restart SAN Gateway, the following message is displayed:

Figure 5-76: Warning Before Restarting an ADIC Gateway

Identify ADIC Gateway

Identify SAN Gateway allows you to visually identify the selected ADIC Gateway.
Pressing the Turn Ready LED On button makes the RDY light flash rapidly. See
Figure 5-77. For the position of the RDY LED, see Figure 5-15 on page 74.
Pressing the Cancel button restores the RDY light to its normal operation and
returns you to the main screen.

Figure 5-77: Identify SAN Gateway
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Chapter 6: Installing and Using
Virtual Private SAN
This chapter introduces Virtual Private SAN. It describes its key features and
functions and provides information on installing and using VPS. This chapter is
organized as follows:

• Introduction to Virtual Private SAN
• Host Registration
• Installing the Host Registration Service
• Installing Virtual Private SAN
• Entering Host Parameters
• Changing Access Permissions
• Determining LUN Assignments
• Adding and Removing Hosts
• Combining VPS with Channel Zoning

Introduction to Virtual Private SAN

VPS is a software feature that collects all host and target information and
manages the end-to-end access control in the SAN. It allows the system
administrator to control access privileges between individual Host Bus Adapters
(HBAs) and target devices connected to ADIC Gateway SCSI and Fibre
Channels. The system administrator uses the ADIC Management Console to
administrate VPS.

1. VPS technology enables Storage Area Networks with multiple users to share
the same connectivity channels or pipes to access the same or different
storage elements or resources. Therefore, multiple virtual private connections
can be created on the same Storage networking infrastructure.

2. VPS is completely host independent and requires no software components on
the host (an optional automatic Host Registration Service that provides peri-
odic host status information is included). It has no interface dependencies and
supports Fibre Channel, SCSI or any other SAN interface. It is also indepen-
dent of the storage elements and requires no change in legacy or new storage
devices.

3. VPS keeps track of Fibre Channel HBAs by their unique World Wide Name
(WWN). Because Fibre Channel switches also have a WWN, VPS can see FC
switches connected to the ADIC Gateway and control their access.
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4. VPS manages access for hosts connected through FC switches and hubs to
the ADIC Gateway. The ADIC Gateway supports up to 256 LUNs across all of
its interfaces. It has a virtual limit for how many hosts (HBAs or Initiators) are
connected to each port. The default setting allows 16 initiators per port.
Consequently, with the default setting, an ADIC Gateway with six Fibre
Channel ports can support up to 96 host connections.

5. VPS creates and maintains a database in non-volatile memory to hold persis-
tent information about each HBA (or Initiator) and its LUN access privileges.

6. When you perform a Save SAN Gateway Configuration from the ADIC
Management Console, it saves both the persistent device map and the VPS
database to a file. This allows all configuration settings to be loaded onto
another ADIC Gateway in the event that the ADIC Gateway needs to be
replaced.

7. When VPS is enabled for the first time, it takes a “snapshot” of the existing
configuration. VPS automatically assigns access between HBAs and the
storage elements that they currently have access to so that an existing
configuration will not be affected. This means that online hosts attached to an
ADIC Gateway will continue to retain their current access permissions to
storage elements.

8. Any HBA (or Initiator) that is added to a SAN connection at a later time will
only have access to the ADIC Gateway Command and Control LUN. In this
case, the system administrator must explicitly set access privileges to the
desired storage element for each host connection.

Host Registration

The VPS database contains separate fields to store the WWN, host name, host
type, connection, host status and a LUN Access field that holds information about
LUNs assigned to it.

When the ADIC Gateway is first booted, VPS initially treats all hosts as “offline”
until a host sends
an I/O request to the ADIC Gateway. VPS detects the I/O and obtains the WWN of
the HBA or Initiator. If the WWN is already in the database (already registered),
VPS stores the value “online” in the status field.

If the WWN is not in the database, VPS adds it and stores the value “online” in the
status field. VPS sets the default value for each of the other parameter fields to
“unknown”.

At this point, VPS has registered the HBA or Initiator but has minimal information
about it. The system administrator can proceed to complete the registration by
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using the ADIC Management Console to manually enter the “unknown” host
information and assign access privileges to LUNs.

Installing the Host Registration Service

If there are multiple hosts connected to the SAN, the system administrator cannot
easily tell which host is associated with each WWN. Unless it receives a periodic
status indication from the host, VPS cannot determine whether a host stays online
(connected and running) or goes offline (disconnected or shutdown);
consequently, the status field contains the value “online” for any host that was
registered since the ADIC Gateway was last booted. It is important for the system
administrator to know whether hosts are online or offline when configuring VPS
access settings.

A Host Registration Service is provided to simplify VPS configuration and it allows
the system administrator to monitor host status. It removes the burden of
physically tracing each connection to correlate the Fibre Channel HBA WWN with
a specific host. If the service is not installed, its absence does not impede VPS
operation. However, the information it provides to the system administrator is very
valuable. It helps the system administrator correctly identify each host HBA and
also obtain host status information.

The registration service installs on most host platforms and it provides VPS with
periodic host status information including the host name, host type, host
connection and the online or offline status. Host information is sent over the host
Fibre Channel connection to the ADIC Gateway.

The service registers the host with VPS automatically when the host system starts
up and its default setting re-registers the host at 15-minute intervals. The
registration period is also communicated. VPS checks to see whether the host has
re-registered at the proper interval. If a host does not re-register after two
registration periods have elapsed, VPS changes the status field in the database to
offline. You can change the re-registration period to any value between 1 and 255
minutes. See the readme file provided with the Host Registration Service utility for
further information about changing the registration period.

Once installed, the service runs automatically and does not require further system
administrator interaction. From the ADIC Management Console, you can see the
Fibre Channel that the host is connected to and you can tell whether the host is
online or offline.

Note: You have to refresh the ADIC Gateway from the ADIC Management
Console to see host status changes.

The Host Registration Service utility is provided on the CD-ROM. For the
Windows NT/Windows 2000 platform, you install it from within the SAN Explorer
installation program. For Solaris, AIX and other platforms, see the readme file in
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the HOSTSW folder for installation instructions. For software updates, visit
“Service and Support” at www.adic.com, or call the ADIC Technical Assistance
Center at 1-800-827-3822.

Installing Virtual Private SAN

VPS is a software module that is part of the ADIC Gateway operational firmware.
Check the readme file on the CD-ROM to find out if the firmware and software that
you have will support VPS. For firmware and software updates, see the Web site
and technical support contact information in the of this manual.

By default, VPS is not enabled. Virtual Private SAN is an optional feature that
requires you to enter a software license key to activate it. Obtain the key where
you purchased the ADIC Gateway.

Note: If this feature is factory enabled, you can activate it by simply entering the
word enable rather than an actual license key to activate it.“Installation Steps for
an Existing SAN Gateway” on page 132.

Installation Instructions

The steps you need to take to install and enable VPS are different for a new ADIC
Gateway installation than they are if you are adding VPS to an ADIC Gateway that
was installed at an earlier time. If you are performing a new installation, go to the
section “Installation Steps for a New SAN Gateway Installation” on page 124.

As a convenience to you, VPS will inherit host access privileges to storage
elements on an existing ADIC Gateway configuration. VPS will automatically
assign host access to the same storage elements that the hosts have been using.
If you want VPS to inherit host access permissions, go to the section “Installation
Steps for an Existing SAN Gateway” on page 132.

Installation Steps for a New SAN Gateway Installation

Note: This procedure assumes that the storage devices and the ADIC Gateway is
turned on and the ADIC Management Console software has already been
installed.

1. If you already installed the Host Registration Service during the Pre-installa-
tion checklist, go to step 2. If not, install it on each host now. See “Installing
the Host Registration Service” on page 123.

Note: If you do not install the Registration Service you have to enter host
parameters manually. See “Entering Host Parameters” on page 137.

2. Shut down the hosts.
Installing Virtual Private SAN



Installing Virt
3. If the ADIC Management Console Server and Client are already running and
you are already logged in with administrative privileges and connected to the
ADIC Gateway, go to step 4. If not, start the Server and Client, login as the
administrator and connect to the ADIC Gateway.

4. From the ADIC Management Console, select the ADIC Gateway. From the
Controls menu, select Restart SAN Gateway. Restarting the ADIC Gateway
eliminates the possibility that it has any previous knowledge of the hosts.

5. Wait for the ADIC Gateway to finish booting.

6. From the Controls menu, select Feature Enable > Virtual Private SAN.

7. In the dialog box, enter the License Key for your specific ADIC Gateway.

Note: If this feature is factory enabled, you can activate it by simply entering
the word enable rather than an actual license key.

8. Startup one of the hosts and wait for it to finish booting. From the ADIC
Management Console, select the ADIC Gateway. From the View menu, select
Refresh SAN Gateway.

9. After the ADIC Gateway has been refreshed, expand the tree to show tree
elements. Expand the tree for the Fibre Channel that the host is connected to
and verify that the registered host is displayed. Figure 6-1 is an example that
shows how a registered host that has the Host Registration Service running is
displayed.

Figure 6-1: One Registered Host Online
125
ual Private SAN



126
In the Tree View panel of Figure 6-1, you can see that the host is connected to
ADIC Gateway Fibre Channel port 1. In the text string after the host icon in Tree
View, you can read the WWN of the HBA and the beginning of the network name
of the computer. You can use the scroll bar to expand your view of this panel (see
Figure 6-2) or you can read the host type, operating system, patch level, and other
host connection information (SCSI map from the host point of view) in the Data
panel. These parameters were provided automatically from the Host Registration
Service.

Figure 6-2: Detail of Host Information in Tree View Panel
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10. Repeat steps 8 and 9 until all hosts are displayed. Figure 6-3 is an example
that shows how two registered hosts are displayed.

Figure 6-3: Confirming That Two Registered Hosts are Online
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11. Expand the tree to display storage devices and determine their assigned
LUNs. Figure 6-4 shows the Assigned LUN for the selected SCSI device on
SCSI Channel 3.

Figure 6-4: Determining the Assigned LUN

The Assigned LUN for the selected device is displayed in the first line of the Disk
Device description area. In the above example, the Assigned LUN for the selected
disk device is 1.

12. Make a list of each Assigned LUN and decide the LUNs you want to allocate
to each host.
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13. From the ADIC Management Console, select the ADIC Gateway. From the
Controls menu, select Access Options > Virtual Private SAN. Figure 6-5 shows a
Virtual Private SAN window that does not yet have any access settings.

Figure 6-5: Initial VPS Window before Access Assignments

Registered hosts are shown in the column on the left. When a host is online, its
name is in black. When a host is registered but not currently online its name is in
blue. If no hosts are displayed, the New Host Data area shows only a default Host
Type. When you select a host, its parameters are displayed at the bottom of the
window and you can edit them. See “Entering Host Parameters” on page 137 for
further information about editing host data fields.

After you have selected a certain host, and its parameters are displayed at the
bottom of the window, you can still see parameters for another host by hovering
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the mouse over the other host’s name. A pop-up with host parameters will appear.
See Figure 6-6.

Figure 6-6: VPS Host Parameters Pop-Up

14. Use the scroll bar below the squares to scroll right or left and locate the
desired LUN.

Assign host access to a LUN by pointing the mouse to a square in the
Assigned LUNs area and clicking. Checkmarks in the Assigned LUNs area
indicate that access is enabled between the LUN and corresponding host. If
you change your mind, you can click the square again and the checkmark will
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be removed. Figure 6-7 is an example of the VPS Access Settings window
after access settings have been made.

Figure 6-7: Assigning Host Access Permissions

For more information about the device at a specific LUN, you can hover the
mouse over the Assigned LUN number in the header row. See Figure 6-8. The
pop-up will state the Channel Number, Target ID and Device LUN, product ID,
vendor ID, and serial number of the device.

Note: You can create combinations of “exclusive” and “shared” access
to LUNs from different HBAs installed in the same host.

Attention: Devices mapped to a particular host with VPS (or VPM)
are available for mapping to other hosts via both the Assigned LUN
checkboxes of the VPS Access Settings window and the Assigned
LUN column of the VPM window. If multiple assignments are made,
the system administrator should verify that the devices are intended
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to be available to more than one host.

Figure 6-8: VPS Device Parameters Pop-Up

15. After you have finished assigning the desired access privileges, press the
Apply Changes button. Press the Close button to return to the main screen.

16. You now have to reboot the hosts or use some other host method to rescan
for devices before the host can see the new devices.

17. You have completed the VPS installation. If you need to add a new host or
remove a host from the SAN configuration, enter host parameters, etc., see
the appropriate section in this chapter for further information.

18. Save your configuration, as explained in “Save SAN Gateway Configuration”
on page 90.

Installation Steps for an Existing SAN Gateway

Note: This procedure assumes that the storage devices, ADIC Gateway and
hosts are turned on and the ADIC Management Console software has already
been installed. The hosts need to be online to inherit their current access
privileges when you enable VPS.
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1. The default Channel Zoning settings allow any-to-any access. If you did not
change the default settings, go to step 2.

Otherwise, if you have changed Channel Zoning settings to create restricted
access zones, confirm that you want to keep those settings and restrictions. If
you want to keep those settings, go to step 2.

You can use a combination of Channel Zoning and VPS but VPS can only
control access permissions between devices in the same access zone. See
the section on “Combining VPS with Channel Zoning” on page 145. You may
want to consider removing Channel Zoning access restrictions. If you do, you
need to reboot the ADIC Gateway after changing the settings.

Note: If you need to reboot the ADIC Gateway, VPS will not be able to inherit
host access permissions. You will have to manually assign access for them. If
this is the case, exit this procedure and go to the section “Installation Steps for
an Existing SAN Gateway” on page 132.

2. If the ADIC Management Console Server and Client are already running and
you are already logged in with administrative privileges go to step 3. If not,
start the Server and Client, login as the administrator and connect to the ADIC
Gateway.

3. From the ADIC Management Console, select the ADIC Gateway. From the
Controls menu, select Feature Enable > Virtual Private SAN.

4. In the dialog box, enter the License Key for your specific ADIC Gateway.

Note: If this feature is factory enabled, you can activate it by simply entering
the word enable rather than an actual license key.

5. Install the Host Registration Service on each host. See “Installing the Host
Registration Service” on page 123.

Note: If you do not install the Registration Service you have to enter host
parameters manually. See “Entering Host Parameters” on page 137.

6. After the hosts have finished booting. From the ADIC Management Console,
select the ADIC Gateway. From the View menu, select Refresh SAN Gateway.

7. After the ADIC Gateway has been refreshed, expand the tree to show tree ele-
ments. Expand the tree for the Fibre Channels and verify that all registered
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hosts are displayed. Figure 6-8 is an example that shows how registered
hosts are displayed.

Figure 6-8: Two Hosts Online

In the Tree View panel of Figure 6-8, you can see that hosts are connected to the
ADIC Gateway Fibre Channel ports 1 and 2. In the text string after the host icons
in Tree View, you can read the WWN of the HBAs and the beginning of the
network names of the computers. You can use the scroll bar to expand your view
of this panel (see Figure 6-10) or you can read the host type, operating system,
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patch level, and other host connection information (SCSI map from the host point
of view) for a selected host from the Data panel.

Figure 6-9: Detail of Tree View Panel
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8. From the ADIC Management Console, select the ADIC Gateway. From the
Controls menu, select Access Options > Virtual Private SAN. Figure 6-10 shows
the Virtual Private SAN Access Settings window.

Figure 6-10: Checking Access Settings Inherited from Hosts

9. Registered hosts are shown in the column on the left. When a host is online its
name is black. When a host is registered but not currently online its name is
blue. When you select a host, its parameters are displayed at the bottom of
the window and you can edit them. See “Entering Host Parameters” on
page 137 for further information about editing host data fields.

Checkmarks in the Assigned LUNs area indicate that access is enabled
between the LUN and corresponding host. See “Changing Access
Permissions” on page 140 for further information about changing access
settings.

Verify that the access settings are as desired. You can find out the ADIC
Gateway channel that each LUN is on and see how the ADIC Gateway has
made LUN assignments by pressing the Close button and going back to the
main screen.

10. Expand the tree to display SCSI or Fibre Channel storage devices and
determine their assigned LUNs. Figure 6-11 shows the Assigned LUN for the
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selected SCSI device on SCSI Channel3.

The Assigned LUN for the selected device is displayed in the first line of the
Disk Device description area. In this example, the assigned LUN for the
selected disk device is 1.

Figure 6-11: Checking the Assigned LUN

11. After you have determined the assigned LUN for each device, you can go
back to the VPS window and confirm that the access settings are as desired.

12. Your transition to VPS is complete. If you need to add a new host or remove a
host from the SAN configuration, enter host parameters, etc., see the appro-
priate section in this chapter for further information.

13. Save your configuration, as explained in “Save SAN Gateway Configuration”
on page 90.

Entering Host Parameters

You may need to manually enter host parameters if the Host Registration Service
is not installed or when automatic host registration is not available for a specific
host type (for example, to register a Fibre Channel switch). When you see the
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WWN of the host in the VPS Access Settings window and the other fields are
shown as “unknown” you can change them to meaningful parameters. The WWN
is acquired automatically and it does not need to be changed. You can also enter
the WWN for a host that is not yet attached to the SAN (see “Adding and
Removing Hosts” on page 143).

From the Controls menu, select Access Options > Virtual Private SAN to display the
VPS Access Settings Window. Figure 6-12 shows how a Fibre Channel switch is
displayed before its parameters have been entered.

Figure 6-12: Unknown Host Parameters

In the Fibre Channel switch example above, initially the WWN is known but the
other parameters are “unknown”.

When you select a host in the left column, its parameters are displayed as fields
below the New Host Data label and you can edit the fields. At the right of the fields
there is an area labeled Original Host Data that shows the values that were in the
fields before you made changes. The fields contain the following parameters.
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Host Name: Usually the name of the computer on the Local Area Network
(LAN). System administrators use this name to refer to the
host.

Host Type: The type of host, version of the operating system software
and the Service Pack Level (NT/Windows 2000) or patch
level (e.g., Solaris, AIX). Select the arrow at the right of the
Host Type field to choose the appropriate entry from the pull-
down list.

Host Connection: Indicates the way the host has mapped its connection to the
ADIC Gateway. It is typically a representation of the host
SCSI mapping to bus, target and LUN. It also identifies the
type of HBA.

Host WWN: The World Wide Name of the HBA or Initiator. The WWN is a
unique identifier that also contains a manufacturer field. If
you are entering this number manually, you must enter a
colon after the first eight characters of the WWN for the ADIC
Management Console to accept your entry, even if the
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manufacturer of your Host Bus Adapter displays it with some
other punctuation.

Figure 6-13: Entering Parameters for a Fibre Channel Switch

Figure 6-13 shows the Host Type pop-up list and an example of parameters that
were entered for the Fibre Channel switch.

Changing Access Permissions

Attention: Ensure that the host is not accessing the device LUN if you intend to
remove its access privileges. If possible, unmount the file system or shutdown the
host before removing access. If you give shared access to a LUN, ensure that
some other software will manage device sharing.
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From the ADIC Management Console, select the ADIC Gateway. From the
Controls menu, select Access Options > Virtual Private SAN to display the VPS
Access Settings window as shown in Figure 6-14.

Figure 6-14: Changing Access Permissions

You can use the scroll bar below the squares to scroll right or left and locate the
desired LUN. You can use the scroll bar at the right of the squares to scroll up or
down and locate the desired host.

Note: You can create combinations of “exclusive” and “shared” access to LUNs
from different HBAs installed in the same host.

You can enable host access to a LUN by pointing the mouse to the specific empty
square in the Assigned LUNs area and clicking. Checkmarks in the Assigned
LUNs area indicate that access is enabled between the LUN and corresponding
host. If you change your mind, you can click the square again and the checkmark
will be removed.

You can disable host access to a LUN by pointing the mouse to the specific check-
marked square and clicking. If you change your mind, you can click the square
again and the checkmark will reappear.
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After you have finished assigning the desired access privileges, you can press the
Apply Changes button and the new settings will take effect immediately.

You can press the Undo Changes button to abort your changes.

You can press the Close button to return to the main screen.

Note: You have to reboot the hosts or use some other host method to rescan for
devices before the host can see new devices.

Determining LUN Assignments

You can expand the tree to display SCSI Channel storage devices and determine
their assigned LUNs. Figure 6-15 shows the Assigned LUN for the selected SCSI
device on SCSI Channel 3.

Figure 6-15: Determining the Assigned LUN

The Assigned LUN is displayed below Disk Device description on the right side of
the screen. In the above example, the assigned LUN for the selected disk device
is 1.
Determining LUN Assignments
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Adding and Removing Hosts

After VPS is already enabled, you may want to add a Host (or Initiator) to the SAN
configuration or remove it from the SAN configuration. This section describes how
to add and remove hosts.

Adding a Host to the SAN Configuration

You can connect a new host to the SAN at any time. VPS automatically adds the
new host to the database as soon as the host is attached to the SAN. If you want
to attach a new host at this time, go to the section “Attaching a New Host to the
SAN,” below. Otherwise, if you want to configure VPS before attaching the host,
go to the section “Adding a Host Before Attaching it to the SAN” on page 144.

Attaching a New Host to the SAN

When you attach a new host to the SAN, VPS automatically detects the host and
adds it to the VPS database. When you connect or refresh the ADIC Gateway
from the ADIC Management Console, you can see the new host in the VPS
Access Settings window. If the Host Registration Service is running on the host,
VPS automatically obtains the host parameters. If the Host Registration Service is
not running on the host, VPS only knows the WWN of the HBA. In this case, you
can manually enter the other host parameters.

Follow these steps to add a new host to the SAN configuration:

1. Connect the host to the SAN.

2. If you need to install the Host Registration Service, refer to the section
“Installing the Host Registration Service” on page 66.

3. If you need to determine LUN assignments for the devices you want to assign
to the new host, refer to the section “Changing Access Permissions” on
page 140.

4. For further information about entering host parameters, refer to the section
“Entering Host Parameters” on page 78.

5. Refer to the section “Changing Access Permissions” on page 140 to assign
access permissions for the new host.

6. Save your configuration, as explained in “Save SAN Gateway Configuration”
on page 90.

7. Verify that the new host has access to the assigned devices.
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Adding a Host Before Attaching it to the SAN

You can add a host that has not yet been attached to the SAN and configure its
access permissions beforehand. You add the host by pressing the New Host
button in the VPS Access Settings window and manually entering the WWN and
other parameters as shown in Figure 6-16.

Figure 6-16: Adding a New Host

You must at least enter the Host WWN and Host Type. You can enter the other
parameters if you know them or you can enter them at a later time. You can also
let VPS automatically obtain the remaining parameters from the Host Registration
Service at a later time. For further information about entering host parameters,
refer to the section “Entering Host Parameters” on page 137.

When you are finished entering the host parameters, press the Accept New Host
button.

If you press the Quit New Host button, VPS will discard all of the new host data.

After the new host has been added you can assign its access permissions.
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Follow these steps to finish configuring VPS:

1. If you need to determine LUN assignments for the devices you want to assign
to the new host, refer to the section “Determining LUN Assignments” on
page 142.

2. Refer to the section “Changing Access Permissions” on page 140 to assign
access permissions for the new host.

3. When you are ready to attach the new Host to the SAN, go to the section
“Attaching a New Host to the SAN” on page 143.

Removing a Host from the SAN Configuration

You may want to remove a host from the VPS database. VPS will prevent you
from removing a host that is online. Follow these steps to remove a host from the
configuration.

1. Stop all I/O from the host to the ADIC Gateway and disconnect it, or shut down
the host.

Attention: If the host is still attached and it performs an I/O to the ADIC
Gateway or the Host Registration Service re-registers the host, you will not be
able to remove the host from the VPS database.

2. From the ADIC Management Console, select the ADIC Gateway and expand
the tree to display the Fibre Channel that the host is connected to. If the host
status is “offline” go to step 3.

If the host status is “online” and the Host Registration Service was previously
re-registering it periodically, you can refresh the ADIC Gateway and wait for
VPS to automatically take the host “offline”. Otherwise, if you are sure that the
host is not online you can manually take it offline.

3. From the Controls menu, select Access Options > Virtual Private SAN to display
the VPS Access Settings Window.

4. If VPS displays the host online, you can press the Take Host Off Line button.
Otherwise, if the host is already offline, press the Delete Host button and the
host will be deleted from the database.

Combining VPS with Channel Zoning

Although it is possible to combine VPS and Channel Zoning, it is not
recommended. VPS settings will not be in effect if any of the LUNs included in the
VPS setting are on Channels that have been zoned out. No warning or Trap will
be sent. If you do have a legacy Channel Zoning configuration, it is recommended
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that you edit the zones to permit all SAN Connections to have access to all SCSI
channels, or you may end up with inaccessible devices that you had intended to
be accessible.
Combining VPS with Channel Zoning
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Chapter 7: Installing and Using
Virtual Private Map
This chapter introduces Virtual Private Map. It describes key features and
functions and provides information on enabling and using VPM. This chapter is
organized as follows:

• Introduction to Virtual Private Map
• Enabling Virtual Private Map
• Mapping Devices With VPM
• Removing Devices From VPM

Introduction to Virtual Private Map

• VPM is a software feature of the ADIC Gateway that allows any
SAN device to map to any desired ID/LUN on a SCSI attached
host. VPM’s drag and drop interface allows mapping of FC
devices to SCSI ID/LUNs. The system administrator uses the
ADIC Management Console to administrate VPM and create a
private device map.

• VPM expands the usefulness of legacy SCSI hosts in the new
SAN infrastructure. It allows for the creation of independent pri-
vate maps.

• VPM technology enables Storage Area Networks to create a
daisy-chain of virtual, multiple SCSI devices connected to a sin-
gle SCSI host.

• VPM is another method of access and security control in SAN,
similar to VPS, and designed specifically for hosts connected to
SAN via SCSI.

• VPM is completely host and device independent and requires no
software components on the host.

• VPM manages access for hosts connected through SCSI
interfaces to the ADIC Gateway. The ADIC Gateway supports up
to 256 LUNs across all of its interfaces

• When you perform a “Save Configuration” from the ADIC
Management Console, it saves both the persistent device map
and the VPM database to a file. This allows all configuration
settings to be loaded onto another ADIC Gateway in the event
that the ADIC Gateway needs to be replaced.
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Enabling Virtual Private Map

By default, VPM is not enabled. Virtual Private Map is an optional feature that
requires you to enter a software license key to activate it. You may need to obtain
the key where you purchased the ADIC Gateway. Use the Feature Enable option
of the Controls menu to enable VPM. See “Feature Enable: Virtual Private Map”
on page 96. If Virtual Private Map is grayed out on the Feature Enable submenu,
VPM has already been enabled or is not available.

Note: If this feature is factory enabled, you can activate it by simply entering the
word enable rather than an actual license key to activate it.

Mapping Devices With VPM

After you have finished assigning devices to a SCSI host channel, the devices will
be immediately available to the host. Reboot the host, or use some other method
to ensure the host rescans for devices.

Attention: Devices mapped to a particular host with VPM (or VPS) are available
for mapping to other hosts via both the Assigned LUN column of the VPM window
and the Assigned LUN checkboxes of the VPS Access Settings window. If
multiple assignments are made, the system administrator should verify that the
devices are intended to be available to more than one host.

Map Devices on a Fibre Channel to a SCSI Host

1. With the ADIC Gateway selected, choose Feature Enable > Virtual Private Map
(see instructions on page 96). If this feature is unavailable or is already
enabled, it will be grayed out on the menu.
Enabling Virtual Private Map
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2. After the VPM feature is enabled, select the SCSI channel where the host
attaches and check the channel mode display in the right-hand panel to be
sure it is set to Target. See Figure 4.

Figure 7-1:SCSI Channel Set to Target

3. If it is not, select the SCSI Channel, go to Controls > SCSI Channel, and choose
the Target radio button. See “SCSI Channel” on page 105. Answer “yes” to
both questions about resetting the channel.

4. After the channel has reset, select the ADIC Gateway and choose View >
Refresh San Gateway. Expand the Fibre Channel with the devices that you want
the SCSI host to access.

5. Select the SCSI channel in Tree View to verify Channel information. See
Figure 4. In order for the ADIC Management Console to display a SCSI host,
you must install the Host Registration Software. See “Installing the Host
Registration Service” on page 123.

6. With the SCSI channel that is set to Target selected (in this example,
Ultra2SCSI Channel 1, where the host attaches) go to Controls > Access
Options > Virtual Private Map. A view of all available and mapped devices will be
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displayed in the Virtual Private Mapping window. The Fibre Channel devices
on Fibre Channel 3 in Figure 7-1 are displayed in Figure 7-2.

Figure 7-2:Initial VPM Mapping Window (Fibre Devices)

5. In Figure 7-2 you can see how these devices look to the ADIC Gateway
before they have been assigned to a SCSI host channel. LUN 0, shown in
Figure 7-2, is reserved for the ADIC Gateway Command and Control LUN.
When the Command and Control LUN is mapped, its Channel numbering
convention follows a different numbering practice than the practice followed in
Tree View. See “Channel Number Reference” on page 321.

The numbers in the first line of each Available LUN are to be read as follows:
Starting in the right-hand panel, the first number is the LUN assignment from
the ADIC Gateway’s persistent device map. “Fibre - 3”, for example,
represents the ADIC Gateway Fibre Channel port where the device is
attached. Inside the square brackets, the first number is the Target ID, and the
second number is the Target LUN.

The unique World Wide Name of each device is displayed on the next line,
unless the devices are attached to a multi-LUN device, e.g. a RAID controller.
In that case, the WWN is the same for every device attached to the controller.
Mapping Devices With VPM
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The Assigned LUN column of the VPM display provides map space for IDs 0-
15 associated with the selected SCSI channel, LUNs 0-7 associated with each
ID, and a box into which a device from the Available LUN column can be
dragged and dropped in order to occupy a particular ID and LUN on the SCSI
host channel.

Drag and drop the devices from the Available LUN column to the appropriate
LUN in the Assigned LUN column. When a target device has been mapped, it
appears gray in the Available LUN column. See Figure 7-3.

Figure 7-3:VPM Mapping Changes Made (Fibre Devices)

6. You must drag the Command and Control LUN over to the Assigned LUN col-
umn. For more information on Channel numbering, see “Channel Number
Reference” on page 321.

7. When you are satisfied with the changes you have made to the device map,
press OK. If you do not want to retain the map, press Cancel.

8. Reboot the host, or use some other method to ensure the host rescans for
devices.
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Map Devices on a SCSI Channel to a SCSI Host

1. With the ADIC Gateway selected, choose Feature Enable > Virtual Private Map
(see instructions on page 96). If this feature is unavailable or is already
enabled, it will be grayed out on the menu.

2. After the VPM feature is enabled, select the SCSI channel where the host
attaches and check the channel mode display in the right-hand panel to be
sure it is set to Target. See Figure 7-4.

Figure 7-4:SCSI Devices Available for Mapping

3. If it is not, select the SCSI Channel, go to Controls > SCSI Channel, and choose
the Target radio button. See “SCSI Channel” on page 105. Answer “yes” to
both questions about resetting the channel

4. After the channel has reset, select the ADIC Gateway and choose View >
Refresh San Gateway. Expand the SCSI Channel with the devices that you want
the SCSI host to access. Select the SCSI channel in Tree View to verify
Channel information.

5. In order for the ADIC Management Console to display a SCSI host, you must
install the Host Registration Software. See “Installing the Host Registration
Service” on page 123.

6. With the SCSI channel that is set to Target selected (in this example,
Ultra2SCSI Channel 1, where the host attaches) go to Controls > Access
Options > Virtual Private Map. A view of all available and mapped devices will be
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displayed in the Virtual Private Mapping window. The SCSI devices shown in
Tree View in Figure 7-4 are shown in the VPM window in Figure 7-5.

5. In Figure 7-5 you can see how these devices look to the ADIC Gateway before
they have been assigned to a SCSI host channel. You have to use the scroll
bar to get down to the LUN numbers that they are using.

The numbers in the first line of each Available LUN are to be read as follows:
Starting in the right-hand panel, the first number is the LUN assignment from
the ADIC Gateway’s persistent device map. The next number is the channel,
e.g. “SCSI- 3.” For more information on Channel numbering, see “Channel
Number Reference” on page 321. Inside the square brackets, the first number
is the Target ID, and the second number is the Target LUN.

Figure 7-5:Initial VPM Mapping Window (SCSI Devices)

5. The Assigned LUN column of the VPM display provides map space for IDs 0-
15 associated with the selected SCSI channel, LUNs 0-7 associated with each
ID, and a box into which a device from the Available LUN column can be
dragged and dropped in order to occupy a particular ID and LUN on the SCSI
host channel.

Drag and drop the devices from the Available LUN column to the appropriate
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LUN in the Assigned LUN column. When a target device has been mapped, it
appears gray in the Available LUN column (see Figure 7-6).

Figure 7-6:VPM Mapping Changes Made (SCSI Devices)

6. The ADIC Gateway’s persistent device map contains the product ID, Vendor
ID and Serial Number of SCSI devices it knows about. This information can be
read in the Data panel of the ADIC Management Console when the device is
highlighted in Tree View (see Figure 7-4).

When the SCSI devices are read by VPM, only the assigned LUN, the SCSI
channel, the target ID, and the target LUN are displayed (see Figure 7-5).

Figure 7-6 shows SCSI devices assigned to specific LUNs that the SCSI host
has access to.

7. You must drag the Command and Control LUN over to the Assigned LUN
column. For more information on channel numbering, see “Channel Number
Reference” on page 321.

8. When you are satisfied with the changes you have made to the device map,
press OK. If you do not want to retain the map, press Cancel.
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9. Reboot the host, or use some other method to ensure the host rescans for
devices.

Removing Devices From VPM

1. With the SCSI channel that is set to Target selected, go to Controls > Access
Options > Virtual Private Map. The Virtual Private Mapping window will present
its view of all available and mapped devices.

2. Select the device that you wish to become inaccessible to the SCSI host in the
left-hand panel. Drag and drop it into the right-hand panel. See Figure 7-7.

Figure 7-7:Device Removed From Virtual Private Map

3. Press OK.

4. When you are satisfied with the changes you have made to the device map,
press OK. If you do not want to retain the map, press Cancel.

5. Reboot the host, or use some other method to ensure the host rescans for
devices.
155
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Chapter 8: Maintenance Action
Plans
This section describes the maintenance action plan for the ADIC Gateway

Start MAP

Always start problem determination here and review the following steps. Gather
as much information as possible before performing a repair action. When
gathering information, you may need to connect the service terminal to the service
port. See “Connecting to the Service Port” on page 217.

For the latest information on the ADIC Gateway, visit “Service and Support” at
www.adic.com, or call the ADIC Technical Assistance Center at 1-800-827-3822.

Event Code or Obvious Symptom

Either an Event Code has been reported by the ADIC Management Console or an
error has been observed by other means. If the event code or error symptoms are
known, go to the “Service Reference Table” on page 161 with that event code or
symptom, and perform the recommended action.

Visually Inspect LEDs

Observe front-panel ADIC Gateway LED status indicators and check against the
“Service Reference Table” on page 161. For more information about expected
LED behavior, see “LED Indicators” on page 19.

If the RDY LED is flashing as expected but the SCSI, Ethernet and SAN
Connection LEDs are off, the ADIC Gateway may have been left in diagnostic
mode. The device drivers for SCSI, Fibre Channel and Ethernet interfaces are
disabled when in diagnostic mode. If the command prompt on the service terminal
is diagmode >, return the ADIC Gateway to normal mode by entering the
normalBoot command on the service terminal (see “Boot Modes” on page 295).
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Check for Problems on Attached SCSI Devices

Check the following on the SCSI devices to determine whether they are the
source of the problem:

• LEDs
• Display panels
• Firmware levels
• Operability

Check FC Host Versions

For an updated list of supported ADIC Gateway host platforms and Fibre Channel
Host Bus Adapters, visit “Service and Support” at www.adic.com, or call the ADIC
Technical Assistance Center at 1-800-827-3822.

You’ll need to determine the following:

• Operating system version
• Service pack version
• Hot-fix version
• HBA hardware version
• HBA firmware version
• HBA device driver version

If an update is required, perform the update.

Check ADIC Gateway Product Versions

For an updated list of required updates, visit “Service and Support” at
www.adic.com, or call the ADIC Technical Assistance Center at 1-800-827-3822.

1. If the ADIC Management Console application is in use, use the Help > About
menu in the ADIC Management Console to determine its software version. If
an update is needed, download the update from the Web site and perform the
update.

2. To check the firmware version, start the ADIC Management Console and
connect to the ADIC Gateway. When the initial Tree View appears, choose the
ADIC Gateway and then read the firmware version from the right-hand panel
of the display.

If the client application is not available, use the version command from the
service terminal to determine the firmware version (see the "version" 
command on page 283. If an update is required, download the update from
the Web site and perform the update.
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3. Hardware version information is viewed by using the sysVpdShow command
from the service terminal. If your service representative determines that the
hardware version is at issue in your situation, you may need to use the
"sysVpdShow or sysVpdShowAll" command on page 277.

Check Event Log

For information on accessing the Event Log, see “Events” on page 85. Go to Tools
> Events > View Event Log.

When viewing the log, set the viewing level to Warning. A message that looks
like:

000001 0185 0d:00h:00m:05s:15t -- NOTICE: LOGGING STARTED

should be in the list. If not, then continue viewing the event log until the start
message can be found in the log. If this start message cannot be found, then use
the log message with the lowest sequence number (the first number on the display
line) as the start of the current log.

Check the event codes against the “Service Reference Table”on page 161. If there
are no abnormal events, go to “Perform Health Check” on page 159.

If the client application is not available, use the loggerDumpCurrent 2
command from the service terminal. See the "loggerDump [number]" 
command on page 252. Check the event codes against the “Service Reference
Table” on page 161. To see additional log messages, follow the procedure “Event
Log Dump” on page 297. If there are no abnormal events, go to “Perform Health
Check,” on page 159.

Quick Component Check

From the service terminal, enter the showBox command. See the "showBox" 
command on page 273. If an installed component does not show up in the display,
go to the correct MAP. For example, if a SCSI interface is missing, go to “SCSI
MAP” on page 171. If the DDF board is missing, see “DDF Board MAP” on
page 185. If a Fibre Channel is missing, go to “Fibre Channel MAP” on page 178.

Perform Health Check

1. If the ADIC Management Console application is in use, see “Health Check” on
page 82.

2. Go to Tools > Health Check > Setting Health Check

3. On the Level tab of the Health Check Setting dialog box, choose the Device
Ready radio button.
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4. Go to Tools > Health Check > Setting Health Check > Perform Health Check.

5. Write down the event codes reported by the Health Check procedure.

6. If Health Check cannot be performed using the client application, use the
hlthChkNow command from the service terminal. See also “Manual Health
Check” on page 296”.

Check the Host Event Log

Check the event log on the FC host. Look for the most recent entries and check to
see if there are any FC HBA driver errors. If there are, go to “Fibre Channel MAP”
on page 178.

Service Reference Table

Review all visual observations and event codes against the following table.
Numerical equivalents for the Event Viewing Levels are shown in Table 8-1.

Default Trap Threshold settings, displayed in column 3 of Table 8-2, are explained
in “Events” on page 85. Make a list of the recommended Action numbers from
column 5 of Table 8-2. Where multiple action numbers are shown, more than one
action may be required to determine the problem. Look at the Table 8-3 and follow
the appropriate action.

Table 8-1: Event Viewing Levels

Number Level Explanation

0 Notice Events recorded in the Event Log but
not displayed by the Event Viewer

1 Warning Includes events that should always be
reported, such as device removals,
and changes to temperature or power
systems

2 Information Includes events that might result in
later problems
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Table 8-2: Service Reference Table

Event
Code

Viewing
Level

Default
Trap

Threshold
Description Action

Visual Observations

N.A. N.A. N.A. All LEDs are off 5

N.A. N.A. N.A. READY LED not blinking once
per second after power has
been on for one minute

3, 14

N.A. N.A. N.A. Temperature Warning LED on 4

N.A. N.A. N.A. Temperature Alarm LED on 4

N.A. N.A. N.A. ADIC Gateway not responding 3, 6, 14

N.A. N.A. N.A. Persistent reboots 3

N.A. N.A. N.A. Host application error
message or host log entry
indicates SCSI target error

12

N.A. N.A. N.A. Host cannot access attached
devices

12

N.A. N.A. N.A. SAN Connection LED off
although cables are attached
and host systems are on and
have booted

2

N.A. N.A. N.A. Heartbeat failure 7

N.A. N.A. N.A. fcShow command returns
Firmware State = Sync 
Lost

2,0

N.A. N.A. N.A. ADIC Management Console
failure

7

N.A. N.A. N.A. Service terminal connection
failure

8
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Generic Event Descriptions

8 2 0 Sense data recorded following
a check condition
NOTE: Normally, the host
system will request and
process send data and then
perform error recovery

0

9 1 0 LUN reports a “unit attention”
condition on a non-removable
media device

1, 2

11 1 1 ADIC Gateway reports a
temperature change (event
message indicates the change
to High, Very High, Reduced,
to High, or OK

4

13 1 1 ADIC Gateway is shutting
down as requested by the
ADIC Management Console
(a Restart was requested)

0

14 0 0 Additional status information
used for diagnostics

0

16 1 1 A SCSI bus reports an
unexpected interrupt

1

17 1 1 Fibre Channel interface
reports a LIP reset was
received from a host

0, 2

18 1 1 Fibre Channel interface
reports a system error

2

19 1 1 Fibre Channel interface
reports an error processing a
request

2

20 1 1 Fibre Channel interface
reports an error processing a
response

2

Table 8-2: Service Reference Table

Event
Code

Viewing
Level

Default
Trap

Threshold
Description Action
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21 1 1 ADIC Gateway processor
memory fault detected

6,3,2,1,

22 1 10 Fibre Channel interface
detected a LIP

2

23 2 0 Fibre Channel interface
reports a loop up

0

24 2 0 Fibre Channel interface
reports a loop down

0

25 1 1 ADIC Gateway PCI bus parity
error detected

6,3,2,1

26 1 1 ADIC Gateway PCI interface
error detected

6,3,2,1

27 2 0 A device has been added to a
SCSI bus

0

28 1 0 A SCSI bus reports a reset
has been detected

0

29 1 1 ADIC Gateway has added a
device to its configuration
table
NOTE: The trap is held off
until the ADIC Gateway has
been up for 60 seconds

0

30 1 1 ADIC Gateway has removed a
device from its configuration

0,1,2

31 2 0 ADIC Gateway logging service
has started

0

331 1 1 An interface has detected a
bus fault
(event message indicates the
specific interface)

1,2

Table 8-2: Service Reference Table

Event
Code

Viewing
Level

Default
Trap

Threshold
Description Action
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341 1 1 An interface has detected a
device fault
(event message indicates the
specific interface)

1, 2

35 1 1 A SCSI interface reported an
unexpected disconnect by a
device

1

36 1 1 A parity error was detected on
a SCSI bus

1

37 2 0 Fibre Channel Port Database
change detected

0

38 1 1 An error was detected on the
DDF memory board

6

39 1 1 Directory Server on Fabric has
changed

0

40 1 1 Maximum LUN limit has been
exceeded

10

41 1 0 Fibre Channel transfer failure
(NOTE: error recovery may
have succeeded)

0

42 1 1 Maximum device limit has
been exceeded (persistent
Address Map database is full)

11

43 1 1 Fibre Channel interface driver
reported debug file dump
(event log contains further
information)

13

58 1 1 Power has returned to
Nominal from Warning or
Alarm Stage

0

59 1 1 Power has entered Warning
Range from Nominal Range
(Power falling) or Alarm
Range (Power improving)

5

Table 8-2: Service Reference Table

Event
Code

Viewing
Level

Default
Trap

Threshold
Description Action
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60 1 1 Power has entered Alarm
Range

5

612 1 1 Inlet Air, Outlet Air, or I/O
Processor temperatures have
entered Nominal Range from
a Warning or Alarm Range

0

622 1 1 Inlet Air Temperature has
entered Warning Range from
Nominal Range (heating up)
or Alarm Range (cooling
down)

4

63 1 1 Inlet Air Temperature has
entered Alarm Range

4

642 1 1 Outlet Air Temperature or I/O
Processor Temperature has
entered Warning Range from
Nominal or Alarm Ranges

4

65 1 1 Outlet Air Temperature or I/O
Processor Temperature has
entered Alarm Range

4

66 1 1 Fan is operating in Nominal
Range after operating in a
fault state

0

67 1 1 Fan speed has entered
Warning Range (Tachometer
fans only)

4

68 1 1 Fan speed has entered Alarm
Range (Tachometer fans) or is
stalled (rotor stall fans)

4

69 2 1 ECC Memory Error 6

703 1 1 Firmware upload completed 0

713 1 1 ADIC Gateway restart
completed

0

Table 8-2: Service Reference Table

Event
Code

Viewing
Level

Default
Trap

Threshold
Description Action
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72 1 1 Maximum number of initiators
has been exceeded

0

150 1 1 The event log is about to
overwrite the earliest events

0

Health Check Event
Descriptions

100 1 1 Power supply is out of
specification

5

102 1 Temperature change detected
since the last report (event
message indicates the change
to High, Very High, Reduced
to High, or OK)

4, 0

106 1 1 Fibre Channel interface failed
Health Check

2

107 1 1 SCSI interface failed Health
Check

1

109 1 1 Target device failed Health
Check

1

110 1 1 Fibre Channel link status
changed

0,2

111 1 1 Fibre Channel transfer failures
detected since the last report
NOTE: error recovery may
have succeeded

0

112 1 1 Blower/Fan is running in
Warning or Alarm Range

4

113 1 1 Power is running in Warning
or Alarm Range

5

114 1 1 Temperature is running in
Warning or Alarm Range

4

Table 8-2: Service Reference Table

Event
Code

Viewing
Level

Default
Trap

Threshold
Description Action
Start MAP



Start MAP
115 1 1 Network is running at 10
Mbits/sec

7

Heartbeat Event
Descriptions

NOTE: These event codes are
not logged in the Event Log.
Notification of these events
occurs from the ADIC
Management Console

2003 N.A. N.A. The Server could not verify the
connection to the ADIC
Gateway

7,3

2013 N.A. N.A. The Client could not
communicate with the Server

7,9

2023,4 N.A. N.A. The Server could not
communicate with the Client

7,9

2033,5 N.A. N.A. Heartbeat communication
restored

0

1Check the Event Log to find out which interface (FCAL or SCSI) caused this
event. Then use the appropriate action number.
2 This trap signals a change in state. A string sent with the trap will indicate
the nature of the previous state.
3 Events not logged in ADIC Gateway Event Log.
4 Not Reported. View the Server Log.
5 Event reported only when ADIC Management Console 2.7 or higher is
running.

Table 8-3: Action Reference Table

Action
Number Action

0 No action necessary

1 Go to “SCSI MAP” on page 171

Table 8-2: Service Reference Table

Event
Code

Viewing
Level

Default
Trap

Threshold
Description Action
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Database Full MAP

These steps are performed if Event Code 42 is reported indicating the persistent
address map database is full (more than 255 devices are in the database).

If the database has no room for a newly detected device, the new device will not
be mapped (assigned a LUN). The database can become full if there are more
devices attached than there were previously or if devices were moved to different
ports or channels. You can free up database entries that are no longer needed,
but keep the devices that are currently attached at the same assigned LUNs.

Attention: Use this procedure only when you are sure that the
devices you are interested in are connected and available to the
ADIC Gateway. Devices that are not currently attached will be
removed from the database. You must reboot the ADIC Gateway
after performing this procedure for the changes to take effect.

2 Go to “Fibre Channel MAP” on page 178

3 Go to “ADIC Gateway MAP” on page 182

4 Go to “Temperature MAP” on page 184

5 Go to “Power MAP” on page 184

6 Go to “DDF Board MAP” on page 185

7 Go to “Ethernet MAP” on page 187

8 Go to “Service Port MAP” on page 191

9 Contact your network administrator

10 Reduce the number of target devices attached to the ADIC
Gateway

11 Go to “Database Full MAP” on page 168

12 Go to “Device Access MAP” on page 169

13 Go to “Retrieving the Code 43 Dump File” on page 297

14 Go to “Data Path Protection MAP” on page 192

Table 8-3: Action Reference Table

Action
Number Action
Database Full MAP
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1. Connect the service terminal to the Service Port (see “Connecting to the
Service Port” on page 217).

2. Press the Enter key on the service terminal. If the prompt is not displayed, go
to “Service Port MAP” on page 191 to determine whether the RS-232 cable
and service terminal are working properly.

3. From the service terminal, enter the mapShowDatabase command to display
the contents of the database (see ““Service Port Command Reference” on
page 223”).

4. From the service terminal, enter the mapShowDevs command to display LUN
assignments for the attached devices that have been mapped.

5. From the service terminal, enter the mapWinnowDatabase command to
remove LUN assignments for devices that no longer need to be kept.

6. Reboot the ADIC Gateway.

7. After the ADIC Gateway has finished booting, repeat steps 3 and 4 to verify
that all attached devices have been mapped.

Device Access MAP

These steps are performed if a host is not able to access SCSI or Fibre Channel
devices.

1. Connect the service terminal to the Service Port (see “Connecting to the
Service Port” on page 217).

2. Press the Enter key on the service terminal. If the prompt is not displayed, go
to “Service Port MAP” on page 191 to determine whether the RS-232 cable
and service terminal are working properly.

Check Fibre Channel Port Status

1. Enter the fcShow command from the service terminal (see “Service Port
Command Reference” on page 223). If the fcShow command does not
display a Firmware State of Ready for the attached Fibre Channel SAN
connections, go to “Fibre Channel MAP” on page 178.

2. The ADIC Gateway Fibre Channel ports are set by default to Target mode. If
the port mode for the host connection was changed to Initiator from the ADIC
Management Console, the host will not be able to see the SCSI devices.
Verify that the port mode was not inadvertently changed using the ADIC
Management Console Controls > Fibre Channel menu. See “Fibre Channel” on
page 108.
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3. If the host attached to a SAN connection is not able to access a Fibre Channel
device on another SAN connection, then go to “Check Fibre Channel Initiator
Port Mode” on page 170.

Check SCSI Channel Devices

1. Enter the scsiShow command from the service terminal. If all of the attached
SCSI devices are not displayed, go to “SCSI MAP” on page 171.

Check Channel Zoning Settings

1. Enter the fcShowDevs command from the service terminal. Look at the
display for each Fibre Channel interface. If all of the SCSI devices are
displayed under each Fibre Channel interface, then host access to SCSI
devices is not being restricted by Channel Zoning. Go to “Check Virtual
Private SAN Access Settings”.

2. If you want to modify Channel Zoning settings, you can use the ADIC
Management Console Controls > Access Options > Channel Zoning menu to
change the settings. See “Access Options: Channel Zoning” on page 98. The
ADIC Management Console allows every combination of Channel Zoning
settings.

Check Fibre Channel Initiator Port Mode

The port mode of the Fibre Channel that the target devices are attached to must
be set to Initiator or Target and Initiator mode. If the port mode is set to Target, the
ADIC Gateway will not see the target devices. Verify the port mode using the
ADIC Management Console Controls > Fibre Channel menu. See “Fibre Channel”
on page 108

Check Virtual Private SAN Access Settings

1. Enter the vpsShow -1 command from the service terminal (see See “Service
Port Command Reference” on page 223)

2. If “VPS Feature NOT Enabled” is displayed, then VPS is not controlling
access between the host and target devices. Exit this MAP.

3. If “VPS State: Active” is displayed, then VPS is controlling access between the
host and the target devices. Use the ADIC Management Console Controls >
Access Options > Virtual Private SAN menu to verify the host and target device
access settings. If the ADIC Management Console is not available, you can
temporarily make VPS inactive to verify that the host can access all devices
by proceeding to step 4.

4. Shut down all of the hosts.
Device Access MAP
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5. Enter the vpsInactiveSet command from the service terminal.

6. Startup one of the hosts.

7. If the host can access all of the target devices, shut down the host and repeat
steps 6 and 7 for each of the other hosts.

8. If each host can access all devices then there is a problem with the Virtual
Private SAN Access settings. Go to step 10.

9. If the host cannot access all of the target devices, then there is a problem with
the devices or their SAN connections. After you resolve the problem, proceed
to step 10.

10. Shut down all of the hosts.

11. Reactivate Virtual Private SAN by entering the vpsActiveSet command
from the service terminal.

12. Use the ADIC Management Console Controls > Access Options > Virtual Private
SAN menu to verify the host and target device access settings.

13. Restart the hosts and verify that each host can access the devices that have
been assigned by VPS.

SCSI MAP

These steps are performed if:

• Errors are reported on the SCSI bus
• SCSI I/O fails to operate
• Parity errors are detected on the SCSI bus
• SCSI device reports unit attention on non-removable device
• Unexpected SCSI bus reset occurs
• Unexpected SCSI disconnect reported by a SCSI device

Get ADIC Gateway SCSI Information

1. Connect the service terminal to the Service Port (see See “Connecting to the
Service Port” on page 217)

2. If the ADIC Gateway is off, then turn it on and wait until the ADIC Gateways
Ready LED is blinking once per second.

3. As the ADIC Gateway is booting, several status messages should be
displayed on the service terminal. If no status messages are displayed, go to
“Service Port MAP” on page 191 to determine whether the RS-232 cable and
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service terminal are working properly. Otherwise, look for the last status
message “Done executing startup script”.

4. Enter the showBox command from the service terminal (see See “Service
Port Command Reference” on page 223)

5. Write down the information for each SCSI channel (e.g., “SCSI -1 requires
Low Voltage Differential cable”).

6. If the SCSI interfaces are not all displayed, replace the ADIC Gateway. Go to
“Final Diagnostic Tests” on page 208.Fill it out and return it with your unit.

7. If they display properly, go to “Check Attached SCSI Devices from the Service
Port,” in the next section.

Check Attached SCSI Devices from the Service Port

Attention: The ADIC Gateway supports up to 256 LUNs. If more than
256 LUNs are attached this will result in unreliable behavior. Only
255 LUNs are available to the user, for the ADIC Gateway takes up
one LUN (0) as its Command and Control LUN.

1. Issue the scsiShow command from the service terminal to display a list of
attached SCSI devices (see “Service Port Command Reference” on
page 223).

2. For each SCSI channel, make a list of attached devices (SCSI device ID,
manufacturer, device status/flags). Go to “Compare List versus Physical
Devices” below.

Compare List versus Physical Devices

For each SCSI channel (starting with channel 1), perform the following:

1. Compare the list of attached devices with the physical devices. If all of the
physical devices were not shown, go to “Check SCSI Bus Termination” below.

2. Go to “Compare Listed versus Supported Devices.”

Compare Listed versus Supported Devices

1. Compare the attached SCSI devices to the list of supported devices found on
the Web site. Write down any devices that are not supported and report them
to the system administrator for possible replacement.

Note: If all other diagnostic procedures fail to isolate a SCSI problem, and
there are unsupported SCSI devices attached to the ADIC Gateway, those
devices will need to be removed or replaced.
SCSI MAP
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2. If the attached SCSI devices are all supported devices, go to “SCSI Loop Back
Test” on page 175.

Check SCSI Bus Termination

Attention: If in this procedure you determine that you need to remove
a SCSI cable or terminator, all I/O to the ADIC Gateway must be
stopped and the ADIC Gateway must be turned off.

For each SCSI device attached to the questionable SCSI channel:

1. Verify the termination.

The ADIC Gateway has internal terminators on its SCSI channels. The
terminators can be disabled from the ADIC Management Console. Use the
Controls > SCSI Channel menu to verify that termination has not inadvertently
been disabled.

2. The last physical device on a chain of SCSI devices needs to be terminated.

• If the end device has internal termination, make sure that is
enabled. Otherwise, check that an external terminator is
attached to the end device.

• A Differential (DE) terminator on a Single Ended (SE) bus or an
SE terminator on a DE bus will cause the bus to be unusable.
Verify the type of terminators for each SCSI channel.

3. Excessive termination: Check that all SCSI devices other than the end devices
have internal termination disabled.

4. If SCSI termination is OK, go to “Check for Multiple SCSI IDs” below.

5. If you corrected a SCSI termination problem, turn the ADIC Gateway back on.
After the ADIC Gateway finishes booting, enter the scsiShow command from
the service terminal. Compare the list of attached devices with the physical
devices. If not all of the physical devices are shown, go to “Check for Multiple
SCSI IDs” below. Otherwise, go to “SCSI Health Check” on page 175.

Check for Multiple SCSI IDs

Attention: If in this procedure you determine that you need to correct
any SCSI IDs, all I/O to the ADIC Gateway must be stopped and
the ADIC Gateway must be turned off.

If two or more devices on the same SCSI channel are configured at the same
SCSI ID, only one of those devices will be seen by the ADIC Gateway. Data
transfers to that device will be unreliable.

1. Write down the SCSI IDs of all devices connected to each SCSI channel.
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2. Check that only one device is set to each ID for each SCSI channel.

3. If a target device is set to the same ID as the ADIC Gateway (ID 7), the bus
will be unstable and data corruption may result.

4. Check that for each SCSI Channel, no devices are set to ID 7 (except the
ADIC Gateway channel ID).

5. If you do not need to correct any SCSI IDs, go to “Improper Device Type”.

6. Assign a new SCSI ID to the target device.

7. Reboot the ADIC Gateway. After it finishes booting, enter the scsiShow
command from the service terminal. Compare the list of attached devices with
the physical devices. If not all of the physical devices were shown, go to
“Improper Device Type”. Otherwise, go to “SCSI Health Check” on page 175.

Improper Device Type

Attention: Only high voltage differential-ended devices must be
attached to ADIC Gateway high voltage differential SCSI channels
and only low voltage differential devices must be attached to low
voltage differential SCSI channels.

Attention: If in this procedure you determine that you need to replace
a SCSI device, all I/O to the ADIC Gateway must be stopped and the
ADIC Gateway must be turned off.

1. When a mix of Ultra 2/3 SCSI and Ultra SCSI devices are connected to a
single bus, the bus will run at the Ultra SCSI speed. Because the bus will
auto-adjust to the slowest speed, it is not recommended that you run both
Ultra 2/3 SCSI and Ultra SCSI devices on the same bus.

2. If you do not have to replace an improper device, go to “Examine SCSI
Cables”.

3. Replace the improper SCSI device with a proper device. Reconnect the SCSI
cable.

4. Turn on the ADIC Gateway. After the ADIC Gateway finishes booting, enter
the scsiShow command from the service terminal. Compare the list of
attached devices with the physical devices. If not all of the physical devices
are shown, go to “Examine SCSI Cables”. Otherwise, go to “SCSI Health
Check” on page 175.

Examine SCSI Cables

Attention: If in this procedure you determine that you need to remove
a SCSI cable, all I/O to the ADIC Gateway must be stopped and
the ADIC Gateway must be turned off.
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1. Look for damaged cables. Check for breaks in the cable jacket, exposed or
frayed cable shield, exposed or broken wires. Replace any damaged cables.

2. Look for inadequate cables. Older SCSI cables may not be suitable for
running at Ultra2/3 speeds. Be sure all cables are rated for Ultra2/3. Replace
any that are not.

3. Check for mixed cable types. If a SCSI bus has both round cables and flat
ribbon cables, it may suffer problems when running at Ultra2/3 speeds. Use
the same cable type consistently for all segments of the SCSI bus. Replace
any cables that do not match.

4. Check for unshielded cables. An unshielded SCSI cable used external to a
cabinet may cause reliability problems, due to interference from other
electrical devices. Replace all unshielded cables.

5. Go to “Examine SCSI Connectors”.

Examine SCSI Connectors

Attention: Before removing a SCSI cable, all I/O to the ADIC Gateway
must be stopped and the ADIC Gateway must be turned off.

1. The pins in the SCSI connectors are somewhat fragile. Inspect each
connector to find pins that were bent when the connector was attached.
Replace any cables that have bent pins.

2. If you did not have to replace or re-secure a SCSI cable, go to “SCSI Loop
Back Test”.

3. If you replaced or re-secured a SCSI cable, turn on the ADIC Gateway. After it
finishes booting, enter the scsiShow command from the service terminal.
Compare the list of attached devices with the physical devices. If not all of the
physical devices are shown, go to “SCSI Loop Back Test”. Otherwise, go to
“SCSI Health Check”.

SCSI Health Check

1. Perform a Health Check and check the event log for SCSI errors (see
“Perform Health Check” on page 159 and “Check the Host Event Log” on
page 160).

2. If errors are still indicated, go to “SCSI Loop Back Test” below.

3. If no errors are reported, exit this MAP.

SCSI Loop Back Test

Attention: Before performing diagnostics, all FC and SCSI cables
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must be disconnected from the ADIC Gateway.

Before changing any SCSI cables, all I/O to the ADIC Gateway must be stopped
and the ADIC Gateway must be turned off.

Do not perform SCSI loop back tests on SCSI channels that are attached to SCSI
target devices. If you do this, you will corrupt the data on the device.

1. If the ADIC Gateway command prompt on the terminal is not diagmode >,
enter the diagBoot command on the service terminal (see “Diagnostic
Command Reference” on page 295).

2. Power the ADIC Gateway off.

3. In addition to the suspect SCSI channel, choose one of the other SCSI
channels to use for the loop back test.

4. Mark and remove attached cables.

5. Connect a short SCSI loopback test cable to the two SCSI channels. An
appropriate SCSI loopback cable is included in the CE Tool Kit.

6. Turn the ADIC Gateway on and wait for the ADIC Gateway to finish booting.

7. Enter the scsiChannelTest(1,2) command (see “Service Port Command
Reference” on page 223). The following example shows a loop back test on
SCSI channels 1 and 2.

diagmode > scsiChannelTest 1,2
SCSI-1 -> SCSI-2 [##########] 151 iterations
SCSI-2 -> SCSI-1 [##########] 151 iterations
PASSED
value = 0 = 0x0

8. If the ADIC Gateway returns a FAILED status, go to “Check DDF Interactions”
on page 178.

9. If the ADIC Gateway returns a PASSED status, go to “Testing SCSI Cables”.

Testing SCSI Cables

If the cables of the devices attached to a channel have a compatible pinout on
both sides, the ADIC Gateway can test the cable using the loop back test.

1. Stop all I/O to the ADIC Gateway.

2. Connect the terminal to the Service Port. See “Connecting to the Service Port”
on page 217.
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3. If the ADIC Gateway’s command prompt on the terminal is not diagmode >
place the ADIC Gateway in diagnostic mode (see “Diagnostic Command
Reference” on page 295).

4. Turn off the ADIC Gateway.

5. Draw a diagram of the devices and their connections to the SCSI channels.

6. Remove the cable from one attached SCSI device, and attach it as a loop
back cable to the ADIC Gateway.

7. Power on the ADIC Gateway.

8. When the ADIC Gateway finishes booting, enter the scsiChannelTest x, 
y command from the service terminal (where ‘x’ and ‘y’ are the slot numbers
connected by the loopback cable) to perform a loop back test.

9. If the ADIC Gateway returns a FAILED status, the cable is faulty and must be
replaced.

10. If the ADIC Gateway returns a PASSED status, go to “Isolating SCSI devices”
and try to isolate bad devices on the SCSI bus.

Isolating SCSI devices

1. Restore the ADIC Gateway to normal operation (see “Restoring Normal
Mode” on page 296).

2. Perform this step for each SCSI device that was found missing in “Compare
List versus Physical Devices” on page 172.

3. Turn off the ADIC Gateway.

4. Remove all devices from the SCSI buses.

5. Attach ONLY the device in question to the SCSI channel it was originally
connected to (refer to the list made in “Check for Multiple SCSI IDs” on
page 173) using a known-good SCSI cable and terminators.

6. Turn on the ADIC Gateway and wait for it to finish booting.

7. Enter the scsiShow command from the service terminal and verify the
device’s presence.

8. If the device is missing, then it needs to be replaced and/or serviced. Inform
the system administrator of any suspected bad devices found in this step.
Replace or remove any bad devices.

9. If the device is present, then perform a health check (see “Perform Health
Check” on page 159).
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10. Review the host event log (see “Check the Host Event Log” on page 160).

11. If SCSI errors are found, then inform the system administrator that the
connected device appears to be bad. Replace or remove any bad devices.

12. After all possible device checks are performed go to “Restore SCSI Setup”
below.

Check DDF Interactions

1. With the SAN Gateway on and booted, type the ddfTest command. The test
should return either a pass or fail status. If the DDF does not return a PASSED
status, replace it (go to “Removing and Installing the DDF Board” on
page 204).

2. If the DDF passed, replace the SAN Gateway base (go to “Prepare the New
Base Unit” on page 206.

Restore SCSI Setup

1. Turn off the ADIC Gateway.

2. Reconnect all available SCSI devices to their proper channel assignments
(either their original configuration, or with any changes made per this MAP).

3. Turn on the ADIC Gateway and wait for it to finish booting.

4. If the ADIC Gateway is in diagnostic mode (command prompt = diagmode 
>), then restore normal operation (see “Restoring Normal Mode” on
page 296).

5. Perform a health check (see “Perform Health Check” on page 159).

6. Review the host event log (see “Check the Host Event Log” on page 160).

7. If all attached SCSI devices and cables are determined to be good, yet SCSI
errors persist, then replace the ADIC Gateway. Go to “Final Diagnostic Tests”
on page 208. Fill it out and return it with your unit.

8. Exit this MAP.

Fibre Channel MAP

These steps are performed if

• The Fibre Channel interface reports a reset or system error
• The Fibre Channel interface reports an error processing a request
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or response
• The Fibre Channel interface reports an excess of 10 LIPs in a 10-

minute interval
• Other Fibre Channel errors reported
• FC connection LED is off

Verify Fibre Channel Connections

1. Connect the service terminal to the Service Port (see “Connecting to the
Service Port” on page 217).

2. Press the Enter key on the service terminal. If the prompt is not displayed, go
to “Service Port MAP” on page 191. To determine whether the RS-232 cable
and service terminal are working properly.

3. From the service terminal, enter the showBox command (see “Appendix B:
Service Port Command Reference”.

4. Confirm that the Fibre Channel connections are correctly displayed. If
showBox displays the PMC cards correctly, go to “Examine Cables” below.

5. If the Fibre Channel connections do not display correctly in the showBox
display, go to “Testing DDF with PMC Cards Removed” on page 187.

Examine Cables

Attention: If in this procedure, you need to remove or replace the
Fibre Channel cable, you must stop I/O at the Fibre Channel host.

1. Remove the cables.

2. If any cables are obviously damaged, replace them.

3. Use dusting spray/compressed gas to dust off optical connectors on the Fibre
Channel cards and cable ends.

4. Reconnect the cables.

5. Perform “Perform Health Check” on page 159.

6. If errors persist, go to “Check Optical Cable Type” on page 179.

Check Optical Cable Type

The optical cable diameter is important for long wave Fibre Channel optical
transceivers. Short wave PMCs will function with any cable diameter (though not
necessarily all lengths). The cable diameter is expressed as the ratio of the
diameter of its fiber core over the diameter of the protective cladding.
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1. Write down the core/cladding diameter printed on the cable jacket. Also write
what Fibre Channel port it was plugged into.

2. For each Fibre Channel that is listed as FCOLW, check the core/cladding
diameter on the jacket. Only cables with 9/125 diameter are acceptable.
Replace any 50/125 or 62.5/125 cables with the 9/125 rating, then retest (see
“Perform Health Check” on page 159).

3. If the problem is not resolved, go to “Fibre Channel Loop Back Test” below.

Fibre Channel Loop Back Test

Attention: Before performing diagnostics, the Fibre Channel cables
must be removed from the ADIC Gateway. All I/O to the ADIC Gate-
way must be stopped.

1. Attach the Fibre Channel loop back plug provided in the Service Tool Kit to the
Fibre Channel port.

2. If the front-panel FC Connection Status LED is not on, replace the ADIC
Gateway. Go to “Final Diagnostic Tests” on page 208. Fill it out and return it
with your unit.

3. If the ADIC Gateway command prompt on the service terminal is not
diagmode >, place the ADIC Gateway in diagnostic mode (see “Diagnostic
Command Reference” on page 295). Wait for the ADIC Gateway to finish
booting.

4. Substituting the Fibre Channel slot number for x, from the service terminal
enter the fcSlotTest x command (see Appendix C, “Diagnostic Command
Reference”). If the test failed, replace the ADIC Gateway. Go to “Final
Diagnostic Tests” on page 208. Fill it out and return it with your unit.

5. If the test passed, the Fibre Channel port is good. Remove the loop back plug
and reconnect the Fibre Channel cables.

6. Exit diagnostic mode and return the ADIC Gateway to normal mode (see
“Restoring Normal Mode” on page 296).

7. Inform the systems administrator that an external component of the Fibre
Channel subsystem appears to be bad. This may be the cables or the host
bus adapter.

8. If the optical cable is easy to remove, go to “Testing Fibre Channel Optical
Cable,” below, to test it.

9. Otherwise, go to “Replace Fibre Channel Cable” on page 181 and replace the
cable.
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Testing Fibre Channel Optical Cable

Note: If the Fibre Channel cable is extremely long, it may be more
practical to replace the Fibre Channel device first; then if the problem
is not resolved, replace the cable.

1. Turn the ADIC Gateway off. Mark and remove optical cables from both the
ADIC Gateway and their attachments.

2. Turn on the ADIC Gateway and wait for the ADIC Gateway to finish booting.

3. If the cable connectors are coupled together, then mark down their orientation
and remove the coupler.

4. Attach matching cable ends (red-to-red or ‘A’-to-’A’ and so on) to both slots of
the Fibre Channel port.

Replace Fibre Channel Cable

Note: If the Fibre Channel cable is extremely long it may be more
practical to replace the Fibre Channel device first; then if the problem
is not resolved, replace the cable.

1. If the ADIC Gateway is still on, turn it off.

2. Replace the cables to the Fibre Channel ports with known good cables.

3. Power up the ADIC Gateway and wait for it to finish booting.

4. Perform health check (see page 159) and view the event log at viewing level 3
(see page 160).

5. If problems persist, replace other external devices that are attached to the
Fibre Channel ports (go to “Replace Fibre Channel Device).

6. Otherwise, exit this MAP.

Replace Fibre Channel Device

The device that needs to be replaced is one of the following:

• Fibre Channel HBA
• Fibre Channel Switch
• Fibre Channel Hub
• Fibre Channel Disk subsystem

Inform the system administrator that it is necessary to replace the Fibre Channel
device connected to the ADIC Gateway to resolve the Fibre Channel errors.
Repeat this MAP after replacing an external component.
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ADIC Gateway MAP

These steps are performed if -

• You were directed here from the “Power MAP” on page 184
because all of the LEDs are off.

• You were directed here from the “Power MAP” on page 184
because the Power LED is on but the Ready LED is not blinking
once per second.

• The SAN Gateway detected a PCI bus error not isolated to
another subsystem

• The SAN Gateway continually reboots itself without operator inter-
vention

Observe Operational LED Behavior

When the ADIC Gateway is first powered on, the front-panel LEDs flash a variety
of patterns as it performs the Power On Self Test (POST) and then starts booting.
Within two minutes, the ADIC Gateway should have booted successfully and the
Ready LED should be blinking once per second. If the Ready LED is not blinking
as expected, go to “Start MAP” on page 157.

Isolating Startup Problems

It is possible for a damaged PMC card or DDF board to cause power supply
shutdown or prevent the ADIC Gateway from booting successfully. To check for
this condition, it is necessary to open the ADIC Gateway and remove all of its
PMC cards and DDF board.

OPEN THE SAN GATEWAY BY PERFORMING THE FOLLOWING:

1. Read “Handling Electro Static Discharge-Sensitive Parts” on page 197.

2. Go to “Preparing for Removal and Replacement” on page 198.

3. Go to “Removing the ADIC Gateway” on page 199.

4. Go to “Removing the Cover” on page 201.

5. Remove each PMC card. See “PCI Mezzanine Cards (PMCs)” on page 202.

6. Remove the DDF board. See “Removing and Installing the DDF Board” on
page 204.

7. Turn on the ADIC Gateway and observe the Power LED. If the Power LED is
off, replace the SAN Gateway Base. Go to “Prepare the New Base Unit” on
page 206.
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8. Wait at least one minute. Then check to see whether the Ready LED is
blinking. If the Ready LED is not blinking once per second, replace the ADIC
Gateway Base. Go to “Prepare the New Base Unit” on page 206.

9. Check the DDF board.

• Turn off the ADIC Gateway.
• Install the DDF board. See “Replacing the DDF Board” on

page 204.
• Turn on the ADIC Gateway
• If the Power LED is off, the DDF board is causing power supply

shutdown. The DDF board must be replaced with a new FRU. Go
to “DDF Board” on page 204.

• Wait at least one minute before checking to see whether the
Ready LED is blinking. If the Ready LED is not blinking once per
second, the DDF board is preventing successful boot-up and
must be replaced with a new FRU. Go to “DDF Board” on
page 204.

• Connect the service terminal to the Service Port. See “Connecting
to the Service Port” on page 217.

• Enter the diagBoot command on the service terminal. See “Boot
Modes” on page 295.

• As the ADIC Gateway is finished booting, several status mes-
sages should be displayed on the service terminal. If no status
messages are displayed, go to “Service Port MAP” on page 191
to determine whether the RS-232 cable and service terminal are
working properly. Otherwise, look for the last status message
done executing startup script. See “Startup Message
Reference” on page 315.

10. Check the PMC cards. For each card:

• Turn off the ADIC Gateway.
• Install a PMC card following the procedure used normally for

installing a new PMC card. See “Replacing the PMC” on
page 203.

• Turn on the ADIC Gateway.
• If the Power LED is off, the PMC card is causing power supply

shutdown. The PMC card must be replaced with a new FRU. Go
to “Replacing the PMC” on page 203.
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Temperature MAP

Perform these steps if:

• The ADIC Gateway reports a temperature warning or alarm.
• The Temp Warn or Temp Alarm LEDs are on.

Check Environmental Conditions

The ADIC Gateway is specified over an operational temperature of 10° C - 40° C
(50° F -104° F). If the immediate environment of the ADIC Gateway exceeds these
limits, then additional cooling or change of location is required.

If the ambient temperature is within specification, go to “Check for Airflow
Obstructions” below.

Check for Airflow Obstructions

There should be an airspace gap of at least one-inch on both sides of the ADIC
Gateway to ensure adequate airflow.

If obstructions are found, then remove them. Allow several minutes for the ADIC
Gateway to cool. If either the Warn or Alarm LED is still lit, then go to “Unresolved
Temperature Warning/Alarm” below.

Unresolved Temperature Warning/Alarm

If the Temp Warn or Alarm LEDs remain illuminated, then replace the ADIC
Gateway base (go to “Preparing for Removal and Replacement” on page 198).

Power MAP

Perform this MAP if:

• The ADIC Gateway is not operational.
• The ADIC Gateway will not respond to any method of manage-

ment or control.
• The SAN ADIC Gateway fails to perform any I/O.
• All LEDs are off.

Check Power Source

• Verify that the ADIC Gateway is plugged into an active AC power
Temperature MAP



DDF Board M
source.
• Verify the operation of other equipment connected to the same AC

power source.
• If the power source is good, then go to “Check Fuses.”
• Connect the ADIC Gateway into an active AC power source; turn

on the ADIC Gateway, verifying the status of the Power LED. If
the LED lights, obtain a new power source for the ADIC Gate-
way.

• If the Power LED remains off, go to “Check Fuses.”

Check Fuses

1. Turn off the ADIC Gateway and remove the power cord.

2. Remove the fuse holder from the power entry module and inspect the fuses.
See “Removing the Fuses” on page 205.

3. If the fuses are good, then return the fuses and fuse holder to the power entry
module (go to “Check Power Cord” below).

4. If the fuses are bad, obtain replacements and place them in the fuse holder.
Return the fuse holder to the power entry module. Plug the power cord into the
power entry module. Turn on the ADIC Gateway and observe the Power LED.

5. If the LED remains off, go to “Check Power Cord” below.

Check Power Cord

1. Try a different power cord and connect it to the ADIC Gateway’s power entry
module.

2. Turn on the ADIC Gateway and observe the Power LED. If the LED remains
off, go to “ADIC Gateway MAP” on page 182.

DDF Board MAP

This step is performed if:

• Unexplained errors on the SCSI channels.
• Unexplained errors on a PMC Interface.
• Unexplained ADIC Gateway PCI bus errors.
• Event Code 21 or 69 is reported

Basic Testing of the DDF Board

Attention: This test requires all I/O to be stopped.
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1. If Event Code 69 is repeatedly reported, replace the DDF Board.
See“Removing and Installing the DDF Board” on page 204. If there is a single
occurrence of Event Code 69, proceed with this MAP.

2. Connect the terminal to the Service Port (see “Connecting the Service
Terminal” on page 218).

3. If the ADIC Gateway’s command prompt on the service terminal is not
diagmode>, from the service terminal enter the diagBoot command (see
“Boot Modes” on page 295). Wait for the ADIC Gateway to finish booting.

4. From the service terminal, enter the ddfTest command (see “Diagnostic
Command Reference” on page 295).

5. The ADIC Gateway should respond with a message as shown below:

==== Testing DDF board ====

Bitwalk PCI-0
0 Passed 1 Passed 2 Passed 3 Passed

Bitwalk PCI-1
0 Passed 1 Passed 2 Passed 3 Passed

Access PCI-0
0 Passed 1 Passed 2 Passed 3 Passed 4 Passed 5 Passed 6 Passed

7 Passed
Access PCI-1
0 Passed 1 Passed 2 Passed 3 Passed 4 Passed 5 Passed 6 Passed

7 Passed
Burst PCI-0 Passed
Burst PCI-1 Passed
MemSize PCI-0 is 64 Mbytes
MemSize PCI-1 is 64 Mbytes
Burst Address PCI-0 ................Passed
Burst Address PCI-1 ................Passed
RP DMA PCI-0 Passed
RP DMA PCI-1 Passed
Data Sharing Passed

DDF Test PASSED
value = 0 = 0x0

6. If the test responds with “DDF Board PASSED” then leave this MAP.

7. To eliminate the possibility that other PMC cards are causing an interaction
problem with the DDF, go to “Testing DDF with PMC Cards Removed”.
DDF Board MAP
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Testing DDF with PMC Cards Removed

1. Open the ADIC Gateway by performing the following:

• “Handling Electro Static Discharge-Sensitive Parts” on page 197
• “Preparing for Removal and Replacement” on page 198
• “Removing the ADIC Gateway” on page 199
• “Removing the Cover” on page 201

2. Remove each PMC card. See “Removing the PMC” on page 202.

3. Turn on the ADIC Gateway.

4. Repeat the ddfTest command. If the DDF board still fails, then replace it (see
“DDF Board” on page 204).

5. If the DDF board passes, then there is a problem with one or more of the PMC
cards.

6. For each PMC card:

• Turn off the ADIC Gateway
• Install a PMC card following the procedure used normally for

installing a new PMC card (see “Replacing the PMC” on
page 203).

• Turn on the ADIC Gateway.
• Repeat the ddfTest command.

If the ddfTest fails, replace the PMC card.

Ethernet MAP

The network administrator must provide the following information before you can
perform this MAP:

• The IP address for the ADIC Gateway- REQUIRED
• The net mask for the ADIC Gateway in decimal and hex formats -

REQUIRED
• The network gateway IP address for the ADIC Gateway- if

assigned
• The IP address of a computer on the same subnet as the ADIC

Gateway for PING tests - REQUIRED
• The IP address of the host running the ADIC Management Con-

sole Server - REQUIRED
1. The ADIC Gateway must be booted and its Ethernet Port (See Figure 9-2)

must be attached to the local area network.
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2. Verify that the Ethernet Link LED, which is the green LED on the left, is on. If
the LED is on, go to step 3. If it is not on, go to “Final Diagnostic Tests” on
page 208 and return it with your unit. Exit this MAP.

3. Verify that the yellow Speed LED, which is the yellow LED on the right,
correctly reflects the speed of the network. To determine the speed of the
network, Go to “Perform Health Check” on page 159.

4. If the Health Check generates a Trap Event Code of 115, then the ADIC
Gateway yellow Speed LED should be on. If it is, go to Step 6. If it is not, go to
Step 5.

5. Inform the System Administrator that there may be a problem with the
Ethernet cable quality, the intermediate link speeds or interconnect speeds. If
no problems can be found and ADIC Gateway yellow Speed LED does not
come on, go to “Final Diagnostic Tests” on page 208 and return it with your
unit. Exit this MAP.

6. Remove the Ethernet cable from the ADIC Gateway Ethernet Port and attach
the Ethernet loop back plug provided in the Service Tool Kit.

7. Verify that the Ethernet LEDs are functioning correctly. If they are not, inform
the system administrator that there is a network hardware problem where the
ADIC Gateway is attached.

8. Remove the Ethernet loop back plug. Obtain another Ethernet cable. Use this
cable to attach the ADIC Gateway to the local area network.

9. Connect the service terminal to the Service Port (see “Connecting to the
Service Port” on page 217”).

10. Press the Enter key on the service terminal. If the prompt is not displayed, go
to “Service Port MAP” on page 191 to determine whether the RS-232 cable
and service terminal are working properly.
Ethernet MAP
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11. From the service terminal, enter the ifShow command (see “Service Port
Command Reference” on page 223).

Gateway > ifShow
lnPci (unit number 0):

Flags: (0x63) UP BROADCAST ARP RUNNING
Internet address: 192.168.1.56
Broadcast address: 192.168.1.255
Netmask 0xffffff00 Subnetmask 0xffffff00
Ethernet address is 00:60:45:0d:00:c1
Metric is 0
Maximum Transfer Unit size is 1500
2 packets received; 4 packets sent
0 input errors; 0 output errors
0 collisions

lo (unit number 0):
Flags: (0x69) UP LOOPBACK ARP RUNNING
Internet address: 127.0.0.1
Netmask 0xff000000 Subnetmask 0xff000000
Metric is 0
Maximum Transfer Unit size is 4096
4 packets received; 4 packets sent
0 input errors; 0 output errors
0 collisions

12. Write down the values of the internet address, netmask, and subnetmask.

13. Compare the internet address with the IP address supplied by the network
administrator. Compare the netmask value with the netmask in hex format
supplied by the network administrator. The subnetmask should be the same
as the netmask. If these values are correct, go to step 15.

14. Otherwise, use the ethAddrSet command to set the correct IP address and
netmask values (see the"ethAddrSet" command on page 236). From the
service terminal, enter the reboot command and wait for the ADIC Gateway
to finish booting. Go back to step 11.

15. Enter the command ping “<host IP address>”, 10 where <host IP 
address> is four decimal numbers separated by periods. This is the address
provided by the network administrator for PING testing.
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Display of successful PING test:

Gateway > ping “192.168.1.1”, 10
PING 192.168.1.1: 56 data bytes
64 bytes from 192.168.1.1: icmp_seq=0. time=0. ms
64 bytes from 192.168.1.1: icmp_seq=0. time=0. ms
64 bytes from 192.168.1.1: icmp_seq=0. time=0. ms
64 bytes from 192.168.1.1: icmp_seq=0. time=0. ms
64 bytes from 192.168.1.1: icmp_seq=0. time=0. ms
64 bytes from 192.168.1.1: icmp_seq=0. time=0. ms
64 bytes from 192.168.1.1: icmp_seq=0. time=0. ms
64 bytes from 192.168.1.1: icmp_seq=0. time=0. ms
64 bytes from 192.168.1.1: icmp_seq=0. time=0. ms
64 bytes from 192.168.1.1: icmp_seq=0. time=0. ms
----192.168.1.1 PING Statistics----
10 packets transmitted, 10 packets received, 0% packet loss
round-trip (ms) min/avg/max = 0/0/0
value = 0 = 0x0

Display of failed PING test:

Gateway > ping “192.168.1.251”,10
PING 192.168.1.251: 56 data bytes
no answer from 192.168.1.251
value = -1 = 0xfffffff

16. If the PING test passed, go to step 21.

17. If the PINGtest failed, remove the Ethernet cable from the ADIC Gateway and
install the Ethernet loop back plug. From the service terminal, enter the
diagBoot command. Wait for the ADIC Gateway to finish booting. Verify that the
diagmode> prompt is displayed.

18. From the service port, enter the elTest command.

Diagmode > elTest
==== Testing Ethernet ====
External loopback LANCE-0
Ethernet OK
value = 0 = 0x0

19. If the test failed, replace the ADIC Gateway. Go to “Final Diagnostic Tests” on
page 208.

20. If the test passed, remove the Ethernet loop back plug. From the service
terminal, enter the normalBoot command and wait for the ADIC Gateway to
finish booting. Reattach the Ethernet cable to the ADIC Gateway.

21. From the service terminal, enter the gateAddrGet command and write down
the network gateway address that is displayed. Compare this address to the
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one provided by the network administrator. If both addresses are the same, go
to step 25.

Gateway > gateAddrGet
Gateway Address set to 192.168.1.1
value = 0 = 0x0

22. If the network gateway address is incorrect, set it to the value provided by the
network administrator using the gateAddrSet command.

23. From the service terminal, enter the reboot command and wait until the
ADIC Gateway has finished booting.

24. From the service terminal, use the ping command to PING the IP address of
the host running the ADIC Management Console Server (see step 15).

25. From the host running the ADIC Management Console Server, PING the ADIC
Gateway.

26. If both PING tests succeeded, exit this MAP.

27. If the PING test fails, inform the network administrator to check and correct the
network connection, route tables, and network gateway addresses for both the
ADIC Management Console and the ADIC Gateway.

28. Go to step 24.

Service Port MAP

These steps are performed if the ADIC Gateway boots and responds to the ADIC
Management Console, but the Service Port does not respond.

Check the RS-232 Cable

This test requires another laptop or desktop computer with a functioning RS-232
9-pin port. Terminal emulation software must be installed and running.

1. Remove the RS-232 null-modem cable from the service port, and connect it to
the compatible port on the other computer.

2. Connect the service terminal to the cable.

3. Set the service terminal and the other computer to 19200 baud, 8 data bits, no
parity, one stop, XON-XOFF.

4. Enter test lines in the service terminal and the other computer. Confirm that
they are displayed on each other. If this fails, replace the RS-232 cable.
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5. If the cable is good, remove it from the other computer

6. Go to “Check Connection with Boot Messages” below.

Check Connection with Boot Messages

1. Reconnect the terminal to the ADIC Gateway with the RS-232 null modem
cable.

2. Stop all I/O to the ADIC Gateway.

3. Perform a graceful shutdown of the ADIC Gateway and keep the power off for
5 seconds. Then turn it back on.

4. If boot messages fail to appear on the service terminal, then replace the ADIC
Gateway. Go to “Final Diagnostic Tests” on page 208. Fill it out and return it
with your unit.

Data Path Protection MAP

These steps are performed if:

• READY LED is not blinking once per second after power has been
on for one minute

• ADIC Gateway not responding
• A message has appeared in the ADIC Gateway Event log, with

the following codes:
CLASS: CS_EVCLASS_SYSTEM_FAULT0x07
CODE: CS_EVCODE_IBF0x0A
ERROR NUM:DATA FLOW_FAULT0x1010

1. Turn off the ADIC Gateway.

2. Unplug the ethernet cable, as well as all FC and SCSI cables.

3. Connect the null modem cable (and the 9- to 25-pin adapter if applicable)
between the computer serial (COM) port and the ADIC Gateway Service Port.
See “Initial Setup of HyperTerminal” on page 219.

4. Turn on the ADIC Gateway and observe the boot messages. If a bus fault
resulted in abnormal behavior of the ADIC Gateway the boot should stop at a
user menu. The boot should stop with the attempt to load firmware.
Data Path Protection MAP
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5. Use the p command to display the contents of the bootline.

[VxWorks Boot]: p 
boot device : lnPci
processor number : 0
file name : ffs0:vxWorkst.Z
inet on ethernet (e) : 10.0.0.41:fffffc00
gateway inet (g) : 10.99.2.1
flags (f) : 0xc
target name (tn) : pl17003
startup script (s) : Bus_Fault_Detected
other (o) : lnPci

6. Note that the startup script reads Bus_Fault_Detected. If this is not
present go to See “ADIC Gateway MAP” on page 182.

7. Change the bootline to allow a diagnostic boot. Use the c command and then
press the Enter key until you reach the flags field. Change flags to 0. 
Continue to press the Enter key until you reach the startup script line.
Change the startup script parameters to ffs0:/mt/diagnstk.rc

[VxWorks Boot]: c

'.' = clear field; '-' = go to previous field; ^D = quit

boot device : lnPci
processor number : 0
host name :
file name : ffs0:vxWorkst.Z
inet on ethernet (e) : 10.0.0.41:fffffc00
inet on backplane (b):
host inet (h) :
gateway inet (g) : 10.99.2.1
user (u) :
ftp password (pw) (blank = use rsh):
flags (f) : 0
target name (tn) : pl17003
startup script (s) : ffs0:/mt/diagnstk.rc
other (o) : lnPci

Write complete

8. Enter the @ command to start diagnostics boot:

[VxWorks Boot]: @
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9. Wait for Gateway to finish booting.

:
:

diagInit
==============================

Diagnostics Version 2.04

==============================
value = 0 = 0x0

SRS Disabled, License is Invalid

Done executing startup script ffs0:/mt/diagnstk.rc
- Service Port Reflected Signal Test
Starting shell
Gateway >

10. Start the DDF test.

Diagmode> ddfTest

==== Testing DDF board ====

Bitwalk PCI-0
0 Passed 1 Passed 2 Passed 3 Passed

Bitwalk PCI-1
0 Passed 1 Passed 2 Passed 3 Passed

Access PCI-0
0 Passed 1 Passed 2 Passed 3 Passed 4 Passed 5 Passed 6 Passed

7 Passed
Access PCI-1
0 Passed 1 Passed 2 Passed 3 Passed 4 Passed 5 Passed 6 Passed
Data Path Protection MAP
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7 Passed
Burst PCI-0 Passed
Burst PCI-1 Passed
MemSize PCI-0 is 64 Mbytes
MemSize PCI-1 is 64 Mbytes
Burst Address PCI-0 ................Passed
Burst Address PCI-1 ................Passed
RP DMA PCI-0 Passed
RP DMA PCI-1 Passed
Data Sharing Passed
Page Xing PCI-0 ....Passed
Page Xing PCI-1 ....Passed

DDF Test PASSED
value = 0 = 0x0
Diagmode>

11. Change the bootline to restore the normal startup script. Use the
bootChange command. Then press the Enter key until you get to the
startup script line. At startup script enter ffs0:sna.rc Then
reboot the Gateway:

Diagmode> bootChange

'.' = clear field; '-' = go to previous field; ^D = quit

boot device : lnPci0
processor number : 0
host name :
file name : ffs0:vxWorkst.Z
inet on ethernet (e) : 10.0.0.41:fffffc00
inet on backplane (b):
host inet (h) :
gateway inet (g) : 10.99.2.1
user (u) :
ftp password (pw) (blank = use rsh):
flags (f) : 0x0
target name (tn) : pl17003
startup script (s) : ffs0:sna.rc
other (o) : lnPci

Write complete
value = 0 = 0x0
Gateway >
195
otection MAP



196
12. Reboot and wait for firmware to start.

Gateway > reboot

13. Manually invoke repeated data path tests. Use the repeat command to
iterate the ddfc command. In this example ddfc will be run 200 times. If an
error occurs then the Gateway will be rebooted and re-enter the
Bus_Fault_Detected state.

Gateway> repeat 200,ddfc
0 Bit errors
0 Bit errors
0 Bit errors
0 Bit errors
0 Bit errors

:
:
:

0 Bit errors
value = 0 = 0x0
Gateway >

14. If errors occur, visit “Service and Support” at www.adic.com, or call the ADIC
Technical Assistance Center at 1-800-827-3822.
Data Path Protection MAP



Removal and
Chapter 9: Removal and
Replacement Procedures
This section describes the ADIC Gateway removal and replacement procedures.

Handling ESD-Sensitive Parts

Attention: Always wear an electrostatic discharge (ESD) wrist strap
properly connected to the ESD ground bracket when you service this
machine.

How to Attach the ESD Wrist Strap

Before you touch any ESD-sensitive part, place the ESD wrist strap on either
wrist. This strap has a high resistance (>1 megohm) resistor in series with the
grounding clip so there is no danger to you. It discharges the static electricity from
your body.

Connect the clip on the flexible grounding cord to the ADIC Gateway. Keep the
strap on and connected while you touch, insert, or remove any ESD-sensitive part.

Figure 9-1: Placement of ESD Protection Strap

Attention: When you wear the ESD wrist strap, ensure the flexible
grounding cord remains connected to you and to the power entry
module.

Handling Electro Static Discharge-Sensitive Parts

Attention: It is highly recommended that you follow industry best
practice when handling Electro Static Discharge (ESD) Sensitive
197
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Parts.

• Keep the ESD-sensitive part in a static-protective bag until you
are ready to install the part into the machine.

• Make the fewest possible movements with your body to prevent
an increase of static electricity from clothing, fibers, carpets, and
furniture.

• If instructed to do so, switch off the machine power before you
remove ESD-sensitive parts.

• Just before touching the ESD-sensitive part, discharge to the
machine any static electricity in your body by touching the metal
frame or cover of the machine. If possible, keep one hand on the
frame when you install or remove an ESD-sensitive part.

• You may opt to wear an ESD wrist strap.
• Do not place any ESD-sensitive parts on the machine cover or on

a metal table because large metal objects can become discharge
paths if they are not grounded. If you must set aside an ESD-
sensitive part, first place it into the ESD static-protective bag.

• Prevent ESD-sensitive parts from being accidentally touched by
other personnel.

• If possible, keep all ESD-sensitive parts in a grounded metal
case.

• Be very careful when you work with ESD-sensitive parts in cold
weather. Low humidity and heating increase static electricity.

Preparing for Removal and Replacement

These steps are performed if

• A repair action is required and the ADIC Gateway must be pre-
pared for FRU removal and replacement.

• Diagnostics are going to be performed
Attention: Turn off attached host systems to ensure that all I/O

through the ADIC Gateway has stopped.

1. Verify that the latest SAN configuration has been saved. See “Save SAN
Gateway Configuration” on page 90.

2. Turn off the ADIC Gateway and disconnect the power cord.

3. For each cable attached to the ADIC Gateway, repeat the following:

• Remove the cable.
• Mark what the cable was connected to (for example, ADIC Gate-

way number 3, Ultra LVD SCSI Channel 1).
• If the final cable has been removed, then return to the MAP that
Preparing for Removal and Replacement
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sent you here.

Figure 9-2: Key to Back Panel

ADIC Gateway

Attention: Follow all ESD-sensitive parts procedures while performing
this procedure. For ESD information, see “Handling Electro Static
Discharge-Sensitive Parts” on page 197.

This procedure describes how to remove and replace the ADIC Gateway in a rack.
This procedure must be followed whenever an FRU is to be replaced.

Removing the ADIC Gateway

Perform the following to remove the ADIC Gateway from the rack cabinet. Refer to
Figure 9-3 below.

1. Remove the cable (see “Preparing for Removal and Replacement” on
page 198).

2. Remove the retaining screws from the rackmount ears (A).

3. Pull the ADIC Gateway out of the rack enclosure (B).

4. Remove the rackmount ear screws with an Allen wrench (C).
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5. Remove the rackmount ears (D)

Figure 9-3: Removing the Unit from a Rack Cabinet

Replacing the ADIC Gateway

1. If replacing a desktop ADIC Gateway, install the rubber feet on the new unit
(see “Desktop Configuration” on page 18). After installing the feet, go to step
7.

2. If replacing a rack-mount ADIC Gateway transfer the rack mount ears from the
original unit to the new unit.

3. Hold the rack mount ear over the mounting holes (D).

4. Install the rack mount ear screws and tighten with an Allen wrench (C).

5. Insert the ADIC Gateway into the space in the rack cabinet (B).

6. Install the retaining screws and washers to hold the ADIC Gateway into the
rack cabinet (A).

7. Reconnect the cables to their designated ports. See Figure 9-2 for cable loca-
tions.

Cover

Attention: Follow all ESD-sensitive parts procedures while perform-
ing this procedure. For ESD information. See “Handling ESD-Sensi-
ADIC Gateway
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tive Parts” on page 197.

This procedure describes how to remove and replace the cover. Refer to See
Figure 9-4 while performing this repair action.

Removing the Cover

1. Mark and remove the ADIC Gateway cables (see “Preparing for Removal and
Replacement” on page 198).

2. If the ADIC Gateway is not installed in a rack cabinet, go to step 3.

If the ADIC Gateway is installed in a rack cabinet, remove the ADIC Gateway
(see “Preparing for Removal and Replacement” on page 198).

3. Remove the four retaining screws located on the sides, next to the front panel
(A). Facing the back of the ADIC Gateway grasp the sides of the unit with both
hands. Thumbs should be on top of the box (B).

4. Push thumbs down and toward the box’s front to dislodge the cover (C).

5. Slide the cover all the way forward and lift off the chassis.

Figure 9-4: Removing the Cover

Replacing the Cover

1. Place the back corners of the lid onto the lip at the front of the ADIC Gateway
chassis.

2. Hook both corners of the cover onto the lip.

3. Push the cover back until it stops (C).
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4. Install the four retaining screws (A).

PCI Mezzanine Cards (PMCs)

Attention: Follow all ESD-sensitive parts procedures while perform-
ing this procedure. For ESD information, see See “Handling ESD-
Sensitive Parts” on page 197

This procedure describes how to remove and replace the Fibre Channel PMC
card. Refer to Figure 9-5 while performing this repair action.

Removing the PMC

1. Mark and remove the ADIC Gateway cables (see “Preparing for Removal and
Replacement” on page 198).

2. Remove the cover. See “Removing the Cover” on page 201.

3. If the PMC you are removing is an Ultra 2/3 SCSI PMC, go to Step 7.

4. Use compressed gas dust spray to blow the fiber optic cable connectors you
just removed.

5. Place dust caps on the fiber optic cable ends after cleaning.

6. Place dust caps on the Fibre Channel PMC card connectors.

7. Remove the two bulkhead screws holding the PMC to the back panel of the
chassis (A).

8. Remove the two retaining screws located on the PMC, towards the front panel
(B).

9. Lift up on the front panel edge of the PMC until the card is 45° from the moth-
erboard (C). See Figure 9-5 on page 203.
PCI Mezzanine Cards (PMCs)
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10. Pull the PMC out of the ADIC Gateway and place it in a static-protective bag
(D).

Figure 9-5: Removing PMC Option Card

Replacing the PMC

1. Hold the PMC at a 45° angle from the ADIC Gateway base, with the external
connector facing down.

2. Center the bezel in the PMC slot opening (D).

3. Lower the front end of the PMC. Line-up the mounting holes of the card with
the binding posts on the motherboard (C).

4. Push the PMC down onto the PMC connectors. It should fit snugly at the con-
nector.

5. Install the two retaining screws (B).

6. Install the two bulkhead screws (A).

7. Remove the dust caps from the new PMC.

8. If the PMC you are replacing is an Ultra 2/3 SCSI PMC, go to Step 10.

9. Use compressed gas dust spray to blow the PMC connector to ensure it is
dust free.

10. Replace the ADIC Gateway cover (see “Replacing the Cover” on page 201).

11. Go to “Final Diagnostic Tests” on page 208.
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DDF Board

Attention: Follow all ESD-sensitive parts procedures while perform-
ing this procedure. For ESD information, see “Handling ESD-Sensi-
tive Parts” on page 197.

This procedure describes how to remove and replace the DDF board. Refer to
See Figure 9-6 while performing this repair action.

Removing and Installing the DDF Board

1. If your ADIC Gateway is rack-mounted, mark and remove the ADIC Gateway
cables (see “Preparing for Removal and Replacement” on page 56).

2. Remove the cover. See “Removing the Cover” on page 201.

3. Remove the five retaining screws securing the DDF board to the motherboard
(A).

4. Lift up on the four corners of the DDF board to remove (B).

5. Place the DDF board in the static-protective bag.

Figure 9-6: Removing the DDF Board

Replacing the DDF Board

1. Observe the orientation of the DDF board in the diagram.

2. Hold the DDF board over the binding posts and line them up with the mount-
ing holes and motherboard connectors.

3. Press the DDF board down onto the motherboard connectors.
PCI Mezzanine Cards (PMCs)
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4. Install the five retaining screws securing the DDF board to the motherboard
(A).

5. Replace the cover (see See “Replacing the Cover” on page 201)

Go to See “Final Diagnostic Tests” on page 208

Fuse Removal

This procedure describes how to remove and replace the fuses. Refer to See
Figure 9-7 when performing this repair action.

Removing the Fuses

1. Turn off the ADIC Gateway if it is on.

2. Disconnect the power cord from the power source.

3. Locate the fuse holder on the back of the ADIC Gateway.

4. Pull the fuse holder out of the ADIC Gateway (B).

5. Remove the fuses from the ADIC Gateway (C).

Figure 9-7: Removing the Fuses

Replacing the Fuses

1. Place the new fuses (type F4AL) into the fuse holder (C).

2. Place the fuse holder into its receptacle and push firmly.
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3. Make sure the latch engages (B).

4. Connect the power cord to the power source.

5. Turn on the ADIC Gateway.

Base Unit

Attention: Follow all ESD-sensitive parts procedures while perform-
ing this procedure. For ESD information, see “Handling ESD-Sensi-
tive Parts” on page 197.

This procedure describes how to remove and replace the ADIC Gateway base.

1. Mark and remove the cables (see “Preparing for Removal and Replacement”
on page 198).

2. If rack mounted, see “Removing the ADIC Gateway” on page 199.

3. Remove the cover. See “Removing the Cover” on page 201.

Prepare the New Base Unit

Removing and Replacing the FRUs

Attention: Follow all ESD-sensitive parts procedures while performing
this procedure. For ESD information, see “Handling ESD-Sensitive
Parts” on page 197.

This procedure describes how to transfer the FRUs from the original ADIC
Gateway to the new ADIC Gateway base unit.

1. Set the new ADIC Gateway base next to the original ADIC Gateway.

2. Remove the cover. See “Removing the Cover” on page 201.

3. For each populated PMC slot, remove the PMC card from the original unit to
the new one (see “Removing the PMC” on page 202).

4. Transfer the bulkhead plates on the unoccupied PMC slots of the original unit
to the new ADIC Gateway base (see “Bulkhead Panel” on page 207).

5. Remove the DDF board (see page 204) and place into the new ADIC
Gateway base. Replace ADIC Gateway cover (see “Replacing the Cover” on
page 201).

6. Go to “Final Diagnostic Tests” on page 208.
Base Unit
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Bulkhead Panel

Attention: Follow all ESD-sensitive parts procedures while performing
this procedure. For ESD information, see “Handling ESD-Sensitive
Parts” on page 197.

This procedure describes how to remove and replace a bulkhead panel. The
bulkhead panel covers unused PMC slots. Refer to Figure 9-8 while performing
this procedure.

Removing a Bulkhead Panel

1. Remove the cover. See “Removing the Cover” on page 201.

2. Remove the retaining screws from the bulkhead panel (A).

3. Remove the bulkhead panel from the ADIC Gateway (B).

Figure 9-8: Removing a Bulkhead Panel

Replacing a Bulkhead Panel

1. Place the bulkhead panel in the ADIC Gateway so that it covers the hole in the
PMC slot (B).

2. Line up the screw holes on the bulkhead plate with the holes in the back
panel.
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3. Insert and tighten the retaining screws (A).

Final Diagnostic Tests

After a FRU has been replaced, a complete diagnostic check must be performed
to verify the new FRU and to ensure that no new problems have been introduced.

For further information about the procedures and commands used in this section,
see:

• “Connecting to the Service Port” on page 217
• “Diagnostic Command Reference” on page 295

Final Test Preparation

1. Attach the service terminal and power cord to the ADIC Gateway.

2. Turn on the ADIC Gateway and wait until it has finished booting.

3. From the Service Terminal, enter the diagBoot command.

4. Wait until the ADIC Gateway has finished booting into diagnostic mode.

5. From the Service Terminal, enter the showBox command.

6. Verify that the ADIC Gateway accurately displays the channel information

7. If the showBox display is accurate, go to step 9. If not, go to “Start MAP” on
page 157.

8. Proceed to “Fibre Channel Tests” below.

Fibre Channel Tests

TEST FIBRE PMC SLOT 1

1. If there is a dual-port PMC in Slot 1, got to Step 5.

2. Attach the Fibre Channel loop back plug to the card in slot 1.

3. From the service terminal, enter the fcSlotTest 1 command.

4. If the test passed, remove the loop back plug and go to Test Fibre PMC Slot 2.
If not, go to “Start MAP” on page 157.

5. Attach the Fibre Channel loop back plug to slot 1.

6. From the service terminal, enter the fcSlotTest 1 command.
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7. If the test passed, go to Step 8. If not, go to “Start MAP” on page 157.

8. Attach the Fibre Channel loop back plug to slot 4.

9. From the service terminal, enter the fcSlotTest 4 command.

10. If the test passed, remove the loop back plug and go to Test Fibre PMC Slot 2.
If not, go to “Start MAP” on page 157.

TEST FIBRE PMC SLOT 2

1. If there is a dual-port PMC in Slot 2, got to Step 5.

2. Attach the Fibre Channel loop back plug to the card in slot 2.

3. From the service terminal, enter the fcSlotTest 2 command.

4. If the test passed, remove the loop back plug and go to Test Fibre PMC Slot 3.
If not, go to “Start MAP” on page 157.

5. Attach the Fibre Channel loop back plug to slot 2.

6. From the service terminal, enter the fcSlotTest 2 command.

7. If the test passed, go to Step 8. If not, go to “Start MAP” on page 157.

8. Attach the Fibre Channel loop back plug to slot 5.

9. From the service terminal, enter the fcSlotTest 5 command.

10. If the test passed, remove the loop back plug and go to Test Fibre PMC Slot 3.
If not, go to “Start MAP” on page 157.

TEST FIBRE PMC SLOT 3

1. If there is a dual-port PMC in Slot 3, got to Step 5.

2. Attach the Fibre Channel loop back plug to the card in slot 3.

3. From the service terminal, enter the fcSlotTest 3 command.

4. If the test passed, remove the loop back plug and go to Ultra SCSI Tests. If
not, go to “Start MAP” on page 157.

5. Attach the Fibre Channel loop back plug to slot 3.

6. From the service terminal, enter the fcSlotTest 3 command.

7. If the test passed, go to Step 8. If not, go to “Start MAP” on page 157.

8. Attach the Fibre Channel loop back plug to slot 6.
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9. From the service terminal, enter the fcSlotTest 6 command.

10. If the test passed, remove the loop back plug and go to Ultra SCSI Tests. If
not, go to “Start MAP” on page 157.

Ultra 2/3 SCSI PMC Tests

TEST ULTRA 2/3 SCSI PMC SLOT 1

1. Attach the appropriate VHDCI cable to slot 1.

2. From the service terminal, enter the xscsiChannelTest 1 command.

3. If the test passed, go to step 4. If not, go to “Start MAP” on page 157.

4. Attach the appropriate VHDCI cable to slot 4.

5. From the service terminal, enter the xscsiChannelTest 4 command.

6. If the test passed, remove the loop back plug and go to Test Ultra 2/3 SCSI
PMC Slot 2. If not, go to “Start MAP” on page 157.

TEST ULTRA 2/3 SCSI PMC SLOT 2

1. Attach the appropriate VHDCI cable to slot 2.

2. From the service terminal, enter the xscsiChannelTest 2 command.

3. If the test passed, go to step 4.If not, go to “Start MAP” on page 157.

4. Attach the appropriate VHDCI cable to slot 5.

5. From the service terminal, enter the xscsiChannelTest 5 command.

6. If the test passed, remove the loop back plug and go to “Test Ultra 2/3 SCSI
PMC Slot 3”. If not, go to “Start MAP” on page 157.

TEST ULTRA 2/3 SCSI PMC SLOT 3

1. Attach the appropriate VHDCI cable to slot 3.

2. From the service terminal, enter the xscsiChannelTest 3 command.

3. If the test passed, go to step 4. If not, go to “Start MAP” on page 157.

4. Attach the appropriate VHDCI cable to slot 6.

5. From the service terminal, enter the xscsiChannelTest 6 command.

6. If the test passed, remove the loop back plug and go to “Ultra SCSI Tests”
below. If not, go to “Start MAP” on page 157.
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Ultra SCSI Tests

TEST SCSI PORT 1 AND 2

1. Attach the appropriate VHDCI loop back cable between slots 1 and 2.

2. From the service terminal, enter the scsiChannelTest 1,2 command.

3. If the test passed, remove the loop back cable and go to Ethernet Test. If not, go
to “Start MAP” on page 157.

TEST SCSI PORT 3 AND 4

1. Attach the appropriate VHDCI loop back cable between slots 3 and 4.

2. From the service terminal, enter the scsiChannelTest 3,4 command.

3. If the test passed, remove the loop back cable and go to Ethernet Test. If not,
go to “Start MAP” on page 157.

DDF Test

1. From the service terminal, enter the ddfTest command.

2. If the test passed, go to the next step. If not, go to “Start MAP” on page 157.

3. Proceed to Ethernet Test.

Ethernet Test

1. If you did not replace the ADIC Gateway base, go to step 3.

2. Obtain the ADIC Gateway’s Ethernet network parameters. Configure the
Ethernet Port Host Name, Address, Routes, Enable Ethernet (see “ADIC
Gateway Network Setup” on page 49).

3. Attach the Ethernet loop back plug to the Ethernet port.

4. From the service terminal, enter the elTest command.

5. If the test passed, go to the next step. If not, go to “Start MAP” on page 25.

6. Remove the Ethernet loop back plug.

7. Proceed to “Updating the ADIC Gateway” on page 212“Updating the ADIC
Gateway” on page 212
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Updating the ADIC Gateway

1. From the service terminal, enter the hardwareConfig command to update
the ADIC Gateway’s Vital Product Data (VPD).

2. From the service terminal, enter the normalBoot command.

3. Wait until the ADIC Gateway has finished booting.

4. From the service terminal, enter the version command. Write down the
firmware version number.

5. To determine whether the ADIC Gateway firmware version requires an
update, visit “Service and Support” at www.adic.com, or call the ADIC Techni-
cal Assistance Center at 1-800-827-3822. If an update is required, download
the new file or files and the associated readme. This firmware is used when
performing the steps in “Post-Repair Checklist” below.

6. If you replaced the ADIC Gateway, enter the ridTag command and type the
identifier. See “Service Port Command Reference” on page 223.

Attention: You must perform this step if you replaced the ADIC Gate-
way.

7. Power down the ADIC Gateway and unplug the power cord.

8. Disconnect the RS-232 cable from the ADIC Gateway.

9. Perform the “Post-Repair Checklist” below.

Post-Repair Checklist

It is important that the items in this checklist are verified after you have completed
a repair action. This ensures a successful reinstall of the product.

Table 9-1: Post-Repair Checklist

Step Actions Comments and References

1 Reinstall the ADIC
Gateway in its original
location.
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Post-Repair C
2 Ensure that the FC
hosts are turned off. if
not, disconnect the FC
cables now.

Although you were just instructed to
reconnect all cables, if you cannot turn off
the FC hosts you must disconnect the FC
hosts before turning on the ADIC Gateway.
This is a safety precaution that ensures that
FC hosts cannot perform any I/O to the
SCSI target devices prior to restoring the
ADIC Gateway configuration in step8,
below.

3 Attach the service
terminal to the ADIC
Gateway

None.

4 Turn on the ADIC
Gateway.

None.

5 Wait for the ADIC
Gateway to finish
booting.

Within one minute, the Ready LED should
start flashing once per second and the
“Done executing startup script” message
should be displayed on the service terminal.
If not, go to “Start MAP” on page 157.

6 From the service
terminal, enter the
targets command.

See ““Service Port Command Reference” on
page 223.” If all attached SCSI devices are
not shown, go to “Start MAP” on page 157.

7 If you replaced the
ADIC Gateway,
configure the network
parameters

Obtain the network parameters. See “ADIC
Gateway Network Setup” on page 49.

Table 9-1: Post-Repair Checklist

Step Actions Comments and References
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8 Perform the following:
1. Start the ADIC

Management
Console server
and client, logon
with administrator
privileges and
connect to the
ADIC Gateway

2. If you downloaded
new firmware in
Step 5 of “Updating
the ADIC
Gateway” on
page 212, use the
Controls > Update
Firmware menu
item to update the
firmware now.

3. Use the Tools >
Load SAN Gateway
menu item to load
the persistent
address map into
the ADIC Gateway.

4. Use the Controls >
Restart SAN
Gateway menu item
to restart the ADIC
Gateway.

5. Use the Controls >
Disconnect SAN
Gateway menu
item.

This step must be performed if you replaced
the ADIC Gateway Base.

Table 9-1: Post-Repair Checklist

Step Actions Comments and References
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9 1. If you discon-
nected the FC
cables in Step 2
above, reconnect
them now.

2. Turn on (or reboot)
the FC hosts.

If SAN Connection Status LEDs for the
attached hosts are not on, check the FC
cables. You may have to change the polarity
of the FC cables. If the problem persists, go
to “Start MAP” on page 157.

10 1. From the service
terminal, enter the
fcShow command
to show the status
of each FC inter-
face that is
installed and con-
nected.

2. From the service
terminal, enter the
fcShowDevs
command to show
the SCSI target
devices that are
connected as seen
by the Fibre
Channel interface.

In the output of the fcShow command, look
for the Firmware State column. If the word
Ready does not appear, go to “Fibre Channel
MAP” on page 178.
Check to see that all SCSI target devices
are seen by each FC interface. If not, go to
“SCSI MAP” on page 171.

11 Verify that all (or the
designated) target
devices are available
to the host systems.

Use appropriate host system utilities for disk
and tape.
If “Access Control” is enabled (Channel
Zoning, VPS, or VPM) the hosts will only see
the devices that have been assigned to
them.
If the designated devices are NOT available,
reboot the host and check again. If the
problem persists, go to “Start MAP” on
page 157.

Table 9-1: Post-Repair Checklist

Step Actions Comments and References
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12 Disconnect the RS-232
cable from the ADIC
Gateway and from the
service terminal. return
it, the SCSI loop back
cable, FC loop back
plug, and Ethernet
loop back plug to the
Service Tool Kit.

None.

13 End of repair.

Table 9-1: Post-Repair Checklist

Step Actions Comments and References
Post-Repair Checklist
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Appendix A: Connecting to the
Service Port
The service port is an RS-232C Data Terminal Equipment (DTE) port, configured
at 19200 Baud, with 8 data bits, no parity and hardware flow control. The 9-pin
connector is compatible with serial ports on PCs. A PC may be used to connect to
the service port, using a 9-pin to 9-pin null modem cable. For connection to
another system, such as a UNIX workstation, a different cable or an adapter may
be required.

Service Port Connections

The figure shows the service port connections:

Figure A-1: Service Port Pinout

Connections are listed in the following table.

Table A-1: DB-9 RS-232 Connector Pin Assignments

Pin
Number

Signal Name Abbreviation
Direction relative to

ADIC Gateway

1 Carrier Detect CD In

2 Receive Data RD In

3 Transmit Data TD Out

4 Data Terminal
Ready

DTR Out

5 Signal Ground SG -

6 Data Set Ready DSR In

7 Request to Send RTS Out

8 Clear to Send CTS In
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Table 2 lists the null modem cable connections.

Connecting the Service Terminal

HARDWARE REQUIRED

• RS-232 DB9F null model cable
• RS-232 DTE Terminal or desktop/laptop computer running

terminal emulation software
• RS-232 DB9M-to-DB25F adapter if the terminal uses a DB25M

connector

9 Ring Indicator RI In

Table A-2: Null Modem Cable Connections

Service
Port Pin
Number

Signal Name
9-pin AT

connector
25-pin (DB25)

connector (DTE)

1 Carrier detect (not used) n/c n/c

2 Receive data <->
Transmit data

3 2

3 Transmit data <->
Receive data

2 3

4 Data terminal ready <->
Data set ready

6 6

5 Signal ground 5 7

6 Data set ready <->
Data terminal ready

4 20

7 Request to send <->
Clear to send

8 5

8 Clear to send <->
Request to send

7 4

9 Ring indicator (not used) n/c n/c

Table A-1: DB-9 RS-232 Connector Pin Assignments
Connecting the Service Terminal
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Initial Setup of HyperTerminal

This section shows the steps to setup using the HyperTerminal program. Other
terminal emulation programs operate in a similar fashion.

1. Connect the null modem cable (and the 9- to 25-pin adapter if applicable)
between the computer serial (COM) port and the ADIC Gateway Service Port.

2. Turn on the service terminal.

3. On the service terminal, select the HyperTerminal icon and double-click on it.

4. In the New Connection dialog enter ADIC Gateway for the name and click OK.

5. In the Connect To dialog, for the Connect using field select the COM Port
number that you have chosen and click OK.

6. In the COM Properties dialog select the following:

Bits per second:19200
Data bits:8
Parity:None
Stop bits:1
Flow Control:Xon/Xoff

7. Click OK.

Verifying the Connection

If the ADIC Gateway is already on, then characters typed in the terminal should be
visible to the operator. The simplest test is to press the Enter key. The ADIC
Gateway will respond by displaying a command prompt like:

Gateway >

When the ADIC Gateway is rebooting, several messages are displayed on the
service terminal. A successful boot is indicated by the last message: “Done
executing startup script”.

Updating Firmware and Configurations

Although the ADIC Management Console is the simplest and most efficient tool for
updating firmware and saving/loading configurations, you can use the service
terminal as an alternate method to perform these operations.

The ADIC Gateway service port supports Zmodem file transfers. The procedures
below are specific for using the HyperTerminal program on the service terminal to
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transfer files. Other terminal emulation programs operate in a similar fashion. The
Zmodem send and receive functions in some terminal emulation programs
automatically issue the command string “rz” before sending a file and the
command string “sz” before receiving a file. However, even if the program you are
using automatically sends the “rz” command, manually issuing the command
string “rz” before starting the transfer has no negative effect on the transfer.

Updating Firmware

1. From the Hyper Terminal window, at the Gateway > command prompt, type
rz and then press the Enter key.

2. From the HyperTerminal window select Transfer and Send File.

3. From the Send File dialog enter the path and filename where the firmware file
is located or click the Browse button and navigate to it. In the Protocol field,
select Zmodem and click the Send button.

4. It will take several minutes for the file to be transferred. The Zmodem file send
dialog will display the current status and it will close automatically when the
file transfer has completed.

5. Wait for the “Firmware Update Complete” status message to be displayed on
the service terminal indicating successful completion. You must reboot the
ADIC Gateway for the update to take effect.

If HyperTerminal reports an error, try to send the file again. If the ADIC Gateway
reports an error, make a note of the error code and see the “Zmodem Status Code
Table“ on page 221 for further information.

Saving a Configuration File

1. From the HyperTerminal window enter sz “config.cfg” <Enter>. The
filename “config.cfg” is shown here as an example. You can specify a
different filename but it must be in quotes, 8 characters or less and end in .cfg.

2. From the HyperTerminal window select Transfer and Receive File.

3. From the Receive File dialog enter the path to the folder where you want to
save the file or click the Browse button and navigate to it. For the Receiving
protocol select Zmodem and press the Receive button.

4. Wait for the “Configuration Download Complete” status message to be dis-
played on the service terminal indicating successful completion.

If HyperTerminal reports an error, try to receive the file again. If the ADIC Gateway
reports an error, make a note of the error code and see the “Zmodem Status Code
Table“ for further information.
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Loading a Configuration File

1. From the Hyper Terminal window, at the Gateway > command prompt, type
rz and then press the Enter key.

2. From the HyperTerminal window select Transfer and Send File.

3. From the Send File dialog enter the path and file name where the firmware file
is located or click the Browse button and navigate to it. In the Protocol field,
select Zmodem and click the Send button.

If HyperTerminal reports an error, try to send the file again. If the ADIC Gateway
reports an error, make a note of the error code and see the “Zmodem Status Code
Table“ for further information.

Zmodem Status Code Table

The following table shows Zmodem status codes reported by the ADIC Gateway:

Table A-3: Zmodem Status Codes

Status
Code

Description

0 OK

-1 Error unwrapping file -bad file, or out of space

-2 Error opening file

-3 Error writing file

-4 Error closing file

-5 Service Port Function Only

-6 Can’t create Debug file - only applicable under lab conditions

-7 Cancelled by host

-8 “Command” not supported

-9 Memory Buffer allocation failed - problem with ADIC Gateway
memory allocation

-10 No file to send

-11 Garbage - degraded link

-12 CRC Error - degraded link

-13 Timeout Error
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-14 File size error - file size is different than it was supposed to be

-15 Invalid file type

-16 Too many retries - degraded link

-17 Position Error - file data has been lost

Table A-3: Zmodem Status Codes

Status
Code

Description
Zmodem Status Code Table
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Appendix B: Service Port
Command Reference
A “shell” interface provides access to management and configuration commands.
The shell is accessible by connecting a terminal or computer with terminal
emulation software to the ADIC Gateway’s Service Port.

The ADIC Management Console application should be used for managing the
ADIC Gateway. When you use the ADIC Management Console, most of the
operations described in this reference will be carried out through the client
application.

The following table is a list of the commands grouped by function.

Table B-1: Commands Grouped By Function

Group Description Page

Command and Control

disableCC Disable Command and Control
Interface

235

enableCC Enable Command and Control
Interface

236

setSnaCCLun Change Command and Control
Interface LUN

271

Data Mover

sncFeatureEnable Enable the optional Data Mover
feature

274

Diagnostics

Diagnostic commands are
discussed in the section
“Diagnostic Command Reference”
on page 295

Ethernet Network

arptabShow Display a list of known ARP
entries

232

ethAddrSet Set Ethernet Port address 236

gateAddrGet Display network gateway address 243
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Group Description Page

gateAddrSet Set network gateway address 243

host “add” Add host table entries 247

host “delete” Delete network host table entries 248

host “list” List network host table entries 248

hostNameSet Change ADIC Gateway’s network
name

249

icmpstatShow Display statistics for ICMP 250

ifShow Display Ethernet Port parameters
and status

250

inetstatShow Display all Internet protocol
sockets

251

ipstatShow Display statistics for IP 251

macShow Display Ethernet Port Media
Access Control address

254

mbufShow Display mbuf statistics 258

route Edit route table entries 261

route “add” Add network route table entries 262

route “delete” Delete network route table entries 262

route “list” List network route table entries 262

snmpCommunitiesShow Display list of Community names
currently in use

274

snmpReadCommunityAdd Add Community name with Read
permission

275

snmpReadCommunityRemove Remove Community name Read
permission

276

snmpTrapCommunitySet Set Community name passed with
traps

276

snmpWriteCommunityAdd Add Community name with Write
permission

276

Table B-1: Commands Grouped By Function
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snmpWriteCo
Group Description Page

snmpWriteCommunityRemove Remove Community name Write
permission

276

tcpstatShow Display statistics for TCP 279

trapDestAdd Add recipient IP address to trap
destination table

280

trapDestRemove Remove recipient IP address from
trap destination table

280

trapDestShow Display trap destination table 281

udpstatShow Display statistics for UDP 281

userAdd Add a user and password to the
password file

282

userDelete Delete a user from the password
file

282

userList Display the contents of the
password file

283

Event Logging

cleShow Display Command Log events for
the specified LUN

233

cleShowAll Display Command Log events for
all LUNs

233

loggerDump Display Event Log records 252

loggerDumpCurrent Display Event Log records for
current boot

253

supportDump Display information used in
troubleshooting

305

Fibre Channel

fcConnTypeGet Display the current setting of a
Fibre Channel port’s connection
type

236

fcConnTypeSet Set the type of connection for a
Fibre Channel port

237

Table B-1: Commands Grouped By Function
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Group Description Page

fcPortModeGet Display the mode for the specified
Fibre Channel port

238

fcPortModeSet Set the mode for the specified
Fibre Channel port

238

fcRestart Restart the specified Fibre
Channel port

239

fcShow Display Fibre Channel interface
status

240

fcShowDevs Display attached SCSI and Fibre
Channel Target Devices from
Fibre Channel port perspective

241

fcShowNames Display Node and Port names for
Fibre Channels

242

setFcFrameSize Set Frame Size for specific Fibre
Channel port

269

setFcHardId Set Loop ID for specific Fibre
Channel port

270

setHost Set Host OS type for specific
Fibre Channel port

270

targets Display attached SCSI and Fibre
Channel Target devices

279

Flash File System

cd Set current working path 232

ll List directory contents in long
format

253

ls List directory contents 253

rm Remove (delete) a file 261

rz Initiate a receive Zmodem file
transfer session

262

sz Initiate a send Zmodem file
transfer session

278

Table B-1: Commands Grouped By Function
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hlthChkInterv
Group Description Page

Health Check

hlthChkIntervalGet Display Health Check Interval 246

hlthChkIntervalSet Set Health Check Interval 246

hlthChkLevelGet Display Health Check Level 246

hlthChkLevelSet Set Health Check Level 246

hlthChkNow Perform a Health Check Now 247

Help

clehelp Display Command Log Entry
command info

233

diagHelp Display Diagnostic command info 234

help Display info for all shell
commands

244

hlthChkhelp Display Health Check command
info

245

mapHelp Display Device Map command
info

255

netHelp Display Network command info 259

snmpHelp Display SNMP command info 275

userHelp Display User account command
info

283

Product Data
and Maintenance

clearReservation Force-clear a reservation on the
specified target LUN

232

dataScrubberDisable Disable the Data Scrubber 233

dataScrubberEnable Enable the Data Scrubber 234

hardwareConfig Re-inventory FRUs and update
Vital Product Data (must be in
diagnostic mode)

243

Table B-1: Commands Grouped By Function
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Group Description Page

initializeBox Restore factory defaults by
deleting all configuration files
including persistent address map
and VPS databases and then
reboot

251

licenseShow Display information about
installed software license keys

252

mapCompressDatabase Remove inactive device entries
and reassign LUNS contiguously
in persistent address map
database

254

mapRebuildDatabase Delete and reconstruct persistent
address map database

255

mapShowDatabase Display all persistent address
map database entries

256

mapShowDevs Display persistent address map
database entries for attached
devices only

257

mapWinnowDatabase Remove inactive device entries
from persistent address map
database

258

shellLock Lock or unlock the shell command
interface

272

showBox Display graphic of hardware 273

sysConfigShow Display configuration settings 276

sysVpdShow Display Vital Product Data 277

sysVpdShowAll Display Vital Product Data for all
subsystems

277

ridTag Display and set serial number of
replaced Base

260

version Display Firmware version 283

uptime Display time elapsed since last
boot

282

Table B-1: Commands Grouped By Function
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vpsAccessAp
Group Description Page

SAN Access Security

vpsAccessApply Apply access settings and save in
Virtual Private SAN database

284

vpsAccessClear Disable Virtual Private SAN
access to all LUNs for all hosts

284

vpsAccessSet Set Virtual Private SAN access
permission for a specific host and
a specific LUN range

284

vpsActiveSet Reactivate Virtual Private SAN if
inactive

285

vpsConnectionSet Enter connection information for a
specific host

285

vpsFeatureEnable Enable Virtual Private SAN with
license key

285

vpsHostShow Display LUN access permissions
for a specific host

286

vpsInactiveSet Deactivate Virtual Private SAN
access control allowing all hosts
to access all LUNs

287

vpsNameSet Enter a name for a specific host 287

vpsShow Display status information for one
or all registered hosts

287

vpsSparseAccessSet Set access permission for a
specific host and specific LUNs

288

vpsTypeSet Enter Operating System
information for a specific host

289

SCSI

fcShowDevs Display SCSI and Fibre Channel
Target Devices from Fibre
Channel port perspective

241

scsiAltIdGet Display SCSI Alternate IDs 263

scsiAltIdSet Change SCSI Alternate IDs 264

Table B-1: Commands Grouped By Function
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Group Description Page

scsiHostChanGet Display SCSI Host Channel
Modes

264

scsiHostChanSet Set SCSI Host Channel Modes 264

scsiHostIdGet Display SCSI Host ID numbers 265

scsiHostIdSet Set SCSI Host ID numbers 266

scsiRescan Rescan for devices on one or all
SCSI Channels

266

scsiResetDisableGet Display SCSI Bus Reset on
Power-Up Setting

267

scsiResetDisableSet Set the SCSI Bus Reset on
Power-Up Setting

267

scsiShow Display SCSI Channels and
attached devices

268

scsiTermGet Display termination status
information for SCSI Channels

269

scsiTermSet Set termination status for the
selected channel

269

targets Display attached SCSI and Fibre
Channel Target devices

279

xscsiAltIdGet Display SCSI Alternate IDs for
Ultra 2/3 SCSI Channels

289

xscsiAltIdSet Change SCSI Alternate IDs for
Ultra 2/3 SCSI Channels

289

xscsiHostChanGet Display SCSI Host Channel
Modes for Ultra 2/3 SCSI
Channels

290

xscsiHostChanSet Set SCSI Host Channel Modes for
Ultra 2/3 SCSI Channels

290

xscsiHostIdGet Display SCSI Host ID Numbers
for Ultra 2/3 SCSI Channels

290

xscsiHostIdSet Set SCSI Host ID Numbers for
Ultra 2/3 SCSI Channels

291
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xscsiRescan
Group Description Page

xscsiRescan Rescan for devices on one or all
Ultra 2/3 SCSI Channels

291

xscsiResetDisableGet Display SCSI Bus Reset on
Power Up Settings for Ultra 2/3
SCSI Channels

292

xscsiResetDisableSet Set the SCSI Bus Reset on Power
Up Settings for Ultra 2/3 SCSI
Channels

292

xscsiTermGet Display termination status for
Ultra 2/3 SCSI Channels

292

xscsiTermSet Set termination status for Ultra 2/3
SCSI Channels

293

Startup

diagBoot Shutdown and restart in
Diagnostic mode

234

normalBoot Shutdown and restart in Normal
mode

260

reset Restart without shutdown 260

reboot Shutdown and restart 260

Virtual Private Map

copyScsiAssign Copy SCSI assignments from a
source channel to a destination
channel

233

deleteScsiAssign Delete an assignment previously
created

234

setScsiAssign Assign a target device to a SCSI
channel

271

showScsiAssign List the current assigned
addresses for the indicated
channel

274

vpmFeatureEnable Enable the optional Virtual Private
Map feature

283

Table B-1: Commands Grouped By Function
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Commands

This section describes the commands that are available to control, manage, and
service the ADIC Gateway. The commands are listed in alphabetical order for
easier reference.

Each command displays a status “value” in decimal and hexadecimal after
execution and before a new prompt is displayed. Usually a value of 0 indicates
success, but some commands may return a different value.

arptabShow

The arptabShow command displays the contents of the ARP table. The ARP
table contains the current Internet-to-Ethernet address mappings. This
information may be useful to the LAN administrator.

Gateway > arptabShow
192.168.1.19 at 8:0:20:23:2f:db
value = 0 = 0x0
Gateway >

cd

You can move to a different directory (usually in the flash file system) using the cd
command.

Gateway > cd "MGMT"
value = 0 = 0x0
Gateway >

clearReservation [devId]

The clearReservation command can be used to force-clear a reservation
held by a host for the specified target device. It may be necessary to issue this
command if a host that has a reservation for a shared device was disconnected
from the ADIC Gateway without properly shutting down the application software
that issued the reservation. If this is the case, other hosts that attempt to access
the shared device will repeatedly receive reservation conflict status from the
device. Issuing this command may result in resetting the target device.

Gateway > clearReservation 4
value = 0 = 0x0
Gateway >

Parameter Value

devId The index of the device (LUN)
arptabShow



cleHelp
The above example shows the clearReservation command being used to
clear a reservation on a target device at LUN 4.

cleHelp

The cleHelp command displays a list of the Command Log Event facility
commands.

Gateway > cleHelp
CLE - Command Log Event facility
cleShow <lun> - Displays Logged Events for a specific LUN
cleShowAll - Displays Logged Events for All LUNs
value = 0 = 0x0
Gateway >

cleShow <LUN>

The cleShow command displays the last 64 Command Log events for a device at
the specified LUN. This log is not maintained for disk devices because the
performance impact is significant. The manufacturer may request the contents of
the command log for diagnostic purposes. Information about interpreting these
events is not provided.

cleShowAll

The cleShowAll command performs a cleShow for all LUNs. The manufacturer
may request the contents of the command log for diagnostic purposes.
Information about interpreting these events is not provided.

copyScsiAssign [source channel], [dest channel] 

Copies the SCSI assignments from a source channel to a destination channel.

dataScrubberDisable

Issue this command to disable the Memory Scrubber, an independent low-priority
task that checks the full data buffer space, approximately once per hour.

Gateway > dataScrubberDisable
value = 0 = 0x0
Gateway >
233
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dataScrubberEnable

Issue this command to enable the Memory Scrubber, an independent low-priority
task that checks the full data buffer space, approximately once per hour.

Gateway > dataScrubberDisable
value = 1 = 0x1
Gateway >

deleteScsiAssign [dev ID],[channel], [id],[lun] 

Deletes an assignment previously created

diagBoot

This command is used only to transition the ADIC Gateway from normal operation
to the special diagnostic mode. The diagBoot command first ensures that the
ffs:mt directory exists. It verifies that the files diagnstk.o and diagnstk.rc are in the
flash file system. If they are in the root directory, it moves them to the ffs:mt
directory.

It copies the existing bootline to a file in the ffs:mt directory on the ADIC Gateway
and installs a new bootline directing the ADIC Gateway to boot using a special
diagnostic startup script ffs:mt/diagnstk.rc. It renames the persistent map file
config/device.map as config/device.bak (a new file will be generated after
rebooting).

Finally, diagBoot issues a reboot command to put the changes into effect

diagHelp

The diagHelp command displays a list of the diagnostic commands.

Gateway > diagHelp
** Diagnostic commands: Available in Diagnostic Mode Only **
ddfTest Test DDF Memory
elTest Test Ethernet port w/loop-back cable
fcSlotTest <portnum> Test specified Fibre Channel port w/loop-
back cable
hardwareConfig Re-inventory FRUs and update Vital Product
Data
normalBoot Shutdown and restart in normal mode
scsiChannelTest <x,y> Test specified SCSI Channels w/loop-back
dataScrubberEnable



disableCC [o
cable

See User’s Guide for more information
value = 0 = 0x0
Gateway >

disableCC [option number]

Disable the command and control interface (LUN 0) using the disableCC 
command. Specify one of two option parameters as follows.

The ADIC Gateway is addressable as a SCSI target device, for command and
control support. On a Fibre Channel Interface, this device will be seen as logical
unit number 0, (LUN 0). The LUN 0 device returns a device type of 0Ch in an
inquiry command, indicating it is a controller device. Controller devices are defined
in the SCSI-3 Controller Commands specification (SCC).

In some cases, it may be desirable to disable this feature. If LUN 0 is disabled,
then a device type of 2Ch will be returned in an inquiry to LUN 0, indicating that
the device is not presently available at this LUN. LUN 0 will remain reserved for
the Command and Control interface and will not be allocated to another target
device.

Other commands are available for re-enabling the Command and Control
interface or reassigning it to a different LUN rather than hiding or disabling it. See
the enableCC command and the setSnaCCLun command for further
information.

Note: If you enter the disableCC command without specifying an
option number, it has the same effect as disableCC 1

Gateway > disableCC
value = 0 = 0x0
Gateway >

Option
number

Value

1 Hides the Command and Control interface and results in
Inquiry data returning “device not available” for LUN 0.

2 Completely disables all Command and Control functions
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enableCC

To restore the capability to send commands to the command and control interface
(LUN 0), use the enableCC command. The command is typically used to re-
enable the interface after it was disabled by the disableCC command.

Gateway > enableCC
value = 0 = 0x0

ethAddrSet

The ethAddrSet command changes the IP address of the ADIC Gateway. An IP
address is specified as 4 decimal numbers separated by periods.

Gateway > ethAddrSet "192.168.1.54"
Host Address set to 192.168.1.54 for Ethernet interface
value = 0 = 0x0
Gateway >

If a netmask is required, specify it after the IP address in “dotted decimal” form.
For example:

Gateway > ethAddrSet "10.0.0.2","255.255.0.0"
Inet Mask set to ffff0000 for Ethernet interface
Write complete
Host Address set to 10.0.0.2 for Ethernet interface
value = 0 = 0x0
Gateway >

fcConnTypeGet [port]

The fcConnTypeGet command is used to display the current setting of a Fibre
Channel port’s connection type. See also the fcConnTypeSet command

Parameter Value Meaning

Port 1 - 6 The SAN Connection number
enableCC



fcConnTypeS
The following example shows how the connection type is displayed when Fibre
Channel port 1 is specified and its connection type is loop.

MyGateway > fcConnTypeGet 1
value = 0 = 0x0
MyGateway > fcConnTypeGet 2
value = 0 = 0x0
MyGateway > fcConnTypeGet 3
value = 0 = 0x0
MyGateway > fcConnTypeGet 4
value = 0 = 0x0
MyGateway > fcConnTypeGet 5
value = 0 = 0x0
MyGateway > fcConnTypeGet 6
value = 0 = 0x0
MyGateway >

The number displayed as a value indicates the connection type as follows:

fcConnTypeSet [port],[connection]

The fcConnTypeSet command is used to set the type of connection for a Fibre
Channel port. See also the fcConnTypeGet command.

The following example shows how to set Fibre Channel port 1 connection type to
point-to-point.

Gateway > fcConnTypeSet 1,1
value = 0 = 0x0
Gateway >

Value Connection Type

0 loop

1 point-to-point

2 loop preferred

Parameter Value Meaning

Port 1 - 6 The SAN Connection number

Connection 0 Loop

1 Point-to-Point

2 Loop Preferred
237
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Attention: You must issue the fcRestart command or reboot the
ADIC Gateway for the new setting to take affect. See the fcRestart
command for further information.

fcPortModeGet [port]

The fcPortModeGet command displays the mode for the specified Fibre
Channel port. The default port mode is Public Target. See also the
fcPortModeSet command.

After the command executes, the number displayed as a value indicates the port
mode as follows:

The following example shows how the connection type is displayed when Fibre
Channel port 1 is specified and the port mode is Private Target.

Gateway >fcPortModeGet 1
value = 1 = 0x1
Gateway >

fcPortModeSet [port],[mode]

The fcPortModeSet command sets the mode for the specified Fibre Channel
port. See also the fcPortModeGet command.

The default port mode is Public Target. This means that if attached to a Fabric
device the ADIC Gateway will register as a Target with the name server. If the
port mode is Private Target, the ADIC Gateway does not register with the name
server and the Fabric device will not recognize the ADIC Gateway as a Target.

Parameter Value Meaning

Port 1- 6 The SAN Connection number

Value Port Mode

1 Private Target

2 Private Initiator

3 Private Target and Initiator

17 Public Target

18 Public Initiator

19 Public Target and Initiator
fcPortModeGet [port]



fcRestart [po
The port must be in Initiator mode if you want the ADIC Gateway to scan for target
devices on the port. When the port is in Private Initiator mode, ADIC Gateway
only scans for devices on the local loop. If the port mode is in Public Initiator
mode, the ADIC Gateway also scans for devices attached to a Fabric.

Gateway > fcPortModeSet 1,2
value = 0 = 0x0
Gateway >

fcRestart [port]

The fcRestart command restarts the specified Fibre Channel port. You typically
use this command to restart the port after changing its configuration settings so
that the changes take affect. Issuing this command is an alternative to rebooting
the ADIC Gateway in order to make the configuration changes take affect.

Attention: This command interrupts traffic.

The following example shows the display when Fibre Channel port 1 is specified.

Gateway > fcRestart 1
value = 0 = 0x0
FCT Restart 1 :
Controller Restart Successful
Gateway >

Parameter Value Meaning

Port 1- 6 The SAN Connection number

Mode 1 Private Target

2 Private Initiator

3 Private Target and Initiator

17 Public Target

18 Public Initiator

19 Public Target and Initiator

Parameter Value Meaning

Port 1 - 6 The SAN Connection number
239
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fcShow [level]

The fcShow command displays the channel status for each Fibre Channel
interface.

------------------------------------------------------------
Fibre Channel Controllers

-----------------------------------------------------------
CtlrId:PCI Addr:ISP Type:Firmware State:Version:Loop ID:FabricAttached:

PortMode

------------------------------------------------------------
1 : 00 18 00 : 2300 : Ready : 2.01.7 : 1 : No : Targ
2 : 00 18 00 : 2300 : Ready : 2.01.7 : 1 : No : Targ
3 : 00 18 00 : 2300 : Ready : 2.01.7 : 1 : No : Targ
4 : 00 18 00 : 2300 : Ready : 2.01.7 : 1 : No : Targ
5 : 00 18 00 : 2300 : Ready : 2.01.7 : 1 : No : Targ
6 : 00 18 00 : 2300 : Ready : 2.01.7 : 1 : No : Targ
--------------------------------------------------------------
value = 80 = 0x50 = 'P'
Gateway >

Ctlr Id Indicates the Port Number for this interface.

PCI Addr The PCI address of the interface, showing
bus, device id, and function number.

ISPType The type of Fibre Channel Controller.

Firmware State The current state of the interface as reported
by the Fibre Channel PMC adapter firm-
ware. Firmware states are listed below.

• Configuration Wait Firmware is not initialized.
• Waiting for AL_PA Firmware is performing or

waiting to perform loop ini-
tialization.

• Waiting for login Firmware is attempting port

Level Meaning

0 or
<blank>

sets the verbosity level to the display in the example below

1 displays the information displayed below, and appends a break-
out for each channel that includes Node Type, Node Name, Port
Name and Port ID

2 displays the information included at levels 0 and 1, and appends
loop ID link stats
fcShow [level]



fcShowDevs
and process logins with all
loop ports.

• Ready Indicates that the interface is
connected and operational
and ready to process SCSI
commands. Any other value
indicates intermediate
states or interface failure.

• Sync Lost The firmware has detected a
loss-of-sync condition and
is re-synchronizing the
serial link receiver. This is
the state reported when the
Fibre Channel link does not
detect a connection to a
Fibre Channel device.

• Error The firmware has detected
an unrecoverable error con-
dition

• Nonparticipating The firmware is not partici-
pating on the loop since it
did not acquire an AL_PA
during initialization

• Failed The firmware is not respond-
ing to commands.

Firmware Version The version of firmware on the Fibre Channel
PMC adapter.

Loop ID The Fibre Channel Loop ID for this interface.
PtoP indicates a point-to-point connection

Fabric Attached Indicates whether the port is attached to a
Fabric.

Port Mode Indicates whether the port is set to Target or
Initiator mode

fcShowDevs

The fcShowDevs command displays information about the devices that are
accessible from each Fibre Channel interface. The display shows the LUN that the
ADIC Gateway has assigned to each device, the SCSI Channel that the device is
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attached to, the actual SCSI ID and LUN of the device, the vendor, product,
revision and serial number of the device.

MyGateway > fcShowDevs
FC 1:
LUN Chan Id Lun Vendor Product Rev SN
-----------------------------------------------------

0 0 0 0 ADIC Gateway 32b2 00112
1 2 3 1 XXX 2105E20 1206 128FC144
2 2 3 2 XXX 2105E20 1206 12AFC144
3 2 4 1 XXX 2105E20 1206 326FC144
4 2 4 2 XXX 2105E20 1206 328FC144
5 2 5 1 XXX 2105E20 1206 526FC144
6 2 5 2 XXX 2105E20 1206 528FC144
7 2 6 1 XXX 2105E20 1206 726FC144
8 2 6 2 XXX 2105E20 1206 728FC144

FC 4:
LUN Chan Id Lun Vendor Product Rev SN
-----------------------------------------------------

0 0 0 0 ADIC Gateway 32b2 00112
1 2 3 1 XXX 2105E20 1206 128FC144
2 2 3 2 XXX 2105E20 1206 12AFC144
3 2 4 1 XXX 2105E20 1206 326FC144
4 2 4 2 XXX 2105E20 1206 328FC144
5 2 5 1 XXX 2105E20 1206 526FC144
6 2 5 2 XXX 2105E20 1206 528FC144
7 2 6 1 XXX 2105E20 1206 726FC144
8 2 6 2 XXX 2105E20 1206 728FC144

value = 6 = 0x6
MyGateway >

fcShowNames

The fcShowNames command displays the node and port names (addresses) of
the Fibre Channels.

Gateway >fcShowNames
---------------------------------------------------------------
Ctlr : PCI Addr : ISP : Node : Port
Id : Bs Dv Fn : Type : Name : Name

---------------------------------------------------------------
1 : 00 06 00 : 2300 : 10000060.451603bb : 20010060.451603bb
2 : 00 18 00 : 2300 : 10000060.451603bb : 20040060.451603bb

---------------------------------------------------------------
value = 64 = 0x40 = '@'
Gateway >

Ctlr Id Indicates the Channel Number for the inter-
face
fcShowNames



gateAddrGet
PCI Addr The PCI address of the interface, showing
bus, device id, and function number.

ISPType The type of Fibre Channel Controller,
ISP2300.

Node Name The Fibre Channel node name for the ADIC
Gateway.

Port Name The Fibre Channel port name for the inter-
face.

gateAddrGet

The gateAddrGet command displays the default network gateway address if
one has been set. This address is used when connections are made to a different
subnet and there are no explicit routes defined for that subnet. Consult your
network administrator for more information on the default gateway (sometimes
referred to as default router) address.

Gateway > gateAddrGet
Gateway Address set to 192.168.1.1
value = 0 = 0x0
Gateway >

gateAddrSet

The gateAddrSet command changes the default network gateway address. This
address is used when connections are made to a different subnet and there are
no explicit routes defined for that subnet. Consult your network administrator for
more information on the default gateway (sometimes referred to as default router)
address.

Gateway > gateAddrSet “10.0.0.1”
value = 0 = 0x0
Gateway >

hardwareConfig

In order to use this command, the ADIC Gateway must be in diagnostic mode.
The hardwareConfig command records the configurations of installed FRUs by
copying them to the nonvolatile vital product data (VPD) stored on the ADIC
Gateway base. The fields that are updated are the SCSI channel types and PMC
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card types. The service representative enters the hardwareConfig command
after replacing any FRUs. This causes the ADIC Gateway to update the VPD.

Gateway > hardwareConfig
==== Recording Hardware Configuration ====
Scanning PMC option slots...
Scanning SCSI IO Modules...
Checking memory sizes...

MemSize PCI-0 is 64 Mbytes ...Done
value = 0 = 0x0
Gateway >

help

The help command displays a list of the shell commands.

Gateway > help
help Print this list

cleHelp Print Command Log Entry info
diagHelp Print Diagnostic Help info
hlthChkHelp Print Health Check Help info
ioHelp Print I/O Utilities Help info
mapHelp Print Device Map Help info
netHelp Print Network Help info
snmpHelp Print SNMP Help info
userHelp Print User account info
cd "path" Set current working path
copy ["in"][,"out"] Copy in file to out file (0
= std in/out)
h [n] Print (or set) shell history
ls ["path"[,long]] List contents of directory
ll ["path"] List contents of directory -
long format
pwd Print working path
rename "old","new" Change name of file
rm ["name"] Remove (delete) a file
shellLock Lock or unlock shell command
interface
version Print Version info
whoami Print user name
clearReservation[devId] Clear reservation on a
target (may reset target)
diagBoot Shutdown and restart in
diagnostic mode
initializeBox Delete all device maps,
restore factory defaults, reboot
ridTag ["value"] Display and set serial number
of replaced base unit
disableCC [option] Disable Command and
help



hlthChkHelp
Control Interface
option 1 - Report as Invalid (AIX

mode)
option 2 - Fully disabled

enableCC Enable Command and Control
Interface
scsiRescan [chan] Rescan SCSI Channel (all if
chan not specified)
scsiShow Display info for SCSI Channels
fcShow Display info for Fibre Channels
fcShowDevs Display devices available on
each Fibre Channel
fcShowNames Display Node and Port names for
Fibre Channels
hostTypeShow Display Default Host Type
settings
loggerDump [count] Display Logger Dump
Records
loggerDumpCurrent [level] Display Logger Dump
Records for current boot
reboot Shut down and restart
reset Restart without shut down
setFcFrameSize [chan],[size] Set FC Frame Size
setFcHardId [chan],[id] Set FC Loop ID
setHost [chan],["OS"] Set default host type for
FC Channel OS may be "aix", "nt",
"solaris","hpux", "as400", " autosense/nt"...
setSnaCCLun Set LUN for Controller Device
(typically zero)
showBox Display graphic of current
hardware configuration
sysConfigShow Display System Config
Parameters
sysVpdShow Display Vital Product Data
sysVpdShowAll Display Vital Product Data for
all subsystems
targets List all known target devices
uptime Display time since last boot

See User’s Guide for more information

value = 0 = 0x0
Gateway >

hlthChkHelp

The hlthChkHelp command displays a list of the Health Check commands.

Gateway > hlthChkHelp
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hlthChkIntervalGet - Show Check Interval
hlthChkIntervalSet <interval> - Set Check Interval
hlthChkLevelGet - Show Check Level
hlthChkLevelSet <level> - Set Check Level
hlthChkNow - Run Health Check Now

See User’s Guide for more information

value = 0 = 0x0
Gateway >

hlthChkIntervalGet

The current Health Check interval can be viewed using the
hlthChkIntervalGet command. The example below shows the current
interval is 60 minutes.

Gateway > hlthChkIntervalGet
value = 60 = 0x3c = '<'
Gateway >

hlthChkIntervalSet

The Health Check interval controls how often the Health Check process runs. The
interval may range from 1 to 65,535 minutes (about 45 days). Set the interval
using the hlthChkIntervalSet command.

Gateway > hlthChkIntervalSet 60
value = 0 = 0x0
Gateway >

hlthChkLevelGet

To display the current Health Check level, use the hlthChkLevelGet command.
The example below shows that the current level is 2.

Gateway > hlthChkLevelGet
value = 2 = 0x02
Gateway >

hlthChkLevelSet

To set the Health Check level, use the hlthChkLevelSet command. The
example below shows setting the level to 3.

Gateway > hlthChkLevelSet 3
value = 0 = 0x0
hlthChkIntervalGet



hlthChkNow
Gateway >

hlthChkNow

The hlthChkNow function causes the ADIC Gateway to execute an immediate,
level 4 Health Check. Results are displayed that will indicate which devices or
subsystems failed the check.

Gateway > hlthChkNow
Health Check: Starting level 4 check
Health Check: Step 1 -- Checking System
Health Check: Step 2 -- Checking Interfaces
Health Check: Step 3 -- Checking Devices
Health Check: Step 4 -- Checking Device States
Health Check: Passed

value = 0 = 0x0
Gateway >

host “add”,“hostname”,“ipAddress”

The host “add” command adds the named host to the host table and host file. If
the IP address is already assigned to a host, then the new name is added as an
alias for the host. The host “add” command is invoked to add known hosts and
their IP addresses. Alias names are supported, allowing multiple names to a
single host.

The host utilities maintain a host file, ffs:/mgnt/hosts, which is used at
system startup to initialize the network hosts table. This table associates network
names with IP addresses. Use of the hosts table is entirely optional, but might
facilitate frequently needed connections. Each host entry is a single line of the
format:

IP-address official_host_name nicknames ...

where

IP-address is a text string in standard IP Address format
(i.e., 10.0.0.2).

official_host_name is the first name selected for this host.

nicknames is an optional list of additional aliases for the
host (separated by spaces).

The following is an example of host file contents.

192.168.1.90 bruno
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200.0.0.42 socrates
200.0.0.45 plato
200.0.0.47 fred

Note: The host file does not exist until you enter the host “add” command.

Gateway > host “add”,"plato","200.0.0.45"
Gateway >

host “delete”,“hostname”

The host “delete” command deletes the named host from the hosts table and
hosts file. If the hostname is an alias, then only the alias is removed. If
hostname is the official host name, the entry and all aliases are removed.

The host utilities maintain a host file, ffs:/mgnt/hosts, which is used at
system startup to initialize the network hosts table. This table associates network
names with IP addresses. Use of the hosts table is entirely optional, but might
facilitate frequently needed connections. Each host entry is a single line of the
format:

IP-address official_host_name nicknames ...

where

IP-address is a text string in standard IP Address format
(i.e., 10.0.0.2).

official_host_name is the first name selected for this host.

nicknames is an optional list of additional aliases for the
host (separated by spaces).

The following is an example of host file contents.

192.168.1.90 bruno
200.0.0.42 socrates
200.0.0.45 plato
200.0.0.47 fred

Gateway > host “delete”, "plato"
Gateway >

host “list”

The host “list” command prints the content of the hosts file.
host “delete”,“hostname”



hostNameSe
The host utilities maintain a host file, ffs:/mgnt/hosts, which is used at
system startup to initialize the network hosts table. This table associates network
names with IP addresses. Use of the hosts table is entirely optional, but might
facilitate frequently needed connections. Each host entry is a single line of the
format:

IP-address official_host_name nicknames ...

where

IP-address is a text string in standard IP Address format
(i.e., 10.0.0.2).

official_host_name is the first name selected for this host.

nicknames is an optional list of additional aliases for the
host (separated by spaces).

The following is an example of host file contents.

Gateway > host “list”
192.168.1.90 bruno
200.0.0.42 socrates
200.0.0.45 plato
200.0.0.47 fred
value = 0 = 0x0
Gateway >

hostNameSet

The hostNameSet command changes the network name of the ADIC Gateway.
The shell prompt will be set to the new host name.

Gateway > hostNameSet "foster"
Target hostname set to foster
value = 0 = 0x0
foster >

hostTypeShow

The hostTypeShow command displays the host type setting for each Fibre
Channel. The possible host types are “nt” “aix” “solaris” “hp-ux” “netware”
“gateway” “switch” “generic” “unisys” “as400” “autosense/nt” “fcr-2” and “pv-136t-
fc”

Gateway > hostTypeShow
FC 1: Type 2 – nt
FC 4: Type 1 – solaris
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value = 0 = 0x0
Gateway >

icmpstatShow 

The icmpstatShow command displays ICMP statistics for the Ethernet network.
Interpreting these statistics requires detailed knowledge of Internet networking
protocols. This information may be useful to the LAN administrator.

Gateway > icmpstatShow
ICMP:

0 call to icmp_error
0 error not generated because old message was icmp
0 message with bad code fields
0 message < minimum length
0 bad checksum
0 message with bad length
Input histogram:

destination unreachable: 1
0 message response generated

value = 30 = 0x1e
Gateway >

ifShow

The ifShow command is used to show the Ethernet port parameters and status
as shown below. The ADIC Gateway will show two devices. lnPci is the Ethernet
port. lo is the local loopback port.

Gateway > ifShow
lnPci (unit number 0):

Flags: (0x63) UP BROADCAST ARP RUNNING
Internet address: 192.168.1.54
Broadcast address: 192.168.1.255
Netmask 0xffffff00 Subnetmask 0xffffff00
Ethernet address is 00:60:45:0d:00:c0
Metric is 0
Maximum Transfer Unit size is 1500
13 packets received; 12 packets sent
0 input errors; 0 output errors
0 collisions

lo (unit number 0):
Flags: (0x69) UP LOOPBACK ARP RUNNING
Internet address: 127.0.0.1
Netmask 0xff000000 Subnetmask 0xff000000
Metric is 0
Maximum Transfer Unit size is 4096
4 packets received; 4 packets sent
icmpstatShow
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0 input errors; 0 output errors
0 collisions

value = 18 = 0x12
Gateway >

inetstatShow

The inetstatShow command displays statistics about Internet protocol sockets
for the Ethernet network. Interpreting these statistics requires detailed knowledge
of Internet networking protocols. This information may be useful to the LAN
administrator.

Gateway > inetstatShow
Active Internet connections (including servers)
PCB Proto Recv-Q Send-Q Local Address Foreign Address
(state)
-------- ----- ------ ------ ------------------ ---------------
--- -------
c1fee18c TCP 0 0 192.168.1.59.23 206.0.64.117.4239
ESTABLISHED
c1fee40c TCP 0 0 0.0.0.0.52787 0.0.0.0.0 LISTEN
c1fee58c TCP 0 0 0.0.0.0.21 0.0.0.0.0 LISTEN
c1fee68c TCP 0 0 0.0.0.0.23 0.0.0.0.0 LISTEN
c1feea0c TCP 0 0 0.0.0.0.513 0.0.0.0.0 LISTEN
c1fee48c UDP 0 0 0.0.0.0.161 0.0.0.0.0
value = 1 = 0x1
Gateway >

initializeBox

The initializeBox command removes configuration files, such as
management configuration and SCSI device maps, and then prompts to reboot.

Attention: Use this function with care as data may be lost as a result
of devices moving to different LUNs when the mapping database is
removed. Make sure all I/O has been stopped.

ipstatShow

The ipstatShow command displays Internet protocol statistics for the Ethernet
network. Interpreting these statistics requires detailed knowledge of Internet
networking protocols. This information may be useful to the LAN administrator.

Gateway > ipstatShow
total 8380

badsum 0
tooshort 0
toosmall 0
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badhlen 0
badlen 0

fragments 0
fragdropped 0
fragtimeout 0

forward 0
cantforward 0

redirectsent 0

value = 1 = 0x1
Gateway >

licenseShow

The licenseShow command displays information about software license keys
that are installed and the corresponding features that are available. The following
example shows an ADIC Gateway that contains a license key for the VPS and
Data Mover features.

Gateway > licenseShow
License “wsk96-sd59a”: Valid

Features:
VPS,
Data Mover.

value = 1 = 0x1
Gateway >

loggerDump [number]

Dump records from the system event log to the console using the loggerDump
command. A numeric parameter may be used to indicate the number of events to
display. With no parameter specified, all events in the log file are displayed
starting with the most recent events.

Gateway > loggerDump 4
*** Dumping 4 (1018 through 1021) of 1021 records ***
000008 1018 0d:00h:00m:07s:22t -- SCSI 2: Bus RESET
000009 1019 0d:00h:00m:07s:22t -- Target device added: index 0,
handle 0xc0ec2600
000010 1020 0d:00h:00m:08s:18t -- Target device added: index
10, handle 0xc0ad2590
000011 1021 0d:00h:00m:08s:28t -- SCSI 2: New Device at Id 6,
Lun 0
Gateway >
licenseShow



loggerDumpC
loggerDumpCurrent [level]

Dump records from the system event log to the console with the
loggerDumpCurrent command. Only records logged since the system was
booted are dumped. Level specifies the event log level for the events as follows

The following is an example dump after a typical boot sequence with four target
devices added (one additional one is shown; that is the Command and Control
LUN of the ADIC Gateway itself).

Gateway > loggerDumpCurrent 1
*** Dumping 9 (1010 through 1018) current records with level >=
0 ***
000001 0d:00h:00m:05s:56t -- NOTICE: CS and LOGGING STARTED
000002 0d:00h:00m:07s:19t -- FCAL 1: LIP occurred
000003 0d:00h:00m:07s:19t -- FCAL 1: Loop up
000004 0d:00h:00m:07s:22t -- SCSI 1: Bus RESET
000005 0d:00h:00m:07s:22t -- SCSI 2: Bus RESET
000006 0d:00h:00m:07s:22t -- Target device added: index 0,
handle 0xc0ec2600
000007 0d:00h:00m:08s:18t -- Target device added: index 9,
handle 0xc1f9e090
000008 0d:00h:00m:08s:18t -- Target device added: index 10,
handle 0xc0ad2590
000009 0d:00h:00m:08s:28t -- SCSI 2: New Device at Id 6, Lun 0
value = 0 = 0x0
Gateway >

ls or ll

The ADIC Gateway contains a file system in its flash memory. Use the ls
command to display the files as shown below.

Gateway >

CONFIG

Table B-2: Event Log Levels

Level Name Explanation

0 Notice Events which are never shown by the remote event viewer
but are recorded in the ADIC Gateway event log

1 Warning Conditions that should always be reported, such as
temperature alarms and device removals

2 Information Events that might result in a later problem

3 All Events Events that are not errors or warnings
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LOG
VXWORKST.Z
SNA.RC
MGMT
MT
value = 0 = 0x0
Gateway >

To obtain detailed information about the file, use the ll command instead.

macShow

The macShow command displays the Media Access Control (MAC) address for
the Ethernet interface.

Gateway > macShow
Enet MAC Address: 0.60.45.d.0.80
value = 33 = 0x21 = '!'
Gateway >

mapCompressDatabase

Attention: Compressing the map database will cause device
addresses to change unpredictably. Use this command only when no
host systems are expecting devices to remain at their current
addresses.

Occasionally, it may be necessary to eliminate inactive entries and reorder the
active entries in the Persistent Device Map database. The
mapCompressDatabase command removes entries for devices that are no
longer present and reassigns existing device entries to new addresses. The
devices will be assigned new addresses immediately and hosts must rescan for
devices or be rebooted.

This may be required when a host system has a limited number of logical units
that may be supported, and changing devices on the ADIC Gateway has caused
the logical unit numbers to increase beyond the host’s supported level.

When you run this command you will be given the option of also clearing the VPS
access settings. Because devices will be assigned new addresses, clearing the
VPS database ensures that hosts will not have access to the wrong LUNs.
Accepting this option requires that the system administrator must reassign VPS
access permissions between the hosts and LUNs.

Gateway > mapCompressDatabase
This command will compress the Persistent Device Map.

Existing VPS Access Settings may become invalid and
macShow
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should be cleared because LUN assignments may change!
Do you want to compress the Device Map? (y or n) y
0xc1689ac0 (tShell): Wrote 23 device maps to file 'ffs:config/
device.map'
Device Map Compressed
- Do you want to clear VPS Access Settings? (y or n) y
VPS Access Cleared
value = 23 = 0x17
Gateway >

mapHelp

The mapHelp command displays a list of the persistent address map database
commands.

Gateway > mapHelp

mapCompressDatabase - Compress Device Map Database (reboot
required)
mapRebuildDatabase - Rebuild Device Map Database (reboot
required)
mapShowDatabase - Show the Map Database
mapShowDevs - Show currently attached devices
mapWinnowDatabase - Remove unatached devices from database

See User’s Guide for more information

value = 0 = 0x0
Gateway >

mapRebuildDatabase

Attention: Clearing the map database will cause device addresses to
change unpredictably. Use this command only when no host systems
are expecting devices to remain at their current addresses. The ADIC
Gateway must be rebooted after executing this command.

Occasionally, it may be necessary to eliminate the Persistent Device Map
database entirely, allowing the existing devices to have new addresses assigned.
The mapRebuildDatabase command deletes the current database. When the
ADIC Gateway is next booted, the devices found will be assigned new addresses.

When you run this command you will be given the option of also clearing the VPS
access settings. Because devices will be assigned new addresses, clearing the
VPS database ensures that hosts will not have access to the wrong LUNs.
Accepting this option requires that the system administrator must reassign VPS
access permissions between the hosts and LUNs.
255



256
This may be required when a host system has a limited number of logical units
that may be supported, and changing devices on the ADIC Gateway has caused
the logical unit numbers to increase beyond the host’s supported level.

Gateway > mapRebuildDatabase
This command will clear the Persistent Device Map.
Existing VPS Access Settings may become invalid and
should be cleared because LUN assignments may change!
These changes will take effect when the Gateway is rebooted.
Do you want to clear the Device Map? (y or n) y
Removing the Persistent Device Map
Device Map Cleared - Do you want to clear VPS Access Settings?
(y or n) y
VPS Access Cleared - Reboot Gateway? (y or n) y== reboot
Gateway >

mapShowDatabase

The ADIC Gateway maintains a database of attached devices, to insure that each
time a host attaches to it, the target devices are seen at a consistent address. The
database will list not only the devices presently connected, but also devices that
have previously been connected. If a previously attached device is later
reattached, it will be assigned back to its previous address. Use the
mapShowDatabase command to display the persistent device map table.

Gateway > mapShowDatabase
devId Type Chan tId tLun UID
-----------------------------------------------
000 SNA 127 127 127 00000060:450d00c0
001 SCSI 001 003 000 00000060:450d00c0
002 SCSI 001 002 000 00000060:450d00c0
003 SCSI 001 001 000 00000060:450d00c0
004 SCSI 002 002 000 00000060:450d00c0
005 SCSI 002 000 000 00000060:450d00c0
006 SCSI 002 006 000 00000060:450d00c0
007 SCSI 002 009 000 00000060:450d00c0
008 SCSI 002 002 001 00000060:450d00c0
009 SCSI 002 005 000 00000060:450d00c0
010 SCSI 002 005 001 00000060:450d00c0
011 SCSI 001 000 000 00000060:450d00c0
012 SCSI 001 006 000 00000060:450d00c0
value = 0 = 0x0
Gateway >

devId The index of the device in the database.

Type The type of interface where the device is
connected. SNA indicates an internal
device. SCSI or Fibre Channel indicate I/O
mapShowDatabase
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interfaces.

Chan The channel number of the interface where
the device is attached

TId Target ID mapping for SCSI Initiators

TLun Target LUN mapping for SCSI Initiators

UID For a Fibre Channel interface, the Unique ID
of the device. For SCSI interface, the ADIC
Gateway Unique ID.

mapShowDevs 

The ADIC Gateway maintains a cross-reference map of device addresses.
Information about the presently attached and available devices in the map can be
displayed using the mapShowDevs command.

Gateway > mapShowDevs
devId Type Chan iId iLun UID tId tLun Handle Itl
--------------------------------------------------------------
000 SNA 127 127 127 00000060.450d00c0 001 000 c0ec2600h
00000000h
009 SCSI 002 005 000 09000060.450d00c0 255 255 c1f9e090h
00000000h
010 SCSI 002 005 001 0a000060.450d00c0 255 255 c0ad2590h
00000000h
012 SCSI 001 006 000 0c000060.450d00c0 255 255 c1ffdf10h
c1ffdc80h
value = 0 = 0x0
Gateway >

Type The type of interface where the device is
attached to the ADIC Gateway.

Chan The channel number of the interface

iId For a SCSI interface only - device ID of the
device

iLun For a SCSI interface only – Logical unit num-
ber of the device.

UID For a Fibre Channel interface – Unique ID of
the device. For SCSI interface, a con-
structed Unique ID based on the ADIC
Gateway’s Unique ID.
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tId Target ID mapping for SCSI Initiators

tLun Target LUN mapping for SCSI Initiators

Handle An internal pointer used for some diagnostic
operations.

Itl An internal pointer used for some diagnostic
operations.

mapWinnowDatabase

Occasionally, you may want to eliminate inactive entries from the database. The
mapWinnowDatabase command reduces the database to only the devices
presently attached. The address mapping of the current devices will not be
altered.

Gateway > mapWinnowDatabase
0xc0ac8340 (tShell): Wrote 4 device maps to file 'ffs:config/
device.map'
value = 4 = 0x4
Gateway >

Attention: Winnowing the database might cause unattached devices
to change addresses unpredictably if they are reattached. Use this
command only when you are sure that the devices you are interested
in are connected and available to the ADIC Gateway. You must reboot
the ADIC Gateway after executing this command for the new setting
to take effect.

mbufShow

The mbufShow command displays statistics about the distribution of mbufs on the
Ethernet network. Interpreting these statistics requires detailed knowledge of
Internet networking protocols. This information may be useful to the LAN
administrator.

Gateway > mbufShow
type number
--------- ------
FREE : 23
DATA : 0
HEADER : 1
SOCKET : 0
PCB : 11
RTABLE : 3
HTABLE : 0
ATABLE : 0
mapWinnowDatabase
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SONAME : 0
ZOMBIE : 0
SOOPTS : 0
FTABLE : 0
RIGHTS : 0
IFADDR : 2
TOTAL : 40
number of mbufs: 40
number of clusters: 4
number of interface pages: 0
number of free clusters: 4
number of times failed to find space: 0
number of times waited for space: 0
number of times drained protocols for space: 0
value = 47 = 0x2f = '/'
Gateway >

netHelp

The netHelp command displays a list of the Ethernet network commands.

Gateway > netHelp

arptabShow - Display a list of known ARP entries
ethAddrSet "inetaddr","netmask" - set IP Address
gateAddrGet - Display Default IP gateway
gateAddrSet "inetaddr" - set Default IP gateway
host "<func>","hostname","inetaddr"

func - "add" - add to host table
- "delete" - delete from host table
- "list" - list host table

hostNameSet - set host name
icmpstatShow - Display statistics for ICMP
ifShow - Display info about network interfaces
inetstatShow - Display all Internet protocol sockets
ipstatShow - Display statistics for IP
macShow - Display Media Access Control Address
mbufShow - Display mbuf statistics
route "<func>","destination","gateway"

func - "add" - add route to route table
- "delete" - delete route from route table
- "list" - list route table

tcpstatShow - Display statistics for TCP
udpstatShow - Display statistics for UDP

See User’s Guide for more information

value = 0 = 0x0
Gateway >
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normalBoot

Certain commands and tests are only available in diagnostic mode. Switching
to diagnostic mode saves all configuration parameters so that they are restored
before returning to normal operation. Use the normalBoot command to restore
the ADIC Gateway to normal operating conditions.

This command is used only to transition an ADIC Gateway from the special
diagnostic mode to normal operations. It restores the bootline that was copied by
diagBoot. The new persistent device map is erased, and the original map file is
renamed config/device.map restoring it for use when the ADIC Gateway
reboots. The normalBoot command will then reboot the unit.

reboot

The reboot command requests that the ADIC Gateway shut down existing
operations and then restart. This is the preferred method of restarting the ADIC
Gateway. There are processes running within the ADIC Gateway that may have
writes pending to files within the flash file system. Following a reboot command,
these processes flush their data to the flash file system, and the flash file system
writes all pending data out to the flash memory. Only after all pending data has
successfully been written to flash, will the ADIC Gateway start a reset cycle.

Gateway > reboot

reset

The reset command immediately initiates a reset cycle. Any pending data writes
to the flash file system will be lost. This operation is not typically used. The
reboot command should be used to gracefully shutdown and restart the ADIC
Gateway.

Gateway > reset

ridtag [“value”]

The ridtag command is used to change the replacement identifier (RID) tag for
the ADIC Gateway after it has been replaced by the service representative. This
should be the final step after replacing and verifying that the replacement unit is
performing satisfactorily.

The sysVpdShow command will display the RID tag. Before replacing the ADIC
Gateway, the customer engineer must determine the existing RID tag, if there is
one, or the original serial number if no replacement has been made.
normalBoot
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If the ridtag command is entered with a string, that string becomes the RID tag
recorded for the unit.

Gateway > ridtag “12D345677”
*** value = 0 = 0x0

If a string is not entered, the existing RID tag is displayed.

Gateway > ridtag
RID Tag = 12D345677
value = 0 = 0x0
Gateway >

On original equipment, the RID tag will be blank.

rm

To remove a file, use the rm command and specify the file name in quotes:

Gateway > rm "file.ext"

route 

The route utilities maintain a route file, ffs:/mgmt/route, which is used at
system startup to initialize the network routing table. Each route entry is a single
line of the format:

destination:gateway

where

destination is an IP address (for a subnet or host) or the
name of a host that is described in the
hosts file.

gateway is an IP address or the name of a gateway to
a host. The gateway must be a device on
the local subnet.

An IP address is a text string in standard IP Address format (i.e., 10.0.0.2). A host
or gateway name must be listed in the hosts file.

Here is an example of the contents of the route file.

socrates:bruno
10.0.0:bruno

The first line instructs the system to reach the host “socrates” by directing the IP
packets to the host “bruno”. The second example shows how all traffic for the
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subnet 10.0.0 (implied netmask is 255.255.255.0) is sent to the host “bruno” for
forwarding. By default, no routes are defined in the route file.

The route command is invoked to add, remove, and list the route table.

route “add”,“destination”,“gateway”

The route “add” command adds a route to the destination through the gateway.

Gateway > route "add","200.0.0","bruno"
Gateway >

route “delete”,”destination”,”gateway” 

The route “delete” command removes a route to the destination through the
gateway.

Gateway > route "delete","200.0.0","bruno"
Gateway >

route “list” 

The route “list” command lists the existing routes.

Gateway > route "list"
Destination Gateway

-------------------- --------------------
socrates bruno
Destination Gateway

-------------------- --------------------
200.0.0 bruno

value = 0 = 0x0
Gateway >

rz

The rz command initiates a receive Zmodem file transfer session. You use this
command when you want to download a file from the service terminal to the ADIC
Gateway. The file can be either a firmware or configuration file. After issuing this
command, you start the file transfer from the service terminal by initiating a send
file operation that uses Zmodem protocol.

The example below shows the rz command when it is used to receive a file that
contains operational firmware. The ADIC Gateway extracts individual firmware
modules from the file and saves them temporarily in memory. After the file transfer
route “add”,“destination”,“gateway”
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has completed, the ADIC Gateway copies the firmware modules to nonvolatile
flash memory. The ADIC Gateway must be rebooted to use the updated firmware.

Gateway > rz
**B000000023be50
Firmware Update in Progress....
Found Image File BOOTROM.IMG – loading
.........Found Image File IPOST.IMG – loading
.........Found Image File SPOST.IMG – loading
Firmware Update Complete. Reboot for Update to Take Effect.
value = 0 = 0x0
Gateway >
The example below shows the rz command when it is used to
receive a file that contains configuration parameters. See also
the sz command for information about sending a configuration
file.

Gateway > rz
**B000000023be50
Configuration Update in Progress....
Configuration Update Complete. Reboot for Update to Take Effect.
value = 0 = 0x0
Gateway >

scsiAltIdGet [channel]

The scsiAltIdGet command displays the alternate ID number for a specified
channel. If no channel is specified, alternate IDs are displayed for all SCSI
channels.

Gateway > scsiAltIdGet
SCSIbus AltId ------- ---------------
SCSI 1 1
SCSI 2 6
value = -1 = 0xffffffff
Gateway >
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xscsiAltId
For information about Ultra2/3 SCSI channels, see the xscsiAltIdGet com-
mand.

scsiAltIdSet [channel],[id]

The scsiAltIdSet command sets the Alternate Id for the specified SCSI
Channel.

Gateway > scsiAltIdSet 2,6
Alternate Id set to 6 for SCSI 2
will take effect upon reboot
value = 0 = 0x0
Gateway >

Attention: You must reboot the ADIC Gateway after executing this
command for the new setting to take effect.

To set Alternate ID numbers for Ultra 2/3 SCSI Channels, see the 
xscsiAltIdSet command

scsiHostChanGet [channel]

The scsiHostChanGet command displays Host Channel modes for a SCSI
channel. If no channel is specified, Host Channel modes are displayed for all
SCSI channels.

Gateway > scsiHostChanGet
SCSIbus HostChan ------- ---------------
SCSI 1 Channel is Target
SCSI 2 Channel is Initiator
value = -1 = 0xffffffff
Gateway >

For information about Ultra2/3 SCSI channels, see the xscsiHostChanGet
command.

Parameter Value

SCSI Channel number 1 - 4

ID 0 -15
For information about Ultra2/3 SCSI channels, see the 
Get command.
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scsiHostChanSet [channel],[mode]

The scsiHostChanSet command sets the Channel Mode to Target or
Initiator for the specified SCSI Channel.

Gateway > scsiHostChanSet 2,1
Host Chan set to TRUE for SCSI 2 will take effect upon reboot
value = 0 = 0x0
Gateway >

Attention: You must reboot the ADIC Gateway after executing this
command for the new settings to take effect.

To set Host Channel Modes for Ultra 2/3 SCSI Channels only, see the
xscsiHostChanSet command.

scsiHostIdGet [channel]

The scsiHostIDGet command displays the Host ID number for a specified
SCSI Channel. If no channel is specified, Host IDs are displayed for all SCSI
channels.

Gateway > scsiHostIdGet
SCSIbus HostId ------- ---------------
SCSI 1 7
SCSI 2 7
value = -1 = 0xffffffff
Gateway >

Parameter Value Meaning

SCSI Channel number 1 - 4 Selected Channel

Mode 0 Initiator

1 Target
265
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xscsiHostI
For information about Ultra2/3 SCSI channels, see the xscsiHostIdGet com-
mand.

scsiHostIdSet [channel],[id]

The scsiHostIdSet command sets the Host ID for a specified SCSI Channel.

Gateway > scsiHostIdSet 2,7
Host Id set to 7 for SCSI 2
will take effect upon reboot
value = 0 = 0x0
Gateway >

Attention: You must reboot the ADIC Gateway after executing this
command for the new settings to take effect.

To set Host IDs for Ultra 2/3 SCSI Channels only, see the xscsiHostIdSet
command.

scsiRescan [channel]

The command scsiRescan requests a SCSI rescan for new devices. If channel
is specified (1 or 2), then only that channel is scanned. Otherwise, if channel is not
specified or if channel is 0, then all channels are scanned.

Gateway > scsiRescan 2
Done
value = 0 = 0x0
Gateway >

Notes:

Rescanning a SCSI bus may delay I/O commands pending on that
bus for several seconds. Do not rescan SCSI buses when this delay
may not be tolerated. When possible, only scan the bus where a new
device has been added.

If a channel is specified, that channel is scanned and the prompt is
returned on completion. If no channel is specified (or 0 is specified),
SCSI Channels 1 through 4 are scanned in sequence and the prompt

Parameter Value

Channel number 1 - 4

ID 0 -15
For information about Ultra2/3 SCSI channels, see the 
dGet command.
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is returned on completion.

When a device is discovered, there may be further device specific
initialization that continues after the scan has completed in which case
the device may not show up immediately when you issue the
fcShowDevs command. An example of this is a disk that requires a
SCSI Start Unit command to become ready. (Tape and Changer
devices and Disks that indicate Ready status are available on scan
completion).

If a SCSI target device should require replacement, remove the old
device, set the new device to the same SCSI bus ID as the old device
and attach it to the same channel. Rescan the channel to update the
configuration data. The new device should be available to host
systems with the same LUN as the old device.

scsiResetDisableGet [channel]

The scsiResetDisableGet command displays the SCSI Bus Reset On Power
Up is enabled. False means that SCSI Bus Reset On Power Up is disabled.

Gateway > scsiResetDisableGet
SCSIbus Reset Disable ------- ---------------
SCSI 1 TRUE
SCSI 2 FALSE – default
value = -1 = 0xffffffff
Gateway >

For information about Ultra2/3 SCSI channels, see the xscsiResetDisableGet
command.

scsiResetDisableSet [channel],[mode]

The scsiResetDisableSet command sets the SCSI Bus Reset On Power Up
for the specified SCSI channel. False is default and enables reset of SCSI bus on
power-up, True disables SCSI bus reset on power-up.

Gateway > scsiResetDisableSet 1,1
Reset Disable set to TRUE for SCSI 1

Parameter Value Meaning

Channel number 1 - 4 Selected Channel

Mode 0 Enable Reset on Power Up

1 Disable Reset on Power Up
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nels only, see
will take effect upon reboot
value = 0 = 0x0
Gateway >

To specify Bus Reset Settings for Ultra2/3 SCSI channels only, see the xsc-
siResetDisableSet command

scsiShow

The scsiShow command displays all SCSI channels and information about the
devices attached to each channel. The following example shows the display for
two disk devices attached to SCSI Channel 1 and a tape library attached to SCSI
Channel 2:

Gateway > scsiShow
SCSI Initiator Channel 1: 0xc08b5b60
ID LUN Vendor Product Rev | Sync/Off Width
--------------------------------------|------------
1 0 OEM OEM DCHS04X 6363 | 12/15 16 S W 0/ 0 8 S W Q
2 0 OEM OEM DCHS04X 6363 | 12/15 16 S W 0/ 0 8 S W Q

SCSI Initiator Channel 2: 0xc08d26e0
ID LUN Vendor Product Rev | Sync/Off Width
--------------------------------------|------------
0 0 OEM 03570C12 5346 | 25/15 16 S W 0/ 0 8 S W
0 1 OEM 03570C12 5346 |
1 0 OEM 03570C12 5346 | 25/15 16 S W 0/ 0 8 S W

value = 0 = 0x0
Gateway >

ID The SCSI ID of the target device

LUN The SCSI LUN of the target device

Vendor The content of the Vendor ID field from the
SCSI Inquiry Data

Product The content of the Product ID field from the
SCSI Inquiry Data

Rev The content of the Revision ID field from the
SCSI Inquiry Data

Sync/Off The negotiated synchronous transfer period
and offset. The period is the negotiated
transfer period. Multiply the period times 4
nanoseconds to determine the actual
period (exception: if the period is negoti-
ated to 12, then 50ns. is used). The offset
indicates the REQ/ACK offset that was
To specify Bus Reset Settings for Ultra2/3 SCSI chan-
the xscsiResetDisableSet command



scsiTermGet
negotiated. A zero in these fields indicates
that asynchronous transfer is in use.

Width The negotiated transfer width in bits, either 8
or 16.

scsiTermGet [channel]

The scsiTermGet command displays termination status information for the
specified channel. If no channel is specified, status information is displayed for all
SCSI channels.

Gateway > scsiTermGet
SCSIbus Termination ------- ---------------
SCSI 1 Enabled – default
SCSI 2 Enabled

value = 0 = 0x0
Gateway >
Gateway > scsiTermGet 2
SCSIbus Termination ------- ---------------
SCSI 2 Enabled – default

value = 0 = 0x0
Gateway >

Information solely about Ultra2/3 SCSI channels may be requested by entering
the xscsiTermGet command.

scsiTermSet [channel],[termination]

The scsiTermSet command enables or disables the termination for the SCSI
Channel.

To set termination status for Ultra 2/3 SCSI Channels only, use the
xscsiTermSet command.

Parameter Value Meaning

Channel number 1 - 4 Selected Channel

Termination 0 Enable Termination

1 Disable Termination
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setFcFrameSize [channel],[size]

Set the frame size for a channel using the setFcFrameSize command.

If an invalid size is set, then the fame size of 2048 will be used.

Attention: You must reboot the ADIC Gateway after executing this
command for the new setting to take effect.

Gateway > setFCFrameSize 1,2048
value = 2048 = 0x800
Gateway >

setFcHardId [channel],[id]

Set the Hard AL_PA for a channel using the setFcHardId command.

The ID settings 0 to 125, inclusive, are valid IDs. [255] requests the Soft ID
method. If an invalid id is requested, then the Soft ID method will be used.

Gateway > setFcHardId 1,4
value = 0 = 0x0
Gateway >

Attention: You must reboot the ADIC Gateway after executing this
command for the new setting to take effect

setHost [port],“OS”

The setHost command sets the operating system type for the specified SAN
interface. This provides some customization in the way the ADIC Gateway is

Parameter Value

SAN Channel Number 1 - 6

Frame size 512,1024, or 2048

Parameter Value Meaning

Channel 1 - 6

ID number 0 to 125

255 Use Soft ID method
setFcFrameSize [channel],[size]



setScsiAssig
presented to the particular operating system. If [port] is 0, the change applies to all
SAN connections; otherwise the host type is applied.

Attention: You must reboot the ADIC Gateway after executing this
command for the new setting to take effect.

setScsiAssign [devID], [channel], [id], [lun] 

Assigns a target device to a SCSI channel [channel] with SCSI Target ID [id] and
Logical Unit Number of [lun]. The indicated channel must be configured to be
running in target mode. The [id] and [lun] must be available on that channel.

setSnaCCLun [newLUN]

The setSnaCCLun command reassigns the ADIC Gateway Command and
Control LUN to the specified value.

newLUN is the new value for the Command and Control LUN. Valid values are 0
through 127.

The new setting takes effect immediately. The previous value is removed from the
device map and database and a trap is generated indicating that the device was
removed.

Parameter Value

Port 0 Changes will apply to all SAN
Connections

1 - 6 Changes will apply to SAN Connection 1
- 6, as specified

OS “nt”
“aix”
“solaris”
“hp-ux”
“netware”
“gateway”
“switch”
“generic”
“unisys”
“as400”
“fcr-2”
“pv-136t-fc”
“autosense
/nt”
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If the new LUN is not currently in use, a new entry is added in the device map and
database. A trap will be generated indicating the new device was added.

If the new LUN is already in use, the Command and Control LUN will be disabled.
It will remain disabled until the device mapped at the requested LUN is removed
and deleted from the database. In this case, you can use the
mapRebuildDatabase command to remove the previous LUN assignment and
to allow the new Command and Control LUN to be enabled.

Attention: Because AIX and NT use LUN 0 when they issue a Report
LUNs command, you must make sure that a device is configured at
LUN 0.

shellLock

Only one management interface may be in use at a time. If a network interface is
opened, the Service Port interface is not available. The shellLock command
may be used to prevent a network protocol access to the shell.

A numeric parameter specifies if the shell is to be locked or unlocked. If the
parameter is 0, then the shell is unlocked.

Gateway > shellLock 1
value = 1 = 1x1
Gateway >
.. Shell is now locked

Gateway > shellLock 0
value = 0 = 0x0
shellLock
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showBox

The showbox command displays components of the ADIC Gateway using
characters to form a picture of the unit, as viewed from the back of unit:

SAN Gateway
login : admin
Password:

Gateway3010 > showBox
NOTICE: On-board SCSI-1 changed

_ _
Front //| /-------------------------------//|

// /----/ DDF Board // |
// / / // |

// / -------------------------------// |
// / /-----/ /-----/ /-----/// /

///====/ /====/ / 3 / / 2 / / 1 /// /
/========================================/ /
| [HVDT] [HVDT] | /
| [DFCSW] [FCCu=] [DFCSW] | /
| [====] [HVDT] | /
|________________________________________|/ Back

HVDT = SCSI High Voltage Differential - Terminated
DFCSW = Dual FibreChannel Optical Short Wave
FCCu = FibreChannel Copper
DDF = Direct Data Flow Memory with error correction

SIMMS: 32 Mbytes total, non parity
SCSI-2 requires High Voltage Differential cable
SCSI-3 requires High Voltage Differential cable
SCSI-4 requires High Voltage Differential cable
DFCSW-1 slot-1 Right-Port requires FibreChannel Multi-Mode

(SW) cable
DFCSW-4 slot-1 Left-Port requires FibreChannel Multi-Mode (SW)
cable
FCCu-2 slot-2 requires FibreChannel copper cable
DFCSW-3 slot-3 Right-Port requires FibreChannel Multi-Mode

(SW) cable
DFCSW-6 slot-3 Left-Port requires FibreChannel Multi-Mode (SW)
cable

value = 0 = 0x0
Gateway3010 >

The abbreviations used in the drawing are explained in the legend immediately
below the drawing.
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showScsiAssign

Lists the current assigned addresses for the indicated channel. If channel is
omitted, or is 0 (zero) then all assignments are shown for all Target channels.

sncFeatureEnable "licensekeystring"

The sncFeatureEnable command enables the optional Data Mover feature.
You enable the feature by entering the unique license key.

Gateway > sncFeatureEnable “BVRXC-G79DN”
value = 0 = 0x0
Gateway >

If the license key was factory-installed, you can enter the word “enable” rather
than the actual license key.

Gateway > sncFeatureEnable “enable”
value = 0 = 0x0
Data Mover License is Valid
Gateway >

If value = 1 = 0x1 message is displayed, it means the license is already
installed and Data Mover is already enabled.

If the value = -1 = 0xffffffff message is displayed, it means the license
is not already installed and you do need to enter the license key.

snmpCommunitiesShow

The snmpCommunitiesShow command displays the list of SNMP community
strings in use by the ADIC Gateway.

Gateway > snmpCommunitiesShow

ReadCommunity ViewIndex
-----------------------------
pub 1
ReadCommunity ViewIndex
-----------------------------
public 1
icmp 2

WriteCommunity ViewIndex
-----------------------------
priv 1
private 1
TrapCommunity
showScsiAssign



snmpHelp
------------------------------
private
value = 9 = 0x9
Gateway >

snmpHelp

The snmpHelp command displays a list of the snmp commands.

Gateway > snmpHelp

snmpCommunitiesShow
snmpReadCommunityAdd "string"
snmpReadCommunityRemove "string"
snmpTrapCommunitySet "string"
snmpWriteCommunityAdd "string"
snmpWriteCommunityRemove "string"
trapDestAdd "ipaddress"
trapDestRemove "ipaddress"
trapDestShow

See User’s Guide for more information

value = 0 = 0x0
Gateway >

snmpReadCommunityAdd “string” 

The snmpReadCommunityAdd command adds the specified string to the list of
accepted strings for SNMP Read operations (Get and GetNext).

Gateway > snmpReadCommunityAdd “DISC Inc.”
Success
value = 4 = 0x4
Gateway >

snmpReadCommunityRemove “string” 

The snmpReadCommunityRemove command removes the specified string from
the list of accepted strings for SNMP Read operations.

Gateway > snmpReadCommunityRemove “DISC Inc.”
Success
value = 3 = 0x3
Gateway >
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snmpTrapCommunitySet “string” 

The snmpTrapCommunitySet command sets the community string passed with
all SNMP traps.

Gateway > snmpTrapCommunitySet “DISC Inc.”
Success
value = 8 = 0x8
Gateway >

snmpWriteCommunityAdd “string”

The snmpWriteCommunityAdd command adds the specified string to the list of
accepted strings for SNMP Write operations (Set).

Gateway > snmpWriteCommunityAdd “DISC”
Success
value = 0 = 0x0
Gateway >

snmpWriteCommunityRemove “string” 

The snmpWriteCommunityRemove command removes the specified string from
the list of accepted strings for SNMP Write operations.

Gateway > snmpWriteCommunityRemove “DISC”
Success
value = 0 = 0x0
Gateway >

sysConfigShow 

The sysConfigShow command displays current system parameter settings. The
display shows whether or not the ADIC Gateway Command and Control interface
is enabled or disabled and the LUN that is assigned to it, whether or not enhanced
tape performance features are enabled, the MAC address of the Ethernet port;
and the ADIC Gateway Fibre Channel Node address.

Gateway > sysConfigShow
Current System Parameter Settings:
Command and Control Device (CC) : 0 Enabled

LUN : 0
Allow Early Write Status for Tape : 1 Enabled
Allow R/W Acceleration for Tape : 1 Enabled
Enet MAC Address: 0.60.45.16.1.4
FC Node WWN: 10000060.45160104
value = 0 = 0x0
Gateway >
snmpTrapCommunitySet “string”
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sysVpdShow or sysVpdShowAll

The sysVpdShow command displays Vital Product data information. The Vital
Product Data for the ADIC Gateway includes such items as serial numbers and
installed memory sizes, as shown below.

Gateway > sysVpdShow

====== VPD ======
name SAN Gateway
uid 00:60:45:16:01:04
s/n 100111
mfg DISC, Inc.
board OntarioII 1.1
" s/n 08357659
flash 2Mbyte
dram 32Mbyte
slot1 10772100 FCOSW
scsi 1: DET 2: DET
EC OTA08000H
RID Tag

value = 0 = 0x0
Gateway >

The fields are:

• The product’s Name, up to 16 characters
• The product’s unique Ethernet MAC address, 32 characters dis-

played as hexadecimal bytes separated by colons
• The product’s serial number, up to 16 characters
• The product’s manufacturer, up to 16 characters
• The name of the motherboard contained in the base unit, up to 16

characters
• The motherboard’s serial number, up to 16 characters
• The size of the FLASH memory on the motherboard
• The size of the DRAM on the motherboard
• The GBIC type installed in SAN Connection slot one
• The SCSI type for each of the two channels, DET for “Differential,

terminated” and SET for “Single-ended, terminated”
• The Engineering Change (EC) level for the motherboard, up to 16

characters
• The RID Tag identifier, up to 16 characters
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The sysVpdShowAll shows a little more information and includes product data
for the Fibre Channel GBIC.

Gateway > sysVpdShowAll
===[ Vital Product Data ]===

-=[ Base Assembly ]-------
Name Gateway
Mfg ADIC
UID 00:60:45:16:01:04
S/N 100111
Assy HCO OTA08000H
Board OntarioII 1.1
" S/N 08357659

Flash 2 Mbyte
Dram 32 Mbyte
RID Tag 100111

-=[ Slot 1 ]=-------------
Type 10772100 FCOSW
S/N 123456
UID 0060.45160065
HCO SC004120H

value = 0 = 0x0
Gateway >

sz “filename”

The sz command initiates a send Zmodem file transfer session. You use this
command when you want to save configuration information to a file in case the
ADIC Gateway needs to be replaced. The ADIC Gateway uses Zmodem protocol
to upload its persistent address map database and configuration parameter
settings from its nonvolatile flash memory to a file on the service terminal. After
issuing this command, you start the file transfer from the service terminal by
initiating a receive file operation that uses Zmodem protocol.

The filename “config.cfg” is shown in the example below. You can specify a
different name for the file but the name must not exceed 8 characters and it must
end in .cfg. See also the rz command for information about receiving a
configuration file.

Gateway > sz "config.cfg"
Configuration Download Complete: config.cfg
value = 0 = 0x0
Gateway >
sz “filename”
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targets

The ADIC Gateway maintains a list of target devices that are attached to the I/O
channels. The targets command will list each device currently attached,
providing descriptions of the devices.

Gateway > targets
Idx Tdev Vendor Product Rev | Type Specific
----------------------------------------------|----------------
-------------------
0 0xc194a400 DISC, Inc. SAN Gateway Local 0252 | Cmd/Cntrl

Status 0h
2 0xc1ffc390 IBM 03570C11 5324 | Tape: Blk Size 32768 ,

flags 7h
3 0xc1ffc290 IBM 03570C11 5324 | Changer: flags 7h
value = 4 = 0x4

Gateway >

Idx Device Index in the target list.

Tdev An internal pointer, used for some diagnostic
operations

Vendor The content of the Vendor ID field from the
SCSI Inquiry Data

Product The content of the Product ID field from the
SCSI Inquiry Data

Rev The content of the Revision ID field from the
SCSI Inquiry Data

Type Specific For each device type, information pertinent
to the device

tcpstatShow

The tcpstatShow command displays TCP statistics for the Ethernet network.
Interpreting these statistics requires detailed knowledge of Internet networking
protocols. This information may be useful to the LAN administrator.

Gateway > tcpstatShow
TCP:

301 packets sent
278 data packets (18371 bytes)
0 data packet (0 byte) retransmitted
23 ack-only packets (22 delayed)
0 URG only packet
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0 window probe packet
0 window update packet
0 control packet

516 packets received
272 acks (for 18372 bytes)
1 duplicate ack
0 ack for unsent data
276 packets (322 bytes) received in-sequence
0 completely duplicate packet (0 byte)
0 packet with some dup. data (0 byte duped)
0 out-of-order packet (0 byte)
0 packet (0 byte) of data after window
0 window probe
0 window update packet
0 packet received after close
0 discarded for bad checksum
0 discarded for bad header offset field
0 discarded because packet too short

0 connection request
1 connection accept
1 connection established (including accepts)
1 connection closed (including 0 drop)
0 embryonic connection dropped
272 segments updated rtt (of 272 attempts)
0 retransmit timeout

0 connection dropped by rexmit timeout
0 persist timeout
1 keepalive timeout

1 keepalive probe sent
0 connection dropped by keepalive

value = 36 = 0x24 = '$'
Gateway >

trapDestAdd “ipAddress” 

The trapDestAdd command allows you to add an ethernet address as a trap
recipient to the SNMP trap destination table that is maintained within the ADIC
Gateway. When the ADIC Management Console is running, it inserts its address
into the table automatically. The broadcast address for the Ethernet port is also
automatically included in the table.

Gateway > trapDestAdd 192.168.1.75
value = 0 = 0x0
Gateway >

trapDestRemove “ipAddress” 

The trapDestRemove command allows you to remove an ethernet address as a
trap recipient from the SNMP trap destination table that is maintained within the
trapDestAdd “ipAddress”



trapDestShow
ADIC Gateway. When the ADIC Management Console is running, it inserts its
address into the table automatically. The broadcast address for the Ethernet port
is also automatically included in the table.

Gateway > trapDestRemove “10.0.0.2”
value = 0 = 0x0
Gateway >

trapDestShow

The trapDestShow command allows you to view the SNMP trap destination
table maintained within the ADIC Gateway. When the ADIC Management Console
is running, it inserts its address into the table automatically. The broadcast
address for the Ethernet port is also automatically included in the table

Gateway > trapDestShow
Trap Destination IP Address
---------------------------

192.168.30.255
206.0.64.17
206.0.64.25
206.0.64.35
206.0.64.255

value = 1 = 0x1
Gateway >

udpstatShow 

The udpstatShow command displays UDP statistics for the Ethernet network.
Interpreting these statistics requires detailed knowledge of Internet networking
protocols. This information may be useful to the LAN administrator.

Gateway > udpstatShow
UDP:

8514 total packets
8445 input packets
69 output packets
0 incomplete header
0 bad data length field
0 bad checksum
8383 broadcasts received with no ports
0 full socket

value = 15 = 0xf
Gateway >
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uptime

The uptime command displays the elapsed time since the last boot of the ADIC
Gateway.

Gateway > uptime
Elapsed time since reset 4d:23h:12m:46s:10t
value = 10 = 0xa
Gateway >

The example indicates that 4 days, 23 hours, 12 minutes, 46 seconds and 10
clock ticks have elapsed since the ADIC Gateway was last booted. There are 60
ticks per second.

user

The userAdd,userDelete, and userList commands provide control of the
user list. The persistent address map file can be sent to the ADIC Gateway or
retrieved from it using FTP. If you need to use FTP, use the user commands to
create a login and password so you can access the ADIC Gateway from the
Ethernet network.

userAdd “username”,”password” 

The userAdd command adds a user and password to the password file. The
parameter “username” must be from 3 to 80 characters. The parameter
“password” must be from 8 to 40 characters.

Gateway > userAdd "nancy","password"
value = 0 = 0x0
Gateway >

userDelete “username”,”password” 

The userDelete command deletes a user from the password file. It is not
possible to remove a user without knowing the user’s password. If the user’s
password is forgotten or unknown, you have to delete the password file, reboot
the ADIC Gateway, and then add all user names and passwords again.

Gateway > userDelete "nancy","password"
value = 0 = 0x0
Gateway >
uptime
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userList 

The userList command displays the contents of the password file (passwords
are encrypted).

Gateway > userList
Name : Password
nancy : SyecycRz
fred : b9dczebQbd
martha : RQQdRedb9d
admin : cScQRSQzzz
value = 0 = 0x0
Gateway >

userHelp

The userHelp command displays a list of the user commands.

Gateway > userHelp

userAdd "name","password" - Add user to user list
userDelete "name","password" - Delete user from user list
userList - Display user list

See User’s Guide for more information

value = 0 = 0x0
Gateway >

version

The ADIC Gateway is an intelligent device and has software that controls all
functions. The revision of that firmware can be displayed with the version
command. The first line displayed is the ADIC Gateway firmware version. The
lines that follow pertain to the firmware version.

Gateway > version
Gateway Version 0339.11 Built Dec 13 1999, 15:14:14
VxWorks (for DISC, Inc. (i960RD)) version 5.3.1.
Kernel: WIND version 2.5.
value = 26 = 0x1a
Gateway >

vpmFeatureEnable

The vpmFeatureEnable command enables the optional Virtual Private Map
feature. You enable the feature by entering the unique license key. If the license
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key was factory installed, VPM is already enabled. See also the licenseShow
command.

Router> vpmFeatureEnable “H822F-KCRV2”
value = 0 = 0x0
Router >

vpsAccessApply

The vpsAccessApply command causes the settings that have been changed
and stored in memory to take effect immediately and also saves them to the VPS
database.

vpsAccessClear [disable code]

The vpsAccessClear command disables all host access to all LUNs except to
LUN 0 (the Command and Control interface). The disable code is 0xfacade02.

The following command example shows how to disable all access.

Gateway >vpsAccessClear 0xfacade02
value = 0 = 0x0
Gateway >

vpsAccessSet [hostindex],<Starting LUN>,<Ending 
LUN>,<Access>

The vpsAccessSet command sets the access for the specified range of LUNs
for the specified host connection index. Existing hostindex values can be
determined by looking at the “Id” column in the output of the vpsShow -1 
command (see page 287).

When you enter this command, the settings are stored in memory but are not
applied until you enter the vpsAccessApply command. The following example
shows how to enable the host at connection index 1 to access LUNs 2 through 32.

Gateway > vpsAccessSet 1,2,32,1
value = 0 = 0x0
Gateway >

Access

0 Disables access to the LUNs

1 Enables access to the LUNs
vpsAccessApply



vpsActiveSet
vpsActiveSet

The vpsActiveSet command places VPS in the active state. The means that all
of the current access settings are put into effect. You would typically only use this
command after making VPS inactive. See the vpsInactiveSet command.

Gateway > vpsActiveSet
value = 0 = 0x0
Gateway >

If VPS is already active, the following is displayed.

Gateway > vpsActiveSet
VPS: Already Active
value = 21 = 0x15
Gateway >

vpsConnectionSet [hostindex],“host connection string”

The vpsConnectionSet command sets the host connection information for the
host at the specified connection index. The connection may be a device name,
port address, etc. The following example shows setting the host connection
information. Existing hostindex values can be determined by looking at the “Id”
column in the output of the vpsShow -1 command.

Gateway > vpsConnectionSet 1,"ScsiPort2 [0:0:0] (QLA2100)"
value = 0 = 0x0
Gateway >

vpsFeatureEnable “license key string”

The vpsFeatureEnable command enables the VPS feature. Each license key
is unique for each ADIC Gateway serial number. If the feature is factory-enabled
you can specify “enable” rather than an actual license key.

vpsHelp

The vpsHelp command displays a list of the Virtual Private SAN commands.

Gateway > vpsHelp
vpsAccessApply
vpsAccessClear <disable code>
vpsAccessSet [host index],<starting lun>,<ending lun>,<access>
vpsActiveSet
vpsConnectionSet [host index],"host connection string"
vpsFeatureEnable "license key string"
vpsHostShow [host index]
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vpsInactiveSet
vpsNameSet [host index],"name string"
vpsShow [host index]
vpsSparseAccessSet [host index],"LUN string"<access>
vpsTypeSet [host index]"OS type string"

See User’s Guide for more information

value = 0 = 0x0
Gateway >

vpsHostShow [hostIndex]

The vpsHostShow command displays all known Virtual Private SAN information
for the specified host connection index. The LUN access map is displayed as 16
rows of 16 bytes, one byte for each LUN.

hostIndex is the Id obtained from the vpsShow com-
mand.

00 in the LUN Access map indicates the host
has no access to the LUN

01 in the LUN Access map indicates the host
has access to the LUN

The following command example shows VPS information for host Id 1.

Gateway > vpsHostShow 1
Host(1):
State = 0, Type = 1, Flags = 0x00000000, Online
WWN: 200000e0:8b0057d8
Name: 'LABATTS'
Host Type: 'NT 4.0 SP5'
Device Id: 'ScsiPort6 [0:0:0] (QLA2100)
LUN Access:
0: 01 01 01 00 00 00 00 00 00 00 00 00 00 01 01 00
16: 00 00 00 00 00 00 00 00 00 01 01 00 00 00 00 00
32: 00 00 00 00 00 01 01 00 00 00 00 00 00 00 00 00
48: 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
64: 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
80: 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
96: 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00

112: 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
128: 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
144: 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
160: 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
176: 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
vpsHostShow [hostIndex]



vpsInactiveS
192: 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
208: 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
224: 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
240: 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
value = 0 = 0x0
Gateway >

vpsInactiveSet

The vpsInactiveSet command de-activates VPS making all LUNs available to
all host connections. This command typically would be used when troubleshooting
a SAN configuration. It removes VPS access control without deleting VPS access
settings. Use the vpsActiveSet command to re-activate VPS.

Gateway > vpsInactiveSet
value = 0 = 0x0
Gateway >

If VPS is already inactive, the following is displayed.

Gateway > vpsInactiveSet
VPS: Already Inctive
value = 23 = 0x17
Gateway >

vpsNameSet [hostindex],"name string"

The vpsNameSet command sets the host name field to the specified “name
string” for the specified host connection index. The following command example
shows setting the host name for host Id 1 to “LANDERS”. Existing hostindex and
name values can be determined by looking at the “Id” and “Host Name” columns
in the output of the vpsShow -1 command.

Gateway > vpsNameSet 1,"LANDERS"
value = 0 = 0x0
Gateway >

vpsShow [hostIndex]

The vpsShow command displays information about hosts that have been
registered with Virtual Private SAN based on the value of hostIndex.

Tip: You can enter vps as a shortcut for vpsShow -1.

Hostindex Meaning

-1 Displays brief list of all known host connections
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The following command example shows VPS information for the hosts that have
been registered by VPS. Hosts that have the Host Registration Service running
with periodic re-registration are shown with a status of Periodic. One of the hosts
has more than one Fibre Channel connection to the SAN Gateway.

Gateway > vpsShow -1
VPS State: Active
Id World Wide Name St. Typ HexFlags Status Host Name Host Type
Host Connection
-------------------------------------------------------
001 200000e0.8b0057d8 000 001 00000000 Online LANDERS NT 4.0
SP5 ScsiPort6 [0:0:0](QLA2200)
002 200000e0.8b16014d 000 001 00000000 Periodic SUPERIOR NT
4.0 SP5 ScsiPort7 [0:0:0](QLA2200)
003 200000e0.8b160152 000 001 00000000 Offline SUPERIOR NT 4.0
SP5 ScsiPort7 [0:0:0](QLA2200)
value = 0 = 0x0
Gateway >

vpsSparseAccessSet [hostindex],“LUN string”,[Access]

The vpsSparseAccess command sets the access for the specified LUNs for the
specified host connection index. Same as vpsAccessSet except LUNs are
entered as a string of characters separated by commas. Existing hostindex values
can be determined by looking at the “Id” column in the output of the vpsShow -1 
command.

When you enter this command, the settings are stored in memory but are not
applied until you enter the vpsAccessApply command. The following command
example enables host access to the LUNs 1, 2, 3, 4, 6, 9, 22, 23 and 45.

Gateway >vpsSparseAccessSet 1,“1,2,3,4,6,9,22,23,45,”1
value = 0 = 0x0
Gateway >

0 Full display of all known host connections, and if online
displays a list of all LUNs available to that connection

N (1-48) Display the full information for the host N only

Access Meaning

0 disables access to the LUNs

1 enables access to the LUNs

Hostindex Meaning
vpsSparseAccessSet [hostindex],“LUN string”,[Access]



vpsTypeSet [
vpsTypeSet [hostIndex],“OS type string”

The vpsTypeSet command sets the Operating System type for the specified host
connection index. Existing hostindex values can be determined by looking at the
“Id” column in the output of the vpsShow -1 command. OS can be “nt” “aix”
“solaris” “hp-ux” “netware” “gateway” “switch” “generic” “unisys” “as400”
“autosense/nt” “fcr-2”, or “pv-136t-fc”. Additional information can be appended to
the end of the string.

The following command example shows setting the host type to NT 4.0 SP5 for
host Id 1.

Gateway > vpsTypeSet 1,"NT 4.0 SP5"
value = 0 = 0x0
Gateway >

xscsiAltIdGet [channel]

The xscsiAltIdGet command displays the alternate ID number for a specified
Ultra2/3 SCSI Channel.

Gateway > xscsiAltIdGet 5
SCSIbus AltId ------- ---------------
XSCSI 5 Auto
value = -1 = 0xffffffff
Gateway >

For information about alternate ID numbers for Ultra SCSI channels, see the
scsiAltIdGet command.

xscsiAltIdSet [channel], [id]

The xscsiAltIdSet command sets the Alternate Id for an Ultra2/3 SCSI Channel.

Channel numbers 1 - 6 (Ultra2/3 SCSI)

Id channel numbers 0-15

Gateway > xscsiAltIdSet 6,3
Alternate Id set to 3 for SCSI 6 will take effect upon reboot
value = 0 = 0x0
Gateway >

Attention: You must reboot the ADIC Gateway after executing this
command for the new setting to take effect.

To set Alternate ID numbers for Ultra SCSI channels, see the scsiAltIdSet 
command.
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xscsiHostChanGet [channel]

The xscsiHostChanGet command displays Host Channel mode for a specified
Ultra2/3 SCSI Channel.

Gateway > xscsiHostChanGet 5
SCSIbus HostChan ------- ---------------
XSCSI 5 Channel is Initiator
value = -1 = 0xffffffff
Gateway >

For information about Host Channel modes for Ultra SCSI channels, see the
scsiHostChanGet command.

xscsiHostChanSet [channel], [mode]

The xscsiHostChanSet command sets the Channel Mode to Target or Initiator for
an Ultra 2/3 SCSI Channel.

Channel numbers 1 - 6 (Ultra2/3 SCSI)
Mode 0 Initiator Mode (False)
Mode 1 Target Mode (True)

Gateway > xscsiHostChanSet 6,1
Host Chan set to TRUE for XSCSI 6 will take effect upon reboot
value = 0 = 0x0
Gateway >

Attention: You must reboot the ADIC Gateway after executing this
command for the new settings to take effect.

To set Host Channel Modes for Ultra SCSI channels, see the scsiHostChanSet 
command.

xscsiHostIdGet [channel]

The xscsiHostIDGet command displays the Host ID number for a specified Ultra
2/3 SCSI Channel.

Gateway >  xscsiHostIdGet 5
SCSIbus HostId ------- ---------------
XSCSI 5 7
value = -1 = 0xffffffff
Gateway >

For information about Host IDs for Ultra SCSI channels, see the scsiHostIdGet 
command.
xscsiHostChanGet [channel]
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xscsiHostIdSet [channel], [id]

The xscsiHostIdSet command sets the Host ID for a specified Ultra 2/3 SCSI
Channel.

Channel numbers 1 - 6 (Ultra2/3 SCSI)
Id numbers can be0-15

Gateway > xscsiHostIdSet 5,9
Host Id set to 9 for XSCSI 5
will take effect upon reboot
value = 0 = 0x0
Gateway >

Attention: You must reboot the ADIC Gateway after executing this com-
mand for the new settings to take effect.

To set Host IDs for Ultra SCSI channels, see the scsiHostIdSet
command.xscsiRescan

The command xscsiRescan requests a SCSI rescan for new devices on the Ultra 2/
3 channels 1 - 6. If channel is specified (1, 2, 3, 4, 5, or 6), then only that channel is
scanned. Otherwise, if channel is not specified or if channel is 0, then all channels are
scanned.

Gateway > xscsiRescan 4
Done
value = 0 = 0x0
Gateway >

Notes:
1. Rescanning a SCSI bus may delay I/O commands pending on that bus for

several seconds. Do not rescan SCSI buses when this delay may not be
tolerated. When possible, only scan the bus where a new device has been
added.

2. If a channel is specified, that channel is scanned and the prompt is returned
on completion. If no channel is specified (or 0 is specified), SCSI Channels 1
through 6 are scanned in sequence and the prompt is returned on completion.

3. When a device is discovered, there may be further device specific initialization
that continues after the scan has completed in which case the device may not
show up immediately when you issue the fcShowDevs command. An example of
this is a disk that requires a SCSI Start Unit command to become ready. (Tape
and Changer devices and Disks that indicate Ready status are available on scan
completion).

4. If a SCSI target device should require replacement, remove the old device, set
the new device to the same SCSI bus ID as the old device and attach it to the
same channel. Rescan the channel to update the configuration data. The new
291
et [channel], [id]



292
device should be available to host systems with the same LUN as the old
device.

To rescan Ultra SCSI channels, see the scsiRescan command.

xscsiResetDisableGet [channel]

The xscsiResetDisableGet command displays the SCSI Bus Reset On Power
Up setting for a specified Ultra 2/3 SCSI Channel. False means that SCSI Bus Reset
On Power Up is enabled. True means that SCSI Bus Reset On Power Up is disabled.

Gateway > xscsiResetDisableGet 5
SCSIbus Reset Disable ------- ---------------
XSCSI 5 FALSE - default
value = -1 = 0xffffffff
Gateway >

For information about Bus Reset Settings for Ultra SCSI channels, see the
scsiResetDisableGet command.

xscsiResetDisableSet [channel], [mode]

The xscsiResetDisableSet command sets the SCSI Bus Reset On Power Up
mode for an Ultra 2/3 SCSI Channel.

Channel numbers 1 - 6 (Ultra2-SCSI)

Mode 0 = Enable Bus Reset On Power Up

Mode 1 = Disable Bus Reset On Power Up

Gateway > xscsiResetDisableSet 5,1
Reset Disable set to TRUE for XSCSI 5
will take effect upon reboot
value = 0 = 0x0
Gateway >

To specify Bus Reset Settings for Ultra SCSI channels, see the
scsiResetDisableSet command.

xscsiTermGet [channel]

The xscsiTermGet command displays termination status information for the
specified Ultra 2/3 SCSI channel.

Gateway> xscsiTermGet 6
SCSIbus Termination ------- ---------------
XSCSI 6 Enabled
xscsiResetDisableGet [channel]
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value = 0 = 0x0
Gateway >

For termination status Information for Ultra SCSI channels, see the scsiTermGet 
command.

xscsiTermSet [channel], [termination]

The xscsiTermSet command enables or disables the termination for an Ultra 2/3
SCSI Channel.

Channel numbers 1 - 6 (Ultra2/3 SCSI)
termination 0 = Enable Termination
termination 1 = Disable Termination

Gateway > xscsiTermSet 5,1
Termination for XSCSI 5
will take effect upon channel reset
value = 0 = 0x0
Gateway >

Attention: You must reboot the ADIC Gateway after executing this com-
mand for the new settings to take effect

To set termination status for Ultra SCSI Channels, see the scsiTermSet command.
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Appendix C: Diagnostic
Command Reference
This section is a reference for the procedures used when diagnostics are required.

Boot Modes

The ADIC Gateway has two modes of operation: normal mode and diagmode.
Two commands are available from the service terminal to reboot the ADIC
Gateway to the desired mode. The ADIC Gateway remains in the existing mode
until it has been directed to reboot in the other mode.

When the ADIC Gateway is booted in diagmode, the command prompt displayed
on the service terminal is diagmode >. While in diagmode, a limited command
set is available for testing the ADIC Gateway interfaces. In addition, the device
drivers for the Ethernet, Fibre Channel, and SCSI interfaces are disabled so loop
back tests can be performed on them.

Entering Diagnostic Mode

Use the diagBoot command when the special features of the SAN Gateway’s
diagnostic module are required (see "diagBoot" on page 298). Perform the
following:

1. Stop all I/O.

Attention: Before entering diagmode, you must disconnect all SCSI
and FC cables from the ADIC Gateway. If you do not, the data on the
attached disk or tape devices will become corrupted.

2. Power down the ADIC Gateway.

3. Remove the Ethernet cable, if installed.

4. Connect the terminal to the Service Port.

5. Turn on ADIC Gateway and wait for it to finish booting.

6. If the command prompt displayed on the service terminal is diagmode >, pro-
ceed with the appropriate diagnostic tests.

7. If the command prompt displayed on the service terminal is not diagmode >,
type the diagBoot command.

8. Wait for the ADIC Gateway to reboot.
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9. At the diagmode > prompt, proceed with the appropriate diagnostic tests.

Restoring Normal Mode

normalBoot is performed if the ADIC Gateway was placed in diagnostic mode
and needs to be restored to normal operation. See "normalBoot" on page 298.

1. If the ADIC Gateway is on, power it off.

2. Connect the terminal to the Service Port, if it is not already connected.

3. Turn on the ADIC Gateway and wait for it to finish booting.

4. From the service terminal, type the normalBoot command.

5. Wait for the ADIC Gateway to reboot.

6. At the Gateway >, prompt, continue with the MAP that sent you here.

Special Procedures

This section contains information on special procedures.

Health Check

The Health Check function provides a method to periodically determine the
operational state of a ADIC Gateway and its attached interfaces and devices.

Manual Health Check

Health Check is performed manually from the service terminal only if the ADIC
Gateway is in normal mode. This procedure uses the hlthChkNow command that
performs a “Device Ready” Level Health Check that includes a SCSI device
availability check. The SCSI target devices must be connected and turned on so
that Health Check can determine their operational status.

For other commands associated with healthchecks, see terms beginning with the
hlthChk prefix in “Service Port Command Reference” on page 223.

For an explanation of Health Check Levels, see “Health Check” on page 82.

For a list of Health Check Event Descriptions, see at Table 8-2 on page 161.

1. Stop all I/O.

2. Remove the Ethernet cable if installed.
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3. Connect the terminal to the Service Port.

4. From the service terminal, type the hlthChkNow command.

5. Check the results displayed on the service terminal to determine the status of
the interfaces and attached devices. If a failure is indicated, perform the
appropriate MAP.

Event Log Dump

The events that have been logged in the ADIC Gateway’s Event Log can be
displayed on the service terminal or viewed from the ADIC Management Console.
This information may be useful because you can see the normal events and any
abnormal events that nay lead you to the source of an internal or external failure.

1. Each entry contains a sequence number, day, and time-stamp, the event
code, event source (interface name or system process), an index, and a
description of the event. If the Real Time Clock has been set, the time-stamp
will be real time. Otherwise, the time stamp will be relative to the boot-time.

2. The Event Log holds more than 2000 events. When the log becomes full, the
oldest events are overwritten by the most recent events.

3. You can choose to view only those events logged since the ADIC Gateway
was last booted or you can view a longer list of events that have accumulated
from previous boots.

4. You can choose to view events by severity level. Selecting Warning will display
Warning and Notice events. Selecting Information will display Information, Warn-
ing and Notice events.

See the loggerDump and loggerDumpCurrent commands in “Connecting to
the Service Port” on page 217.

Retrieving the Code 43 Dump File

If an event code 43 was reported to the ADIC Management Console client, it is an
indication that the ADIC Gateway performed an error recovery operation and had
to reset the Fibre Channel interface to clear a lock-up condition. This event is also
recorded in the ADIC Gateway event log along with the name of a file that was
saved to the flash file system. The file contains information about the state of the
Fibre Channel interface prior to the reset. Follow these steps to retrieve the file.

1. Connect the service terminal to the Service Port (see “Connecting to the Ser-
vice Port” on page 217).
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2. Press the Enter key on the service terminal. If the prompt is not displayed, go
to “Service Port MAP” on page 191 to determine whether the RS-232 cable
and service terminal are working properly.

3. From the service terminal, navigate to the “DUMP” directory by entering the
cd “/ffs/dump” command.

4. From the service terminal, enter the ls command to get a file listing for the
directory. There may be more than one file present if the error condition has
occurred more than once.
Note: Dump file names end in .dmp and the files are automatically deleted
whenever you update the ADIC Gateway’s firmware.

Refer to the section ““Saving a Configuration File” on page 220.” Substitute the
name of the dump file and use that procedure to save the file to the service
terminal. Repeat this step if there is more than one file and save each file to the
service terminal.

Boot Mode Commands

diagBoot

1. This command is used only to transition a ADIC Gateway from normal
operations to the special diagnostic mode.

2. The diagBoot command first ensures that the /ffs:mt directory exists.

3. It copies the existing bootline to a file in the /ffs:mt directory on the ADIC
Gateway.

4. It installs a new bootline directing the ADIC Gateway to boot using a special
diagnostic startup script /ffs:mt/diagnstk.rc.

5. It renames the persistent map file config/device.map as config/
device.bak (a new file will be generated after rebooting).

6. It issues a reboot command to put the changes into effect.

normalBoot

1. The normalBoot command is used only to transition the ADIC Gateway from
the special diagnostic mode to resume normal operation.

2. It restores the bootline that was copied by diagBoot.

3. It erases the new persistent device map and renames the original map file
config/device.map – restoring it for use when the ADIC Gateway
reboots.
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4. It reboots the ADIC Gateway.

Diagnostic Commands

This section is a reference for the commands that are available when the ADIC
Gateway is booted in diagmode.

1. The command set is limited while in diagmode. You will need to use the
showBox command and commands (with the suffix Test) when testing the
DDFm Board, the Ethernet, Fibre Channel, and SCSI interfaces.

2. The Ethernet loop back plug, Fibre Channel loop back plug, and SCSI cable
provided in the Service Tool Kit are required for the corresponding loop back
test.

Attention: You must disconnect the FC and SCSI cables from the
ADIC Gateway. If you do not, the data on the attached disk or tape
devices will become corrupted.

ddfTest

The ddfTest is a comprehensive series of tests designed to exercise all data flow
paths.

In the following sample code, “PCI-0” indicates accesses to the DDF board’s
primary PCI interface, and “PCI-1” the secondary PCI bus interface. This is useful
in isolating problems on one bus but not the other.

Diagmode > ddfTest

==== Testing DDF board ====

Bitwalk PCI-0
0 Passed 1 Passed 2 Passed 3 Passed

Bitwalk PCI-1
0 Passed 1 Passed 2 Passed 3 Passed

Access PCI-0
0 Passed 1 Passed 2 Passed 3 Passed 4 Passed 5 Passed 6 Passed

7 Passed
Access PCI-1
0 Passed 1 Passed 2 Passed 3 Passed 4 Passed 5 Passed 6 Passed
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7 Passed
Burst PCI-0 Passed
Burst PCI-1 Passed
MemSize PCI-0 is 64 Mbytes
MemSize PCI-1 is 64 Mbytes
Burst Address PCI-0 ................Passed
Burst Address PCI-1 ................Passed
RP DMA PCI-0 Passed
RP DMA PCI-1 Passed
Data Sharing Passed

DDF Test PASSED
value = 0 = 0x0

DESCRIPTION OF TEST MESSAGES

This tests basic access to each “word lane” in the DDF data path. Each PCI bus
has four 32-bit word lanes associated with it.

Bitwalk PCI-0
0 Passed 1 Passed 2 Passed 3 Passed

Bitwalk PCI-1
0 Passed 1 Passed 2 Passed 3 Passed

This tests 8, 16, and 32-bit access to the DDF memory array. Numbers 0 to 3
indicate the four work-lanes of the lower bank of DDF memory. Numbers 4 to 7
are the word lanes of the upper bank of DDF memory.

Access PCI-0
0 Passed 1 Passed 2 Passed 3 Passed 4 Passed 5 Passed 6 Passed

7 Passed
Access PCI-1
0 Passed 1 Passed 2 Passed 3 Passed 4 Passed 5 Passed 6 Passed

7 Passed

This tests the DDF board’s PCI burst transfer logic.

Burst PCI-0 Passed
Burst PCI-1 Passed

This is the memory size as determined from each PCI bus.

MemSize PCI-0 is 64 Mbytes
MemSize PCI-1 is 64 Mbytes
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Then the burst address test is run. This checks for errors in the memory array’s
address logic. The dots represent a test progress display. Each dot represents 1/
16 of the test complete.

Burst Address PCI-0 ..................Passed
Burst Address PCI-1 ..................Passed

The next test is the deep burst test.

RP DMA PCI-0 Passed
RP DMA PCI-1 Passed

The last test looks at data written to one side of the memory and compares it to
data read from the other side.

Data Sharing Passed

An ADIC Gateway without a DDF board will return the following:

=== Testing DDF board ===
** DDF init failure **
value = -1 = 0xfffffff

elTest

elTest is the Ethernet loop back test. The ADIC Gateway must be in diagnostic
mode to use this command and a loop back plug must be installed on the Ethernet
port.

diagmode > elTest
==== Testing Ethernet ====
Init complete.
Ethernet OK
value = 0 = 0x0

The test issues a series of loop back tests. Test data is transferred and verified. A
good test ends with Ethernet OK.
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If errors are detected, the test displays the number of bad test iterations as shown
below. If your test was not successful, return to the MAP that sent you here.

diagmode > elTest
==== Testing Ethernet ====
Init complete.
Ethernet timeout error
Ethernet timeout error
Ethernet timeout error
Ethernet timeout error
Ethernet timeout error
Ethernet timeout error
Ethernet test reported 6 errors out of 12 iterations
value = 6 = 0x6

fcSlotTest [x]

The ADIC Gateway must be in diagnostic mode to use this command and a loop
back plug must be connected to the PMC card.

The fcSlotTest command performs a confidence test on a Fibre Channel slot.
Substitute for x the Fibre Channel slot number you want to test. This command
can be used to test the slot or the cable.

The following example code shows the display for a test Fibre Channel slot 1.

diagmode > fcSlotTest 1
FC 1 [##########] Iterations 51 Errors 0 - PASSED
Fibre Channel Port 1 returns PASSED
value = 0 = 0x0
diagmode > fcSlotTest 2
FC 1 [##########] Iterations 51 Errors 0 - PASSED
Fibre Channel Port 2 returns PASSED
value = 0 = 0x0

The following outputs are examples Fibre Channel port tests that were not
successful. If your test was not successful, return to the MAP that sent you here.

UNSUCCESSFUL FIBRE TEST 1

diagmode > fcSlotTest 1
FC 1 [##########] Iterations 7799 Errors 7799 - FAILED
Fibre Channel Port 1 returns FAILED
value = -1 = 0xffffffff = pNullDmaDesc + 0xfe4ea9f7

Note: If the Fibre Channel “link” LED does not come on, the test will
not pass.
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UNSUCCESSFUL FIBRE TEST 2 (CABLE NOT PLUGGED IN):

diagmode > fcSlotTest 2
FC 1 [##########] Iterations 37 Errors 37 - FAILED
Fibre Channel Port 1 returns FAILED
value = -1 = 0xffffffff = pNullDmaDesc + 0xfe4ea9f7

scsiChannelTest (x,y)

The ADIC Gateway must be in diagnostic mode to use this command and a SCSI
cable must be connected between two SCSI channels.

The scsiChannelTest command performs a confidence test on a pair of SCSI
channels. Substitute for x and y the SCSI channel numbers you want to test.
Parenthesis are optional. This command can be used to test the SCSI interface or
the SCSI cable.

The example below shows the display for a test on SCSI channels 1 and 2.

diagmode > scsiChannelTest (3,4)
SCSI-3 -> SCSI-4 [##########] 10 iterations PASSED
SCSI-4 -> SCSI-3 [##########] 10 iterations PASSED
value = 0 = 0x0
diagmode > scsiChannelTest (1,2)
SCSI-1 -> SCSI-2 [##########] 10 iterations PASSED
SCSI-2 -> SCSI-1 [##########] 10 iterations PASSED
value = 0 = 0x0

The following output is an example of a SCSI port test that was not successful. If
your test was not succesful, return to the MAP that sent you here.

UNSUCCESSFUL SCSI TEST (CABLE NOT PLUGGED IN):

diagmode > scsiChannelTest (1,2)
SCSI Initiator Error(s) - STO iUnk
SCSI Initiator Error(s) - STO iUnk
SCSI-1 -> SCSI-2 [SCSI Initiator Error(s) - STO iUnk
ERROR, i = 1 ] 1 iterations FAILURE

SCSI-2 -> SCSI-1 [SCSI Initiator Error(s) - STO iUnk
ERROR, i = 1 ] 1 iterations FAILURE

value = -1 = 0xffffffff = pNullDmaDesc + 0xfe4ea9f7
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showBox

The showbox command displays components of the ADIC Gateway using
characters to form a picture of the unit, as viewed from the back of unit:

SAN Gateway
login : disc
Password:

Gateway3010 > showBox
NOTICE: On-board SCSI-1 changed

_ _
Front //| /-------------------------------//|

// /----/ DDF Board // |
// / / // |

// / -------------------------------// |
// / /-----/ /-----/ /-----/// /

///====/ /====/ / 3 / / 2 / / 1 /// /
/========================================/ /
| [HVDT] [HVDT] | /
| [DFCSW] [FCCu=] [DFCSW] | /
| [====] [HVDT] | /
|________________________________________|/ Back

HVDT = SCSI High Voltage Differential - Terminated
DFCSW = Dual FibreChannel Optical Short Wave
FCCu = FibreChannel Copper
DDF = Direct Data Flow Memory with error correction

SIMMS: 32 Mbytes total, non parity
SCSI-2 requires High Voltage Differential cable
SCSI-3 requires High Voltage Differential cable
SCSI-4 requires High Voltage Differential cable
DFCSW-1 slot-1 Right-Port requires FibreChannel Multi-Mode

(SW) cable
DFCSW-4 slot-1 Left-Port requires FibreChannel Multi-Mode (SW)
cable
FCCu-2 slot-2 requires FibreChannel copper cable
DFCSW-3 slot-3 Right-Port requires FibreChannel Multi-Mode

(SW) cable
DFCSW-6 slot-3 Left-Port requires FibreChannel Multi-Mode (SW)
cable

value = 0 = 0x0

Gateway3010 >The abbreviations used in the drawing are explained in the
legend immediately below the drawing.
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supportDump

The supportDump command outputs the result of a number of Service Port
commands in a standard way and in a specific order. The resulting file is used for
troubleshooting. The individual commands called by supportDump are:

envShow
version
showBox
sysVpdShowAll
sysConfigShow
licenseShow
vpsShow
hostTypeShow
targets
scsiShow
fcShow
fcShowDevs
mapShowDevs
mapShowDatabase
showScsiAssign
fctShowChan
cleShowAll
loggerDumpCurrent
envMonShow
dmva
reserveShow

xscsiChannelTest (x,y)

The ADIC Gateway must be in diagnostic mode to use this command and you
must have the appropriate short VHDCI offset cable with 68-pin connectors, either
HVD or LVD/SE.

The xscsiChannelTest command performs a confidence test on a pair of Ultra 2/
3 SCSI channels. Substitute for x and y the Ultra 2/3 SCSI channel numbers you want
to test. Parenthesis are optional. This command can be used to test the Ultra 2/3 SCSI
interface or an Ultra 2/3 SCSI cable.

The example below shows the display for a test on Ultra 2/3 SCSI channels 1
and 4.

diagmode > scsiChannelTest 1,4
XSCSI-1 -> XSCSI-4 [##########] 101 iterations PASSED
XSCSI-4 -> XSCSI-1 [##########] 101 iterations PASSEDPASSED
value = 0 = 0x0

For Ultra SCSI channels, use the scsiChannelTest command.
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Appendix D: Remote Event
Notification
Several features of the ADIC Management Console were designed to assist with
the maintenance and service of the ADIC Gateway. These are described in the
following sections.

Event Logging and Viewing

The ADIC Management Console allows you to retrieve and view event log
information that is stored in the non-volatile memory of the ADIC Gateway. The
ADIC Gateway filters the data based on the setting of the Event Viewing Level.
Note that only a fraction of the possible event codes refer to actual error
conditions, and some of those might have been anticipated and error recovery
was performed. Other events are recorded for informational purposes. Each event
has an assigned viewing level, which indicates a “severity.”

The event logger on the ADIC Gateway records all events, but the Client retrieves
only the events it is interested in, based on the Client’s viewing level (default is set
to 2). The event viewing level is cumulative; that is, a viewing level of 3 also
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displays level 2 and level 1 events. Level 0 events are displayed by the Client only
when the viewing level is set to All Events. See Table 8-1.

Figure D-1: Viewing Events in the Event Log

Events and Traps

Events are recorded in the ADIC Gateway event log. For each event, an assigned
Viewing Level corresponds with the event log facility available to the Client
application (all events are recorded in the ADIC Gateway log regardless of the
assigned level).

A Trap Threshold is preset for each event so that when the number of instances of
that event reaches the threshold, a trap will be sent. The count is then reset. If the
threshold is 0, no traps are sent. If the threshold is 1, a single occurrence of the
event will generate a Trap. If the threshold is set to 2, it will take two occurrences
of the event in order for a Trap to be generated. For an explanation of the action
numbers, see at Table 8-2 on page 161.

When a trap is received by the Server, it attempts to notify all registered Clients
(that is, Clients that are actively monitoring the ADIC Gateway that issued the

Trap). When the Client receives a trap message, the symbol is displayed on
the status/message area at the bottom of the ADIC Management Console screen.
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This is an indication that a trap has been received and a message has been
written to the Event Trap window Figure D-2 is an example of event trap
messages in the Event Trap window.

Figure D-2: Event Traps Displayed By Client

The IP address of the ADIC Gateway, a date/timestamp (provided by the server)
the Event Code and a brief description of the event are displayed. You can double
click on an event in the window to display more detailed information.

This information helps locate potential problems and should be monitored
regularly. It is also stored in the ADIC Gateway event log.

Heartbeats

The communication paths between the three components described in “Client/
Server Model” on page 23 are checked periodically to make sure that each is
listening to the other. These checks define “heartbeats.”

While a ADIC Gateway is being monitored, the Server application periodically
attempts to communicate with it (every two minutes). A fault is reported to any
interested Client if a ADIC Gateway is no longer available.

While a Client is connected to a Server, the Client periodically tests the connection
to the Server to make sure it is still available. If the Server fails this test, the user is
notified and the connection is closed.

While a Client is monitoring one or more ADIC Gateways, the Server tests the
connection to the Client at regular intervals. If a Client is not available to the
Server, it is removed from the registry of interested parties.

Because it is possible for a connection to be temporarily unavailable due to a
network condition, the Server does not sever a connection based on a missed
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heartbeat. However, it does attempt to notify a Client when a ADIC Gateway fails
to respond.

Heartbeat failures are assigned event codes and notifications are sent to the
Client where possible. Heartbeat events are not logged in the event log because
SNMP traps are not issued (traps can only come from a ADIC Gateway). The
Default Trap Thresholds column at Table 8-2 on page 161 shows the threshold
settings that apply to specific event codes.

Health Check

The Health Check function provides a method to periodically determine the
operational state of a ADIC Gateway and its attached interfaces and devices.

When the Health Check is disabled, the ADIC Gateway performs no periodic
checks beyond monitoring environmental status lines, which indicate power
supply and temperature conditions.

The Health Check function posts SNMP traps, when required, to convey status
information to the ADIC Management Console. The ADIC Gateway broadcasts
SNMP traps on the local IP network segment. In addition, specific addresses may
be configured to send directed SNMP traps to host systems located on other
subnets. Routing information must be set-up for traps to be directed to a different
subnet. The ADIC Management Console server automatically registers itself as a
trap recipient when it connects to a ADIC Gateway.
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Health Check failure events are recorded in the event log and the trap is always
sent on each occurrence.

Figure D-3: Successful Health Check

Health Check is enabled when the level is set to a value greater than 0. This can
be set from the Client application or from the service terminal.

Health Check Level Control

The Health Check level may be set to the levels described below using the ADIC
Management Console. For more information on the traps sent from the Health
Check facility, see Table 8-2. The Health Check level is stored in the ADIC
Gateway’s configuration tables and is persistent across boots.

0 — None

Although no health check is performed, the ADIC Gateway monitors the power
and temperature and records variations in the event log. Traps for all such events
are generated based on the threshold settings regardless of the Health Check
level.
311



312
1 — Basic Function

When set to the “Basic Function” level, the ADIC Gateway periodically scans the
system resources to locate problems. Health Check status will be set if either of
the following conditions is true:

Temperature Sensors detect WARNING or ALARM status

Power Supply sensors detect a change in status since the last report.

2 — Interface Test

The “Interface Test” level includes the “Basic Function” Level Health Check plus
an Interface Health Check. It performs an active poll of the interface device, such
as a Fibre Channel or SCSI controller. The controller is queried in an interface-
dependent method to determine if it is currently functional. If a controller is not
functional, a Health Check trap will be sent indicating which interface failed.

Also enabled at the “Interface Test” level is a test of the Fibre Channel link status
registers (which monitor FC link errors). A trap will be sent if any change in these
registers is detected.

3 — Device Test

The “Device Test” level performs both the “Basic Function” level and “Interface
Test” level Health Checks plus a Device Health Check. It polls every attached
device to determine its status. A Device will be considered healthy if it responds to
a simple SCSI Inquiry command.

4 — Device Ready

The “Device Ready” test performs all test functions of the lower Health Check
levels plus a Device Functional Health Check. At this level, each target device is
sent a SCSI Test Unit Ready command when the interval expires. If the device
reports “Good Status,” it is considered healthy. If it is not ready, the sense data
from the device is interpreted to determine if the device is in a “normal” not ready
state, or if the device is in a failed state. For removable media devices, such as
tape drives, level 4 is treated the same as level 3.

If a device is determined to be in a “failed” state, an SNMP trap is issued.

After a successful health check, a Trap is generated.
Health Check
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Health Check Interval

The Health Check interval controls how often the Health Check process runs. The
interval may range from 1 to 65,535 minutes. The default setting is 60 minutes. In
Figure D-4, the interval has been reset to 1 minute.

Figure D-4: Health Check Interval

Performance Impact of Health Checks

At higher levels (3 or 4), the Health Check process may interfere with high
demand I/O operations. For example, in a video delivery application, you may
want to select a very low level, or even level 0 to disable Health Checks.

If a device fails during normal I/O, the event will be logged in the Event Log.
Health Check will not detect the failure nor send a trap unless the Health Check
level is set to 3 or 4.

A trap issued from Health Check will be sent each time the Health Check Interval
expires. This means that there will be repeated messages if the same conditions
exist on successive checks.
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Startup Mess
Appendix E: Startup Message
Reference

POST Messages

Observe the messages displayed on the service terminal as shown in the sample
code below.

Boot Rom Messages

After the ADIC Gateway completes its power-on self-test, it will attempt to find,
load, and run the real-time LIC boot loader. See the sample code below.

== SAN Gateway IPOST Release 1.32 at 0xFEBFC150 ==
== Testing Dram ==
2.1 : Simple Access Leaf1 217 - Testing
2.1 : Simple Access Leaf2 217 - Testing 211 - Pass
2.2 : Bitwalk Leaf1 227 - Testing
2.2 : Bitwalk Leaf2 227 - Testing 221 - Pass
2.3 : Burst Access 237 - Testing 231 - Pass
2.4 : DRAM size 247 - Testing 0x2000000 = 32768 Kb 241 - Pass
2.5 : Pattern 257 - Testing 251 - Pass
2.6 : Address 267 - Testing 261 - Pass
<< Initial POST Passed >>
3.2 : Loading SPOST 327 - Testing
Loading Secondary POST from 0xFEBF0000
loading ELF module from 0xFEBF0000
Starting secondary post

== SAN Gateway SPOST Release 1.32 ==
== Configuring PMC Buses ==
== PCI Config $Revision: 1.6 $ displaying device map ==
0:6:0 22001077 4-02900117 10-00001301 14-80083000 30-80060000
0:7:0 22001077 4-02900117 10-00001201 14-80082000 30-80040000
0:18:0 22001077 4-02900117 10-00001101 14-80081000 30-80020000
0:19:0 22001077 4-02900117 10-00001001 14-80080000 30-80000000

1:6:0 000F1000 4-02000117 10-00009501 14-8805A000 18-88059000
1:6:1 000F1000 4-02000117 10-00009401 14-88058000 18-88057000
1:7:0 20001022 4-02800107 10-00009601 14-88056000 30-88040000
1:8:0 22001077 4-02900117 10-00009301 14-88055000 30-88020000
1:10:0 000F1000 4-02000117 10-00009201 14-88054000 18-88053000
1:10:1 000F1000 4-02000117 10-00009101 14-88052000 18-88051000
1:20:0 22001077 4-02900117 10-00009001 14-88050000 30-88000000

Secondary POST finished
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== Booting from Flash ==

loading COFF module from 0xFEE02000

Loaded. Entry at 0xC0010028

== VxWorks BootLoader ==
Copyright 1984-1996 Wind River Systems, Inc.
CPU: Pathlight (i960RD) Version: 5.3.1
BSP version: 1.2/1 Creation date: Apr 30 1999, 10:43:29

== Build for SAN Gateway ==

Initializing Flash

Press P̂ to stop auto-boot...
0
auto-booting...

boot device : ffs0
processor number : 0
host name : host computer
file name : ffs0:/vxWorkst.Z
inet on ethernet (e) : 192.168.30.6
host inet (h) : aaa.bbb.ccc.ddd
gateway inet (g) : eee.fff.ggg.hhh
user (u) : username
ftp password (pw) : user password
flags (f) : 0x8
target name (tn) : sangateway 0
startup script (s) : ffs0:sna.rc
other (o) : lnPci

Attaching network interface lnPci0... done.
Attaching network interface lo0... done.
Initializing ffs0:
AutoSync disabled
Mounting ffs0: succeeded.
done.
Loading ffs0:vxWorkst.Z ... Inflating ffs0:vxWorkst.Z...
Read data into 0xc1abeb20, len 0x000b5fa5
Inflate to 0xc1b74ad0
Inflated
entry = 0xc0012b40
1587584 + 374012 + 284676
Starting at 0xc0012b40...

Initializing Flash
Initializing ffs0:
AutoSync disabled
Mounting ffs0: succeeded.
done.
Loading ffs0:/vxWorkst.Z ... Inflating ffs0:/vxWorkst.Z...
Read data into 0xc1abf420, len 0x000a4983
Inflate to 0xc1b63db0
Inflated
entry = 0xc0010000
1270208 + 242396 + 231132
Starting at 0xc0010000...
Boot Rom Messages
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LIC Initialization Messages

After the BootLoader finds and loads the license internal code (LIC), the
Bootloader will transfer control and start ADIC Gateway operations. See the
sample code on the next page.
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Initializing Flash
Initializing ffs0:
Mounting ffs0: AutoSync disabled
succeeded.
ffs0: already initialized

Adding 6687 symbols for standalone.
Attached TCP/IP interface to lnPci unit 0
Attaching network interface lo0... done.

NFS client support not included.

-------------------------------------------
| SAN Gateway Firmware Version 0342
| Copyright Pathlight Technology, Inc, 1997-1999
|
| VxWorks version: 5.3.1
| KERNEL: WIND version 2.5
| Copyright Wind River Systems, Inc., 1984-1997
|
| CPU: Pathlight (i960RD). Processor #0.
| Memory Size: 0x2000000
| BSP version 1.3/0

-------------------------------------------

ffs0:/ - disk check in progress ...
System clock is set to TUE SEP 12 07:52:00 2000
instead of THU JAN 01 00:00:00 1970
ffs0:/ - Volume is OK

total # of clusters: 1,784
# of free clusters: 541
# of bad clusters: 0
total free space: 553,984

max contigous free space: 346,112 bytes
# of files: 17

# of folders: 6
total bytes in files: 1,224 Kb

# of lost chains: 0

total bytes in lost chains: 0

Executing startup script ffs0:sna.rc ...
#! /bin/csh -f
sna_monitor_init

SAN Gateway Version 0338.12 Built Oct 25 1999, 18:00:46
value = -1040715920 = 0xc1f7ef70
dbgInit
value = 0 = 0x0
CNFinit
value = 0 = 0x0
csSrvcInit
value = 0 = 0x0
amemInit
Testing DDF - PCI 0 DMA PageX Testing DDF - PCI 1 DMA PageX Test PASSED
Amem interrupt handler installed
value = 0 = 0x0
scsintInit
LIC Initialization Messages
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Final Startup Messages

In the final stage of the boot process, information is displayed about the firmware
version, ADIC Gateway name, optional features that are enabled or disabled,
SCSI Channels, and the IP address. In the example below, after the ADIC
Gateway command prompt, a message is displayed as a result of a response from
a host that is running the Host Registration Service for Virtual Private SAN access
control.

SAN Gateway Version 0338.12 Built Oct 25 1999, 18:00:46
Gateway307
Data Mover is Disabled
SAN Director License is Valid
SCSI 3 - DE - Terminated
SCSI 1 - DE - Terminated
SCSI 4 - DE - Terminated
SCSI 2 - DE - Terminated
IP Address set to 192.168.30.7
value = 0 = 0x0

Done executing startup script ffs0:sna.rc
- Service Port Reflected Signal Test
Starting shell
Gateway307 > 0xc1c3e500 (vcm10): VPS Registration: 'SINGHA' UID 00000
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Appendix F:Channel Number
Reference
This reference describes the convention used for channel numbers (also called
port numbers) and PMC option card slots. Labels on the rear panel and LEDs on
the front panel of the ADIC Gateway identify the channels, PMC slots and Storage
Area Network connections. The ADIC Management Console software and service
port commands associate these numbers to specific hardware connections.

Channel Numbering Convention

Each figure in this section represents a rear panel view of the ADIC Gateway to
illustrate the numbering convention for the Ultra SCSI channels, single and dual
port Fibre Channel PMC option cards, and Dual Channel Ultra2/3 SCSI PMC
option cards.

Ultra SCSI Channel and PMC Slot Numbering

Table F-1 shows that the four Ultra SCSI channels are numbered from bottom to
top, from left to right and the three PMC option slots are numbered from right to
left

Single Port Fibre Channel PMC Option Card Numbering

When three single port Fibre Channel PMCs are installed, the Fibre Channels are
numbered from right to left as shown in Table F-2.

Table F-1: UltraSCSI and PMC Slot Number Assignments

Ultra SCSI Channels PMC 3 PMC 2 PMC 1

SCSI 3 SCSI 4

SCSI 1 SCSI 2

Table F-2: PMC Single Port Fibre Channel Assignments

Ultra SCSI Channels PMC 3 PMC 2 PMC 1

SCSI 3 SCSI 4 Single Port
Fibre Channel

Single Port
Fibre Channel

Single Port
Fibre Channel

SCSI 1 SCSI 2 3 2 1
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Dual Port Fibre Channel PMC Option Card Numbering

When three dual-port Fibre Channel PMCs are installed, the Fibre Channels are
numbered from right to left as shown in Table F-3.

Dual Channel Ultra2/3 SCSI PMC Option Card Numbering

When three Ultra2 or Ultra3 PMCs are installed, the SCSI Channels are
numbered from bottom to top, from right to left as shown in Table F-4.

Skipping PMC Slots and Mixing Option Cards

When a PMC slot is empty, or when there are a mix of single channel and dual
channel PMC cards installed, the channels retain the numbering convention
associated with each PMC slot. Consequently, some channel numbers are

Table F-3: PMC Dual Port Fibre Channel Assignments

Ultra SCSI
Channels

PMC 3 PMC 2 PMC 1

SCSI
3

SCSI
4

Dual Port Fibre
Channels

Dual Port Fibre
Channels

Dual Port Fibre
Channels

SCSI
1

SCSI
2

6 3 5 2 4 1

Table F-4: PMC Ultra 2/3 SCSI Channel Assignments

Ultra SCSI
Channels

PMC 3 PMC 2 PMC 1

SCSI
3

SCSI
4

Dual Channel
Ultra 2/3 SCSI
Channel 6

Dual Channel
Ultra 2/3 SCSI
Channel 5

Dual Channel
Ultra 2/3 SCSI
Channel 4

SCSI
1

SCSI
2

Dual Channel
Ultra 2/3 SCSI
Channel 3

Dual Channel
Ultra 2/3 SCSI
Channel 2

Dual Channel
Ultra 2/3 SCSI
Channel 1
Channel Numbering Convention
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skipped as shown in Table F-5, which shows an empty PMC slot and a mix of
single and dual channel PMCs installed.

Dual Channel Ultra2/3 SCSI PMC Numbers in
Device Maps

If you need to add or change a LUN assignment for a device attached to an Ultra2/
3 SCSI channel, or you need to use the optional Virtual Private Map feature to
map a device to an Ultra2/3 channel, you need to know about a different
numbering scheme.

In the left-hand panel shown in Figure F-1, the ADIC Management Console
displays Ultra2 SCSI Channel 1 and in the right-hand panel next to the ADIC

Table F-5: Assignments for Single and Dual Port PMCs

Ultra SCSI
Channels

PMC 3 PMC 2 PMC 1

SCSI
3

SCSI
4

(EMPTY) Dual Channel Ultra 2/3
SCSI Channel 5

(EMPTY)

SCSI
1

SCSI
2

Dual Channel Ultra 2/3
SCSI Channel 2
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Maps
Gateway rear panel graphic, the ADIC Management Console again refers to this
channel as “1”

Figure F-1: Dual Channel Ultra2/3 SCSI PMC Number in Tree View Display

In the tabular information below the rear panel graphic, the ADIC Management
Console displays a different number shown in Figure F-1 as SCSI Channel “5”.
This is how the channel number is represented in the ADIC Gateway device map
and in Virtual Private Map.

Table F-6 illustrates the rear panel of the ADIC Gateway and shows the numbers
for the Dual Ultra2/3 SCSI channels that appear in the maps.

Table F-6: SCSI Channels in Device Map and VPM

Ultra SCSI
Channels

PMC 3 PMC 2 PMC 1

SCSI
3

SCSI
4

Dual Channel
Ultra 2/3 SCSI
Channel 10

Dual Channel
Ultra 2/3 SCSI
Channel 9

Dual Channel
Ultra 2/3 SCSI
Channel 8

SCSI
1

SCSI
2

Dual Channel
Ultra 2/3 SCSI
Channel 7

Dual Channel
Ultra 2/3 SCSI
Channel 6

Dual Channel
Ultra 2/3 SCSI
Channel 5
Dual Channel Ultra2/3 SCSI PMC Numbers in Device
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Appendix G: POST Error Codes
The power-on self-test (POST) indicates DRAM test progress by flashing the
front-panel SAN Connection and SCSI Channel LEDs in specific patterns. Figure
G-1 shows the LED designation used for the decoding scheme. Progress
messages are also sent to the Service Port and can be viewed on the service
terminal.

Figure G-1: Decoding POST LEDs

While POST is running, the “Ready” LED will remain off. If POST detects an error,
it will flash the error code on and off 10 times (about five seconds). Table G-1
shows the status codes, a description of the status, and the patterns indicated on
the LEDs.

Table G-1: POST Codes

Status Code Description LED Indication

2.1.2 Ram access error – leaf 1

2.1.4 Ram access error – leaf 2

2.1.6 Ram access error

2.1.7 Testing ram access

Minor number

Status
Major number
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2.2.2 Bitwalk error – leaf 1

2.2.4 Bitwalk error – leaf 2

2.2.6 Bitwalk error

2.2.7 Testing ram bitwalk

2.3.6 Burst access error

2.3.7 Testing burst access

2.4.6 Memory size error

2.4.7 Testing memory size

2.5.6 Pattern test memory error

2.5.7 Pattern testing memory

2.6.6 Address test error

Table G-1: POST Codes
POST Error Codes
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2.6.7 Testing memory address lines

3.2.7 Loading Secondary POST

Table G-1: POST Codes
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Appendix H:Glossary
Acronym Meaning

BIOS Basic Input/Output System

DE Differential Ended

DRAM Dynamic Random Access memory

DTE Data Terminal Equipment

ESD Electrostatic Discharge

EMI Electromagnetic Interference

FRU Field Replaceable Unit

GUI Graphical User Interface

HBA Host Bus Adapter

HTTP Hypertext Transfer Protocol

HVD High Voltage Differential

I/O Input/Output

IP Internet Protocol

JMAPI Java Management Application Programming
Interface

JRE Java RunTime Environment

LED Light Emitting Diode

LUN Logical Unit Number

LVD Low Voltage Differential

LW Long Wavelength

MIB Management Information Base

MTBF Mean Time Between Failures
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PMC PCI Mezzanine Card

PPP Point-to-Point Protocol

RFI Radio Frequency Interference

RID Replacement Identification

RMI Remote Method Invocation

RPC Remote Procedure Call

RTOS Real Time Operating System

SAN Storage Area Network

SCSI Small Computer System Interface

SDRAM Synchronous Dynamic Random Access Memory

SE Single-Ended

SNMP Simple Network Management Protocol

SRS SAN Replication Services

TCP Transmission Control Protocol

VPS Virtual Private SAN
Glossary
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